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About this information product

...............................................................................................................................................................................................................................................................

Purpose This preface provides an overview of this information product, the
Navis™ Optical Provisioning Manager (PM) - Network Provisioning
(NP) Provisioning Guide, Release 1.0.

The purpose of this information product is to provide an overview of
the Navis™ Optical PM - NP and present step-by-step tasks so as to
instruct the reader the recommended way to provision with Navis™

Optical PM - NP.

Reason for reissue Issue 1 of this Provisioning guide is a new document that supports the
Navis™ Optical PM - NP.

Safety labels This document does not use safety labels.

Intended audience This document is written primarily for network planners, engineers,
operators, and sales teams. It may be used by anyone desiring specific
information about the features, applications, and operations of Navis™

Optical PM - NP.

....................................................................................................................................................................................................................................
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How to use this
information product

This document contains:

• task information, which includes provisioning tasks (that is,
step-by-step instructions).

• conceptual information, which is specific data related to tasks.

Both types of information is presented within the chapters of this
Provisioning guide.

The following table describes the information in each chapter of this
Provisioning guide.

Section Title Description

Preface About this information product Explains this guide’s purpose, intended audience,
and how to use it.

Chapter 1 Chapter 1, “System Overview” Explains Navis™ Optical PM - NP features,
applications and supported hardware platforms. It
also describes system planning and engineering,
ordering, and product support.

Chapter 2 Chapter 2, “The Navis™ Optical
PM - NP Provisioning Process ”

Provides an overview of the Navis™ Optical PM -
NP provisioning process and commonly used
terminology.

Chapter 3 Chapter 3, “Network Element
Configuration Tasks”

Contains tasks associated with controlled and
noncontrolled network elements.

Chapter 4 Chapter 4, “Provisioning Tasks” Contains tasks related to digital link, connection,
optical layer, subnet, and preplan restoration
provisioning.

Chapter 5 Chapter 5, “Provisioning
Concepts”

Explains provisioning concepts associated with
network elements, connections, optical layers,
subnets, and preplan restoration.

Chapter 6 Chapter 6, “Network Element Port
Addresses ”

Lists the port addresses of the network elements
supported by Navis™ Optical PM - NP.

Index Index Enables the user to quickly find information on
specific topics.

Provisioning Guide About this information product
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Conventions used This Provisioning guide uses the following typographical conventions
to distinguish between computer input and output.

• When describing the Navis™ Optical PM - NP software, fields in
windows and field entries are identified with this font.

• When describing the UNIX environment, text and numbers that
the user inputs to the computer are identified with boldface
type.

• In the UNIX environment, text and numbers that the computer
outputs to the user are identified with monospace type.

Related documentation This Provisioning guide is part of a set of documents that supports
Navis™ Optical PM - NP.

List of documents

The document set that supports Navis™ Optical PM - NP comprises:

1. Navis™ Optical PM - NP Getting Started Guide, (365-314-105):
provides information useful to first-time users of the Navis™

Optical PM - NP software. It describes how to start and stop
Navis™ Optical PM - NP, how to use the software, and how to
interpret the graphical user interface.
This document includes tasks and conceptual information.

2. Navis™ Optical PM - NP Provisioning Guide, (365-314-106)
instructs users on how to provision and manage a network using
Navis™ Optical PM - NP.
This document includes tasks and conceptual information.

3. Navis™ Optical PM - NP Maintenance Guide, (365-314-107)
instructs users on how to maintain Navis™ Optical PM - NP and
a network.
This document includes tasks and conceptual information.

4. Navis™ Optical PM - NP Administration Guide, (365-314-108)
instructs users on how to administer Navis™ Optical PM - NP
and a network.
This document includes tasks and conceptual information.

Glossary

The Navis™ Optical PM - NP Administration Guide contains a
glossary that will be helpful to users of Navis™ Optical PM - NP.

Provisioning Guide About this information product
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On-line documentation

On-line documentation for Navis™ Optical PM - NP is provided in
two formats:

1. An on-line version, in HTML format, of this document set is
provided as part of the Navis™ Optical PM - NP software.

2. An on-line version, in HTML format, of this document set is
available on CD-ROM.
Navis™ Optical PM - NP User Documentation CD-ROM,
(365-314-109) - includes the full set of documents listed above.

Screen help

The Navis™ Optical PM - NP software includes screen help for each
form, which describes the purpose of the form, each field, and each
button.

How to comment To comment on this information product, go to the Online Comment
Form (http://www.lucent-info.com/comments) or email your comments
to the Comments Hotline (ctiphotline@lucent.com).

How to order To order Navis™ Optical PM - NP information products, contact your
Lucent Technologies customer team representative or contact the
Lucent Technologies:

From the United States, call 1-888-LUCENT8, prompt 1.

From Canada, call 317-322-6619.

From Europe, the Middle East, and Africa, call 317-322-6416.

From Asia, the Pacific Region, China, the Caribbean, and Latin
America, call 317-322-6411.

Provisioning Guide About this information product
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1 System Overview

Overview
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Purpose This chapter provides a system overview of the Navis™ Optical
Provisioning Manager (PM) - Network Provisioning (NP) application.
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Product Definition

Overview
....................................................................................................................................................................................................................................

Purpose This section provides a product definition for the Navis™ Optical
Provisioning Manager (PM) - Network Provisioning (NP) software
product.

Definition Navis™ Optical PM - NP provides end-to-end management of service
within SONET and optical networks.

Navis™ Optical PM - NP allows service providers to perform
provisioning and maintenance for a network that includes the
following types of connections:

• Synchronous Optical Network (SONET) links and trails

• Optical layer (optical links, optical channel trails, and optical
multiplex sections).

PDH is supported as ports at the edge of the network and as digital
links.

Capabilities From a single operator seat, an entire network can be managed using
Navis™ Optical PM - NP. Navis™ Optical PM - NP is designed to
manage different network elements and features on a cost-effective
combination of hardware platforms.

System Overview
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External interfaces
....................................................................................................................................................................................................................................

Introduction The Navis™ Optical PM - NP interfaces are shown in the following
figure.

Northbound interfaces The following sections describe the northbound interfaces.

ASCII northbound alarm interface (TIM interface)

The ASCII northbound alarm interface is used to integrate with
other-vendor and customer systems. The ASCII northbound alarm
interface is also known as the TMN Integration Module (TIM)
interface.

Southbound interfaces Navis™ Optical PM - NP manages network elements through
southbound interfaces to EMSs. The following sections describe the
southbound interfaces.

Figure 1-1 Navis™ Optical PM - NP interfaces

Service Management

Service Description Service Impact

Network Management
(Navis Optical PM - NP)

Network Circuit Design Filtered Alarms
Configuration Information
Performance Monitoring

Element Management
(Navis Optical EMS)

Network Element Provisioning Commands Configuration Data
Command Responses
Alarms

Network Element
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G7 2.0 CORBA interface to Navis™ Optical EMS

A G7 2.0 CORBA interface is provided to the following
CORBA-based EMSs:

• Navis™ Optical Element Management System (EMS) (formerly
WaveStar SNMS)

Interfaces to other
systems

Navis™ Optical PM - NP interacts with some other systems that
supply information used to manage the network. The following
sections describe the interfaces to other systems.

Performance Monitoring (PM) Export

Performance monitoring data can be exported in files periodically. The
file transfer uses FTP over TCP/IP to copy files from the EMSs to a
designated workstation.

Product Definition
External interfaces

System Overview
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Supported element management systems (EMSs)
....................................................................................................................................................................................................................................

Introduction Navis™ Optical PM - NP manages a network by interworking with an
element management system (EMS).

List of supported EMSs Navis™ Optical PM - NP, Release 1.1 interacts with the following
Lucent Technologies element management systems (EMSs):

• Navis™ Optical EMS, Release 8.0

Important! Navis™ Optical EMS is the new name for the product
formerly known as WaveStar SNMS.

Navis™ Optical EMS Navis™ Optical EMS manages the following Lucent Technologies
network elements:

• WaveStar® BandWidth Manager

• WaveStar OLS 1.6T (formerly 400G)

• LambdaRouter™ 128/256 All-Optical Switch (AOS)

• LambdaUnite™ MultiService Switch (MSS)

• WaveStar TDM 2.5/10G

• Metropolis® Enhanced Optical Networking (EON)

• Metropolis DMX Access Multiplexer

• Metropolis DMXpress Access Multiplexer

Important! Navis™ Optical EMS is the new name for the product
formerly known as WaveStar SNMS.

About EMS cut-through A “cut-through” interface to the Navis™ Optical EMS GUI is
provided. It is accessed by right-clicking on a node and selecting
“Login to EMS” from the resulting menu. The cut-through interface
allows a user to invoke the EMS view of the node, access more
detailed information about the node, and perform a more detailed
analysis of an equipment failure.

Product Definition System Overview
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Supported network elements
....................................................................................................................................................................................................................................

Introduction This section describes the network elements that are supported
byNavis™ Optical PM - NP.

Releases of network
elements

For a complete list of supported network elements, refer to Chapter 5,
“Provisioning Concepts”.
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Supported digital links
....................................................................................................................................................................................................................................

Introduction This section describes the digital links that are supported byNavis™

Optical PM - NP.

Releases of digital links For a complete list of supported digital links, refer to Chapter 5,
“Provisioning Concepts”.
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Benefits
....................................................................................................................................................................................................................................

Introduction The benefits delivered by Navis™ Optical PM - NP include fast
service activation, state-of-the-art provisioning, reduced operating and
equipment costs, accurate record keeping, fault and performance
monitoring, and fast problem resolution.

These benefits enable service providers to capture market share and
offer an improved level of service to customers, and to efficiently
manage their resources.

List of benefits Navis™ Optical PM - NP provides service providers with the ability
to:

• Manage multi-technology SONET equipment

• Perform end-to-end SONET circuit/trail provisioning (using
automatic, partial, and manual routing)

• Perform end-to-end DWDM optical channel provisioning (using
automatic, partial, and manual routing)

• “Single-seat” control of the network

• Management of all EMSs in the network

• Simplify operational complexity using the user-friendly graphical
user interface (GUI)

• Maximize bandwidth utilization with flexible provisioning
options and scheduled path provisioning features

• Monitor and maintain service quality using performance
monitoring

• Use scalable platforms to cost-effectively support different sizes
of networks

• Maintain access security and establish a hierarchy of access
levels

Customer support Navis™ Optical PM - NP customers are provided with responsive field
support, effective user documentation, and high-quality product
training.

Product Definition System Overview
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Features per functional area

Overview
....................................................................................................................................................................................................................................

Purpose The features of Navis™ Optical PM - NP are classified into several
functional areas. This chapter gives a description of these features
within each functional area.
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User support facilities
....................................................................................................................................................................................................................................

Introduction Navis™ Optical PM - NP provides a number of capabilities to
facilitate the task of managing network elements.

Graphical user interface
(GUI)

Navis™ Optical PM - NP supports the user in his/her daily operations
with an easy-to-use graphical user interface (GUI).

Network Map The main feature of the GUI is a Network Map on which all the
network elements and links within the domain of Navis™ Optical PM
- NP are displayed. Network elements and links are colored to show
the highest severity alarm occurring. The country map that is the
background of the Network Map can be changed by the system
administrator.

Other user support
facilities

Navis™ Optical PM - NP has the following user support facilities:

• Navis™ Optical PM - NP is capable of handling up to 64
simultaneous user logins.

• Screen help is provided for each form.

• On-line access to the product documentation set is integrated into
the Navis™ Optical PM - NP software.

• Help facilities (context-sensitive) are supported. Help texts
contain context-sensitive hyperlinks.

• A user log provides a record of all operations made by a user. It
can be viewed by that user and by the administrator.

Features per functional area System Overview
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Security issues
....................................................................................................................................................................................................................................

Introduction Navis™ Optical PM - NP security management allows authorized users
to have different levels of access.

For each user, Navis™ Optical PM - NP stores a login ID, password,
user type, and user profile.

Controlling access Only authorized users with correct login ID/password combinations
are able to access Navis™ Optical PM - NP.

User type Every user is assigned a user type.

For Navis™ Optical PM - NP, there is only one user type:

• Regular user: For all users

User profile The user profile controls which of the task groupings a user is
allowed to perform. A user can be assigned more than one user
profile.

Task groupings

There are eight task groupings that can be assigned to a user profile.

1. Fault Management

2. Configuration Management

3. Performance Monitoring

4. NE Management

5. Sys Admin

6. Fault Management (View Only)

7. Configuration Management (View Only)

8. Performance Monitoring (View Only)

Predefined user profiles

There are four predefined user profiles:

Features per functional area System Overview

....................................................................................................................................................................................................................................

1 - 1 2 Lucent Technologies 365-314-106R1.1
Issue 1, July 2002



Table 1-1 Predefined user profiles

User profile Allowed task groupings

Initial This profile provides access to the following
task groupings:

• Fault Management

• Configuration Management

• Performance Monitoring

• NE Management

Alarm
Management

This profile provides access to the following
task groupings:

• Fault Management

Provisioning (View
Only)

This profile provides access to the following
task groupings:

• Configuration Management (View Only)

Combined This profile provides access to the following
task groupings:

• All Tasks

Customized user profiles

The system administrator can create and assign additional user profiles
that are customized to meet the specific needs of their network.

Default behavior

By default, all new users are assigned to the Initial user profile.

Other security features Features and tasks that are not available to a user are grayed-out.

If a terminal with an active Navis™ Optical PM - NP session
experiences a period of inactivity, the terminal is locked. It can be
unlocked by entering the password of the current user.

Features per functional area
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Configuration management
....................................................................................................................................................................................................................................

Introduction Navis™ Optical PM - NP provides configuration management
capabilities and features that are supported by a user-friendly GUI.
From the Network Map, a user can complete all the steps needed for
end-to-end provisioning, implementation, and record keeping of
optical channels, and SONET digital links, paths, and circuits. In
addition, automatic circuit/path provisioning using a powerful
auto-router algorithm is provided.

Digital link provisioning Using Navis™ Optical PM - NP, digital links are provisioned using a
form accessed from the Network Map.

Digital link provisioning is accomplished by providing the following
information on the form:

1. The desired transmission rate of the digital link

2. The two endpoint nodes of the digital link

3. The two endpoint port address of the digital link (Port address
information can either be entered manually or it can be obtained
using a context-sensitive cut-through to the appropriate EMS
where the user can graphically select the desired ports.)

Path and circuit
provisioning

Using Navis™ Optical PM - NP, paths and circuits are provisioned
using a form accessed from the Network Map.

Path and circuit provisioning can only be done after digital links are
in place.

Path and circuit provisioning is accomplished by providing the
following information on the form:

1. The desired path level (for example, STS-1 or STS-12c). Navis™

Optical PM - NP displays only those path levels that can be
supported by all the digital links involved.

2. The two endpoint nodes of the path or circuit

Three modes for path and circuit provisioning

Navis™ Optical PM - NP provides three modes for path and circuit
provisioning: Automatic, Partial, or Manual. The default is Automatic.

Features per functional area System Overview
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For one-way and broadcast paths, only manual route selection is
allowed .

• Automatic: The automatic mode provides the most assistance to
the user. The user specifies the A-Port and the Z-Port. The
system finds the route automatically, based on the available spare
capacity between specified points. For auto-ring-protected paths,
it is a requirement that the same channels must be used on all of
the segments of the path. For line-switched rings, the system
attempts to fill up lower channels around the ring first before
attempting to use the next channels within a segment. The user
can modify the system’s recommendations before the route is
committed and implemented. Nothing is changed in the network
until the user has provided confirmation.

• Partial: The partial mode allows the user to select the link along
the path, and optionally, to additionally specify a channel along
the path. At a minimum, each link along the path must be
specified. In this case, the system selects the channel on each
facility.

• Manual: The manual mode provides the most flexibility and
works best for Open_Ended_Z paths that are provisioned using
one PDH port and two SONET ports on the same network
element. In addition to specifying the A/Z Location and the port,
the user specifies each link and channel along the path.

Scheduled Provisioning

The Navis™ Optical PM - NP Scheduled Provisioning feature provides
the capability to accept customer requests for services to be turned up
at a future date. Order and layout data are entered into Navis™ Optical
PM - NP at the time the request is received from the customer. At this
time, Navis™ Optical PM - NP validates the order and layout data and
stores the information in the database, but it does not “reserve” the
requested resources. At the designated date and time, the system
automatically implements the circuit/facility (that is, sets up the port
parameters and/or cross-connections). After the completion of the
implementation, the user is able to perform required testing.

Features per functional area
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Network-level facilities
....................................................................................................................................................................................................................................

Introduction The network-level facilities include:

• Network element control and resource management

• Reports management

Network element control
and resource management

Support of all Lucent Technologies SONET and optical DWDM
network elements is provided through the EMSs.

All network elements are managed with synchronized network
element equipage and status information.

Resource management of Navis™ Optical EMS-controlled network
elements is provided through a “cut-through” from the Navis™ Optical
PM - NP to theNavis™ Optical EMS interface.

Reports management Navis™ Optical PM - NP can provide on-demand, predefined reports
containing summary and analysis data. These reports complement the
information that is presented on the Network Map, on the forms, and
in the dialog boxes.

Features per functional area System Overview
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Fault management
....................................................................................................................................................................................................................................

Introduction The status together of all components in the network must be closely
monitored to anticipate possible degradation of the services, and to
react as quickly and adequately as possible to failures. Fault
management encompasses the handling of alarms and events.

Navis™ Optical PM - NP includes powerful alarm handling tools that
provide alarm notification, fault isolation, failed-facility and affected
circuit identification, and alarm logs.

Two modes The fault management system may be set to operate in one of two
modes: alarm mode and service mode.

• Alarm mode focuses on management from the Alarm List.

• Service mode focuses on management from Traffic Correlated
Alarm List.

The mode used is set as an installation option.

Network event summaries Network event summaries provide:

• A summary of alarms for the network, including counts of events
by alarm state and other breakdowns

• Alerts for new alarms

• Display of most recently received alarms at base of window

Different network event summaries are provided for the alarm mode
and for the service mode.

The network event summaries offer these features:

• A versatile presentation that can be customized by hiding and
expanding counts and alarm displays

• Filtered access to Alarm List and Traffic Correlated Alarm List

• Access to complete Alarm List and Traffic Correlated Alarms
List

Alarm List The Alarm List provides:

• A combined list of all network, EMS, and network element
alarms

• The ability to filter the Alarm List manually or automatically

Features per functional area System Overview
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• A record of instantaneous, as well as persistent, alarms

• Details of each alarm

The user may:

• Acknowledge one or more selected alarms

• Create trouble ticket(s) for selected alarm(s)

• Attach an additional alarm to an existing trouble ticket

• Configure on-line suppression of secondary alarms

In the service mode, correlated alarms cannot be acknowledged or
assigned to a trouble ticket.

Traffic Correlated Alarms
List

The Traffic Correlated Alarms List provides the following
information:

• Alarms that affect traffic are correlated to network objects.

• Alarms are classified as internal or external to management
domain.

• In addition to trails, alarms may be correlated to:

- Network element and port (failure on network boundary)

- Network element and card (equipment failure with traffic
impact)

• For each alarm, both Fault State and Service Impact are
provided.

• Users may configure on-line suppression of secondary faults.

• Customer priority field shows highest priority of the failed client
services, and alarms can be sorted by customer priority.

Fault state determination If an alarm correlates to a trail, a fault state for that trail and its client
trails (trails carried by the alarmed trail) is calculated. Fault state is
determined using a real-time calculation.

Fault state has the following characteristics:

• Takes account of protection (Multiplex Section Protection [MSP],
Multiplex Section-Shared Protection Ring [MS-SPRING], and
Subnetwork Connection Protection [SNCP])

• Assumes protection switching is successful and uses end port
alarms to identify unsuccessful attempts

Features per functional area
Fault management
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• A failed fault state is propagated to client trails, and a degraded
fault state is not. For example, if the fault state of a trail becomes
failed, the fault states of all of its client trails also become failed.
However, if the fault state of a trail becomes “degraded,” the
fault states of its client trails remain working (unless affected by
another failure).

• Propagates from optical to SONET layers

Fault state values are: Failed, Degraded, and Working.

Service impact Service impact is assessed based on the fault state of all client
services.

Where there are failed client services, the service impact is the
worst-case fault state value.

Service Impact values are: Failed, Degraded, No Services, and
Calculating

Calculating value is possible where there are many clients.

Where the failed connection in the Traffic Correlated Alarms List is
itself, the fault state and service impact values are the same.

Repeated Alarm List Repeated alarms are marked on the Alarm List with a repeat alarm
flag. The Repeated Alarm List is accessed by clicking on this flag.

The Repeated Alarm List does the following:

• Shows details of previous occurrences with the same probable
cause and source

• Allows identification of transient alarms

Trouble ticket Trouble ticketing is available for alarms (in addition to Traffic
Correlated Alarms List records).

Trouble tickets have the following characteristics:

• Multiple alarms can be associated with a single trouble ticket.

• An owner can be assigned to resolve the trouble ticket.

• The trouble ticket exists until the associated alarms or Traffic
Correlated Alarms List records are deleted (made historic).

• Users may delete trouble tickets.

Features per functional area
Fault management

System Overview

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 1 - 1 9



Generic filtering and
sorting

The following filtering options are provided:

• There is an unlimited number of filter keys.

• Filtering is provided for any value of most displayed fields.

• Filtering is provided on user-entered search string.

The following sorting options are provided:

• There is an unlimited number of sort keys.

• Any field may be selected for sorting.

• Sorting may be in ascending or descending order, as specified by
the user.

Alarm log The Alarm Log displays historic records of alarms.

The Alarm Log includes:

• Two views: service and alarm

• Options to print, export, and archive

• Full filtering and sorting facilities (However, there is a restriction
on the number of records that can be displayed.)

• Configurable size for alarm storage

When the number of historic records approaches the limit, an alarm is
raised.

Features per functional area
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Performance monitoring
....................................................................................................................................................................................................................................

Introduction Performance monitoring specifies continuous monitoring of
termination points within SONET equipment. This enables the system
administrator to:

• initiate proactive maintenance by spotting performance
degradation

• precisely monitor the quality of the end-to-end paths

Monitored events The different events that can be distinguished are described in the
following table.

Table 1-2 Monitored events

Event Indicates that ...

Errored Seconds (ES) A one second period with one or more
errored blocks

Severely errored
seconds (SES)

A one second period with more than 30%
errored blocks

Unavailability seconds
(UAS)

Seconds of unavailability time (10 or more
consecutive SES gives UAS)

Background Block
Errors (BBE)

An errored block not occurring as part of
an SES

Performing monitoring
features

The performance monitoring features include:

• The user can specify which counts (15-minute bins or 24-hour
bins) are to be taken from which transport facilities (for example,
STS-1 or MS) for which network element.

• In case the association between Navis™ Optical PM - NP and the
network element fails, Navis™ Optical PM - NP regains
information about the lost time by reading the network element’s
bins for the relevant interval.

• Navis™ Optical PM - NP supports performance monitoring as
provided by the particular SONET network elements. This
includes ES, SES, UAS, and BBE parameters for OC-48 and
OC-192, section, and line termination points.

• The Navis™ Optical PM - NP performance data log provides a
minimum capacity of up to 31 days for the 24-hour bins and 24
hours for the 15-minute bins.

Features per functional area System Overview
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• Performance collecting can be enabled/disabled by the user.

• Inspection of snapshots of counts can be done via current
registers.

• The user can print completed performance monitoring reports in
tabular and graphical format. In this way, the user may easily
spot trends in performance behavior.

• The user may select one or two termination points for viewing or
printing. Depending on the termination point type, the user may
select up to a maximum of four counters (the counters available
depend on the termination point type). The information can be
displayed in a tabular form or in a graphical form. The
display/print covers 31 days for the 24-hour bins and 24 hours
for the 15-minute bins.

• Performance monitoring data can be written to tape in ASCII
form.

• Navis™ Optical PM - NP stores historical performance monitoring
data only, although it can retrieve and present current bin
performance monitoring data in user reports. The historical
performance monitoring data is retrieved periodically from the
network element.

Performance monitoring
measurements

Performance monitoring is based on measurements taken on blocks
being transported through the network (where a block is a number of
consecutive bits). An error event inside a block can be discovered by
applying inherent Error Detection Code (for example, Bit Interleaved
Parity [BIP]). If an error event occurs in the block, an errored block
will be counted.

Features per functional area
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Other features
....................................................................................................................................................................................................................................

Introduction This section describes some of the other features of Navis™ Optical
PM - NP.

On-line documentation This feature provides on-line access to the product document set,
integrated into the Navis™ Optical PM - NP software.

The documentation set consists of the following documents:

• Navis™ Optical PM - NP Administration Guide

• Navis™ Optical PM - NP Provisioning Guide

• Navis™ Optical PM - NP Maintenance Guide

The on-line documentation is accessed from the Help menu on the
Network Map.

Features per functional area System Overview
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Optional features
....................................................................................................................................................................................................................................

Introduction This section describes the optional features of Navis™ Optical PM -
NP.

Performance Monitoring
(PM) Data Export

Performance Monitoring (PM) Data Export allows performance
monitoring information to be stored in a predefined data file. Users
with the appropriate privileges can remotely access this data file and
use it for a variety of purposes.

ASCII northbound alarm
interface

The ASCII northbound alarm interface is an optional interface.

The ASCII northbound alarm interface is used to integrate with other
vendor and customer systems. The ASCII northbound alarm interface
is also known as the TMN Integration Module (TIM) interface.

Optical Network Navigator
(ONN)

Optical Network Navigator (ONN) is software and hardware present
in the LambdaRouter that performs management functions (for
example, configuration and fault management) on optical connections
across a network of LambdaRouters.

An ONN domain is the area of a network that is under the control of
an ONN.

This optional feature allows a user to perform network management
(including provisioning and fault management) for connections within
an ONN domain, from the Navis™ Optical PM - NP Network Map.

This feature also allows a user to control Shared Risk Groups from
Navis™ Optical PM - NP. A Shared Risk Group is an identifier used to
indicate risk among fibers that use the same conduit. All entities that
share the same risk can be grouped into a Shared Risk Group.

Features per functional area System Overview
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Strategies for ensuring high-availability

Overview
....................................................................................................................................................................................................................................

Purpose Many customers use Navis™ Optical PM - NP in a network where a
high degree of system availability is a necessity. This section
describes the high-availability strategies that can be used with Navis™

Optical PM - NP to protect against system downtime.

High-availability strategies The following high-availability strategies are supported:

• Uninterruptible Power Supply (UPS)

• Mirrored disks

Contents
Uninterruptible Power Supply (UPS) 1-26

Mirrored disks 1-27
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Uninterruptible Power Supply (UPS)
....................................................................................................................................................................................................................................

Description An Uninterruptible Power Supply (UPS) protects against power
failures. It is used to protect the server hardware, client hardware, and
their essential peripherals from minutes of power failure. In the case
of a longer power loss, the UPS enables the system to shut down
gracefully.

When to use The use of UPS is recommended in all cases. However, due to the
site-specific nature of power requirements, it is not a mandatory
requirement.
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Mirrored disks
....................................................................................................................................................................................................................................

Description Mirrored disks protect against disk failures. When mirrored disks are
used, all data is written to two disk systems. In the event of a disk
failure, no data is lost and there is no interruption of system operation
at the time of the disk failure. The damaged disk will need to be
replaced, which may require a system shutdown, but this can be done
as part of scheduled maintenance and will not cause any unexpected
downtime.

Strategies for ensuring high-availability System Overview
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Applications

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the applications supported by Navis™ Optical
PM - NP.
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Supported applications
....................................................................................................................................................................................................................................

Introduction Standard applications have been defined for Navis™ Optical PM - NP.

These applications are used to define the hardware platforms for each
application.

The hardware platforms for each application are not described in this
document.

List of applications The standard applications are:

• Small: The small application is a small-scale application.

• Medium: The medium application is a medium-scale application.

• Large: The large application is a large-scale application.

Network topology In all of the applications, each instance of Navis™ Optical PM - NP
and the EMSs is loaded on its own server. Navis™ Optical PM - NP
can communicate with all of the EMSs in the network, and with the
network elements they manage.

The three applications have the same network topology, but vary in
the number of users, EMSs, and network elements that are supported.
The following figure illustrates the network topology used by all three
applications.

Figure 1-2 Network topology example
Clients

General-purpose
Network
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Ordering

Overview
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Purpose This section describes how to order Navis™ Optical PM - NP.
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How to order Navis™ Optical PM - NP
....................................................................................................................................................................................................................................

Overview This section describes how to order Navis™ Optical PM - NP.

Ordering Navis™ Optical PM - NP is ordered by calling a Lucent sales
representative.

Ordering System Overview

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 1 - 3 1



Orderable items
....................................................................................................................................................................................................................................

Overview This section lists the items that are orderable. The lists in this section
should be used to help prepare an order before it is actually placed.

Application Software: Core The following table contains the comcodes for the application
software core.

Table 1-3 Comcodes: application software code

Description Comcode

Navis™ Optical PM - NP Release 1.1 Core KIT:
NL R1.0 (includes both DAT and DVD)

109228643

Navis™ Optical PM - NP Release 1.1 Core DAT:
NL R1.0

109228627

Navis™ Optical PM - NP Release 1.1 Core
DVD: NL R1.0

109228635

Application Software:
Optional Features

The following table contains the comcodes for the application
software options.

Table 1-4 Comcodes: application software options

Description Comcode

Navis™ Optical PM - NP Release 1.1 Option:
ASCII Northbound Alarm Interface

109228668

Navis™ Optical PM - NP Release 1.1 Option:
PM Data Export

109228676

Application Software:
Network Element RTU

The following table contains the comcodes for the network element
Right to Use (RTUs).

Table 1-5 Comcodes: network element Right to Use

Description Comcode

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: WaveStar TDM 2.5/10G

109228684

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: WaveStar BandWidth Manager

109228692

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: Metropolis EON

109228700

Ordering System Overview
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Table 1-5 Comcodes: network element Right to Use
(continued)

Description Comcode

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: Metropolis DMX Access
Multiplexer

109228718

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: Metropolis DMXpress Access
Multiplexer

109228726

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: WaveStar OLS 1.6T (formerly
400G)

109229914

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: LambdaRouter

109229922

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: LambdaRouter with ONN

109229930

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: LambdaUnite MSS

109229948

Navis™ Optical PM - NP Release 1.1 Network
Element RTU: Black Box (unmanaged object)

109229955

Documentation The following table contains the comcodes for the Navis™ Optical PM
- NP user documentation.

Table 1-6 Comcodes: User documentation

Description Comcode

Navis™ Optical PM - NP Release 1.1 Getting
Started Guide - English (365-314-105R1.1)

109294223

Navis™ Optical PM - NP Release 1.1
Provisioning Guide - English (365-314-106R1.1)

109294231

Navis™ Optical PM - NP Release 1.1
Maintenance Guide - English (365-314-107R1.1)

109294249

Navis™ Optical PM - NP Release 1.1
Administration Guide - English (365-314-
108R1.1)

109294629

Navis™ Optical PM - NP Release 1.1 User
Documentation CD-ROM - English
(365-314-109R1.1)

109294637
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Maintenance The following table contains the comcodes for the maintenance
packages.

Table 1-7 Comcodes: Maintenance packages

Description Comcode

Navis™ Optical PM - NP Release 1.1
Maintenance Fee (with one upgrade a year)

109232033

Navis™ Optical PM - NP Release 1.1
Maintenance Fee (without upgrades)

109232041
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Product support

Overview
....................................................................................................................................................................................................................................

Purpose This chapter describes product support available for Navis™ Optical
PM - NP.
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Technical Assistance
....................................................................................................................................................................................................................................

Introduction Lucent Technologies is committed to providing excellence in technical
support for its products.

A support structure is ready and available to resolve any technical
issue related to Navis™ Optical PM - NP.

Getting help In the continental United States, when you need additional technical
assistance, the Lucent Technologies Global TSS Contact Center is
your first point of contact. Technical assistance is available 24 hours a
day, 7 days a week. Contact the Global TSS Contact Center at
866-LUCENT8 (866-582-3688).

Outside the continental United States, contact your Local Customer
Support (LCS) or the support organization designated by your Lucent
customer team representative. If you are unsure of who to call, contact
the Global TSS Contact Center at 630-224-4672.

Local support procedures Some customers have established their own support procedures that
involve escalation within their own companies. In these cases, be sure
to follow the procedures established by your company.

Product support System Overview
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User documentation
....................................................................................................................................................................................................................................

Introduction This information product is part of a set of documents that supports
Navis™ Optical PM - NP.

List of documents The document set that supports Navis™ Optical PM - NP comprises:

1. Navis™ Optical PM - NP Getting Started Guide, (365-314-104)
provides information needed when you are learning how to use
the Navis™ Optical PM - NP software. It describes how to start
and stop Navis™ Optical PM - NP, how to use the software, and
how to interpret the graphical user interface.
This document includes tasks and conceptual information.

2. Navis™ Optical PM - NP Provisioning Guide, (365-314-100R1.0)
instructs users how to use Navis™ Optical PM - NP to provision
and manage a network.
This document includes tasks and conceptual information.

3. Navis™ Optical PM - NP Maintenance Guide, (365-314-102R1.0)
instructs users on how to maintain Navis™ Optical PM - NP and
the network.
This document includes tasks and conceptual information.

4. Navis™ Optical PM - NP Administration Guide,
(365-314-102R1.0) instructs users on how to administer Navis™

Optical PM - NP and the network.
This document includes tasks and conceptual information.

On-line documentation On-line documentation for Navis™ Optical PM - NP is provided in
two formats:

1. An on-line version, in HTML format, of this document set is
provided as part of theNavis™ Optical PM - NP software.

2. An on-line version, in HTML format, of this document set is
available on CD-ROM.
Navis™ Optical PM - NP User Documentation CD-ROM,
(365-314-103R1.0) includes the full set of documents listed
above.

Screen help The Navis™ Optical PM - NP software includes on-line help for each
window, which describes the purpose of the window, each of the
fields, and each of the buttons.

Product support System Overview
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How to order To order Navis™ Optical PM - NP information products, do one of the
following:

• Contact your Lucent Technologies customer team representative.

• Contact the Lucent Technologies at:

- From the United States, call 888-LUCENT8 (888-582-3688),
prompt 1.

- From Canada, call 317-322-6619.

- From Europe, the Middle East, and Africa, call
317-322-6416.

- From Asia, the Pacific Region, China, the Caribbean, and
Latin America, call 317-322-6411.

Product support
User documentation

System Overview
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2 The Navis™ Optical PM - NP
Provisioning Process

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides an overview of the Navis™ Optical PM - NP
provisioning process.

Important note This document instructs users on how to provision with Navis™

Optical PM - NP.

This document contains two types of chapters:

• Task chapters that describe provisioning tasks (that is,
step-by-step instructions). The tasks described within this
document do not require adminstrator privileges.

• Conceptual chapters that contain detailed information related to
the tasks.

Task chapters are located in the front of the document; conceptual
chapters follow the task chapters.

Contents
What is provisioning? 2-2

Terminology overview 2-3

Task information 2-8

Conceptual information 2-9
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What is provisioning?
....................................................................................................................................................................................................................................

Overview Provisioning, as it pertains to Navis™ Optical PM - NP, is the process
of establishing a connection through a Navis™ Optical PM - NP
managed network and setting appropriate transmission parameters for
a digital link, optical link, optical multiplex section, optical channel
trails, and circuit/trails for a specified SONET rate.

This overview assumes that all of the administrative procedures
needed to have the system fully operational have been completed by
the system administrator or a user with administrator privileges.

Supported actions Navis™ Optical PM - NP allows users to perform the following
actions for provisioning:

• Add: users can provision new digital links, circuit/trails and
optical layers from Navis™ Optical PM - NP.

• Disconnect: users can delete existing digital links, circuit/trails
and optical layers from Navis™ Optical PM - NP.

• Modify: users can modify an existing circuit/trail to create a new
route.

• Merge: users can merge two or more circuits/trails of the same or
equivalent rate to form one new circuit/trail. This activity from
Navis™ Optical PM - NP will not create any implementation
commands.

The Navis ™ Optical PM - NP Provisioning Process
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Terminology overview
....................................................................................................................................................................................................................................

Overview This section provides an overview of the common terms and concepts
necessary to understand the Navis™ Optical PM - NP product and
provisioning process.

For a complete listing of Navis™ Optical PM - NP-related terms, refer
to the glossary section of the Navis™ Optical PM - NP
Administration Guide.

Aggregate An aggregate is a collection of one or more network elements or
aggregates. An aggregate is represented by a single icon on the
Navis™ Optical PM - NP Network Map.

Area Networks managed by Navis™ Optical PM - NP can be subdivided
into smaller, more manageable networks called areas. An area is a
collection of nodes and/or aggregates and their associated links.
Subdividing a network into areas reduces overcrowding on the user
interface and improves system performance because smaller amounts
of information are exchanged by the subsystems.

Areas can be defined for any purpose. Examples of areas can include:

• A set of nodes/aggregates dedicated to a subscriber

• A set of nodes/aggregates either connected or not connected

• A set of nodes/aggregates in a geographic location or building

An area is represented by a single icon on the Navis™ Optical PM -
NP Network Map.

Black box A black box is a functional unit in a network displayed on the Navis™

Optical PM - NP Network Map that Navis™ Optical PM - NP cannot
monitor or control (also known as noncontrolled network element).

Channel When either a digital link or trail is channelized, it is subdivided into
channels. For time division multiplexing equipment, channels
represent the time slots with which information is carried within a
digital link or in a server trail. Channels are created by Navis™

Optical PM - NP for use during circuit/trail provisioning. When
creating channels for digital links, depending on the network element
capability, alternate channels, to accommodate the provisioning of
different rates of circuits/trails, are created.

The Navis ™ Optical PM - NP Provisioning Process
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Circuit A circuit is a concatenation of link connections and sub-network
connections to provide an end-to-end service to a customer. A circuit
is identified by a rate at which the service is provided. The “rate” of a
circuit is defined by ITU and ANSI standards for SONET and
Asynchronous circuit. An SONET trail is provisioned over SONET
link connections and over SONET cross-connects in Navis™ Optical
PM - NP managed network elements.

The following figure shows how a circuit relates to a trail and digital
links.

Digital link Digital links are fiber or electrical connections between two points.
These transport facilities are assignable to high-order and low-order
circuits to carry customer services.

The following figure shows a digital link.

Figure 2-1 A circuit in relation to a trail and digital links
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Equipment Equipment is a functional unit in a network that is not displayed on
the Navis™ Optical PM - NP Network Map and which Navis™ Optical
PM - NP cannot monitor or control (also known as noncontrolled
network element). Equipment is displayed in the Graphical Layout
screen. Some examples of equipment is customer premises equipment.

Network A network carries a payload from one point to another. This payload
can consist of data, voice, video, or images. Digital links and trails
carry the circuits that carry the data.

Network element A network element is a functional unit in a customer’s network that
displays on the Navis™ Optical PM - NP Network Map and is
controlled by the user. Network elements supply switching,
transmission, or multiplexing functionality in a network and are either
controlled or noncontrolled.

Optical network navigator The Optical Network Navigator (ONN) is the software and hardware
present in the LambdaRouter network element which performs
management functions on optical connections across a network of
LambdaRouters. The ONN system consists of a number of ONN
Modules, each on a different LambdaRouter.

Ring A ring is formed when digital links connect all participating network
elements to form a closed loop (of course, the network elements have
ring forming capabilities).

Figure 2-3 Sample formation of four rings
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Shared risk group A shared risk group is an identifier indicating risk among fibers using
the same conduit. All entities that share the same risk can be grouped
into a risk group.

Tandem connection A tandem connection is the sublayer between the multiplex section
layer and the path layer that allows users to monitor the quality of the
signal transport within its managed domain. A tandem connection also
provides users with information about the total quality of a signal
before the signal travels from the user’s managed network to a
network managed by a different user. Users can create tandem
connections on paths that do not terminate in its managed network but
traverse its network from other user managed networks.

Trails A trail is a logical connection between two adjacent, or nonadjacent
network element. It may traverse one or more channels and supports
add/drop capability along the path.

Trails simplify provisioning by allowing users to establish routes
through digital links and network elements so that circuits can be
assigned to the path. This capability allows users to assign a circuit to
a path at the path’s A and Z ends without spelling out a list of digital
links and cross-connections that make up the trail. Two or more trails
may be connected as part of a circuit.

Trails ride on one or more digital links and also contain their own
payload and overhead sections.

The following figure shows how a trail relates to digital links.

Figure 2-4 Relationship between a trail and digital links
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Virtual concatenation Virtual concatenation is a standards compliant mechanism for
efficiently transporting payloads which do not neatly fit into a
standard SONET-sized container across a SONET network. It works
by distributing the payload across a number of standard SONET
containers, transporting the containers independently across the
network and then re-assembling the payload a the other side.

Terminology overview The Navis ™ Optical PM - NP Provisioning Process
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Task information
....................................................................................................................................................................................................................................

Overview This section describes the task information appearing within this
guide. This information is extremely useful when attempting to
perform the actual action of provisioning with Navis™ Optical PM -
NP.

Location Refer to Chapter 3: Network Element Configuration Tasks for task
information related to network elements; refer to Chapter 4:
Provisioning Tasks for task information regarding digital links,
connections, optical layers, subnets, virtual concatenation groups, and
shared risk groups.

The Navis ™ Optical PM - NP Provisioning Process
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Conceptual information
....................................................................................................................................................................................................................................

Overview This section describes the conceptual information appearing within
this guide. This information is useful in understanding the ’big
picture’ of a given feature as well as its technicalities.

Location Refer to Chapter 5: Provisioning Concepts for conceptual background
information related to network elements, digital links, connections,
optical layers, subnets, virtual concatenation groups, and shared risk
groups.

The Navis ™ Optical PM - NP Provisioning Process
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3 Network Element Configuration
Tasks

Overview
....................................................................................................................................................................................................................................

Purpose After a database synchronization with the element management
system, Navis™ Optical PM - NP automatically adds all the network
elements managed by the EMS to the Navis™ Optical PM - NP
Network Map and stores them in the database. Navis™ Optical PM -
NP allows users to discover, through a database synchronization,
network elements managed by Lucent or non-Lucent EMSs.

This chapter contains tasks to add and delete controlled and
noncontrolled network elements through Navis™ Optical PM - NP.

Before you begin Before you begin using the tasks contained within this chapter,
consider the following items:

• The number of allowable network elements on the Network Map
varies with the Navis™ Optical PM - NP configuration. When the
limit is reached, an error message will appear.

• When a network element is first added to Navis™ Optical PM -
NP, its corresponding icon is always displayed as green
regardless of whether equipment or environment alarms exist.
Users should therefore perform a manual database
synchronization in order to display the network element’s true
state.

....................................................................................................................................................................................................................................
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• Users must use the correct network element identification number
format. The identification number consists of up to 20
alphanumeric characters, including the /, - and _ characters. No
leading delimiters are allowed. Navis™ Optical PM - NP does not
support the following characters: space ( ), quote (″), percent
(%), star (*), dot (.), backslash (\), and pipe (|). Only upper case
alphabetical characters are supported.

• A network element may only be deleted if it is not assigned to a
digital link or circuit/trail (pending or in-effect). If a network
element linked to another network element is deleted, the
network element is put in a “pending delete” state and not
deleted from the system database or Network Map. Users cannot
back out of the pending delete state. However, a database
synchronization with the EMS can bring the network element
back to a normal state so long as the EMS still reports that
network element is still managed by it.

• No commands, such as delete cross-connect or port
reprovisioning, will be sent to a network element once it is in a
pending delete state.

• If a network element is inadvertently deleted, perform a database
synchronization with the corresponding network element to
recover it to its original state.

• If a network element is completely deleted, a database
synchronization cannot be performed on the network element. To
recover the network element in this case, perform a network
element database synchronization on the corresponding controller
(EMS).

Contents
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Add a black box 3-13
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Section I: Controlled Network Elements

Overview
....................................................................................................................................................................................................................................

Purpose This section discusses the provisioning tasks associated with
controlled network elements.

Important Controlled network elements (network elements controlled by the
Navis™ Optical EMS) are not added to Navis™ Optical PM - NP; they
are automatically discovered.

Contents
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Controlled network element support
....................................................................................................................................................................................................................................

Definition Controlled network elements are network elements that can be
controlled by Navis™ Optical PM - NP.

Characteristics Controlled network elements have the following characteristics:

• They are usually displayed on the network maps as nodes
(physical locations) interconnected by digital links. A unique icon
represents each network element type.

• They are in constant communication with their EMS.

• They are controlled by commands sent from the EMS (the EMS
receives and processes the responses from the controlled network
element).

• They report and show alarms.

Controlled Navis™ Optical
PM - NP network elements

For a complete list of controlled network elements supported by
Navis™ Optical PM - NP, refer to Chapter 5: Provisioning Concepts.

Icons for controlled
network elements

Controlled network elements managed by Navis™ Optical PM - NP
appear as icons on the Network Map. A legend showing all the icons
and their respective models of network elements is available from the
Network Map when requested by the user. For additional information
regarding what controlled network elements map to which icon, refer
to Chapter 5: Provisioning Concepts.

Additional information For additional information about controlled network elements, refer to
Chapter 5: Provisioning Concepts of this guide.

Section I: Controlled Network Elements Network Element Configuration Tasks
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Add a controlled network element
....................................................................................................................................................................................................................................

Purpose Use this task to add a controlled network element to the Navis™

Optical PM - NP Network Map.

Important! Navis™ Optical EMS controlled network elements
are not added to Navis™ Optical PM - NP; they are automatically
discovered by Navis™ Optical PM - NP during start-up or a
database synchronization with an EMS. Examples of network
elements automatically discovered by Navis™ Optical PM - NP
include: the WaveStar BandWidth Manager and LambdaRouter.

Task Perform the following task to add a controlled network element
to the Navis™ Optical PM - NP Network Map.
............................................................................................................................................................

1 From the Network Map, select Configuration > Network Element >
Add > (Select an NE Type from the list).

Result:

The NE window appears.

............................................................................................................................................................

2 In the EMS ID field, select an EMS ID from the list.

............................................................................................................................................................

3 Click OK.

Result:

The Connection dialog box appears. If the connection occurs,
the Create MIB Image from NE window appears.

............................................................................................................................................................

4 Specify the Network Element Name, NSAP Format, Area ID
(optional), Network Element SID, and Connection Type.

............................................................................................................................................................

5 Click Apply.

Result:

The network element appears on the Network Map and a
success message appears within the window’s Message panel.

Section I: Controlled Network Elements Network Element Configuration Tasks
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Synchronize a network element
....................................................................................................................................................................................................................................

Purpose Use this task to synchronize a network element.

Synchronizing a network element is a recommended step when
performing many provisioning tasks with Navis™ Optical PM - NP
because it will automatically synchronize a network element’s alarms,
ports, switches, protection group, and cross-connects with the
database. This saves the user time because many graphical user
interface (GUI) fields, such as ones used for port selection, will
automatically present up-to-date selections for the user if the network
elements in the provisioning process are synchronized first.

Important! This procedure synchronizes a single network
element with the Navis™ Optical PM - NP database. To
synchronize all network element appearing on the Network Map,
perform a database synchronization from the EMS-level. Refer to
the Navis™ Optical PM - NP Administration Guide for details
on performing an EMS-level database synchronization for
network elements. Note that this procedure does not apply to
certain type network elements, such as black boxes.

Task Perform the following task to synchronize a network element
with the Navis™ Optical PM - NP database. This procedure
applies to both controlled and noncontrolled network elements.
............................................................................................................................................................

1 On the Network Map, select a network element.

Result:

The icon becomes highlighted.

............................................................................................................................................................

2 Right click on the icon.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Start Database Synchronization.

Result:

A window appears.

Section I: Controlled Network Elements Network Element Configuration Tasks
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............................................................................................................................................................

4 For NE ID, verify that the identification listed corresponds to the
selected network element.

............................................................................................................................................................

5 Under Type, select the item you wish to synchronize with the
database.For example, select Port to synchronize the network
element’s ports. To synchronize all attributes of the selected network
element, select All.

............................................................................................................................................................

6 Press Apply.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Press Yes.

Result:

The Database Synchronization window appears. This window
will report the progress of the database synchronization. If the
synchronization is successful, a confirmation window appears.

............................................................................................................................................................

8 Press OK.

Result:

The network element is synchronized.

Section I: Controlled Network Elements
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Update a network element location
....................................................................................................................................................................................................................................

Purpose Use the following task to update the location of a network element on
the Navis™ Optical PM - NP Network Map. This task applies to both
controlled and noncontrolled network elements that appear on the
Navis™ Optical PM - NP Network Map.

Important! Any user is able to move a network element on the
Network Map, but the network element’s location on the
Network Map can only be updated within the Navis™ Optical PM
- NP database by a user with appropriate privileges, such as a
system administrator. Refer to the Navis™ Optical PM - NP
Administration Guide for details on updating a network
element’s location in the database.

Task Perform the following task to update the location of a network
element on the Navis™ Optical PM - NP Network Map.
............................................................................................................................................................

1 On the Network Map, left-click and hold on the network element to
be moved.

Result:

The network element becomes highlighted.

............................................................................................................................................................

2 Drag the network element to the desired location on the Network
Map.

Result:

The network element is repositioned on the Network Map.

............................................................................................................................................................

3 From the Network Map, select File > Save Node and Label Map
Positions.

Result:

The network element location is updated on the Network Map.
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Delete a controlled network element
....................................................................................................................................................................................................................................

Purpose Use this task to delete a controlled network element from the Navis™

Optical PM - NP Network Map.

Important! This procedure only deletes a network element from
the Navis™ Optical PM - NP database; it leaves any
cross-connect information on the network element. If the
database has cross-connect information this procedure will fail. If
you want the cross-connect information to remain in the EMS or
network element database, you will need to disconnect the
cross-connect through a virtual disconnect in Navis™ Optical PM
- NP.

Task Perform the following task to delete a controlled network element
from the Network Map.
............................................................................................................................................................

1 On the Network Map, right-click the network element to be deleted.

Result:

The Node menu is displayed.

............................................................................................................................................................

2 Select Node Operation > Delete Node.

Result:

A confirmation dialog box is displayed.

............................................................................................................................................................

3 Click Yes.

Result:

The network element is deleted or put in a “pending delete”
state.
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Section II: Noncontrolled Network Elements

Overview
....................................................................................................................................................................................................................................

Purpose This section presents provisioning tasks for noncontrolled network
elements, such as black boxes and equipment.

Contents
Noncontrolled network element support 3-12

Add a black box 3-13

Display black box list 3-14

Search for a specific black box 3-15

Delete a black box 3-16

Add equipment 3-17

Display equipment list 3-18

Delete equipment 3-19
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Noncontrolled network element support
....................................................................................................................................................................................................................................

Definition Noncontrolled network elements are network elements that cannot be
controlled by Navis™ Optical PM - NP.

Characteristics Noncontrolled network elements:

• Support only manual provisioning

• Do not report alarms

• Are listed in the database as part of provisioning records

Noncontrolled Navis™

Optical PM - NP network
elements

For a complete list of noncontrolled network elements supported by
Navis™ Optical PM - NP, refer to Chapter 5: Provisioning Concepts.

Icons for noncontrolled
network elements

Noncontrolled network elements managed by Navis™ Optical PM -
NP appear as icons on the Network Map. A legend showing all the
icons and their respective models of network elements is available
from the Network Map when requested by the user. For additional
information regarding what noncontrolled network elements map to
which icon, refer to Chapter 5: Provisioning Concepts.

Additional information For additional information about noncontrolled network elements,
refer to Chapter 5: Provisioning Concepts of this guide.
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Add a black box
....................................................................................................................................................................................................................................

Purpose Use this task to add a black box to the Navis™ Optical PM - NP
Network Map.

Task Perform the following task to add a black box to the Network
Map.
............................................................................................................................................................

1 From the Network Map, select Configuration > Black Box > Add.

Result:

The Add Black Box form appears.

............................................................................................................................................................

2 In the BBOX field, enter a name for the black box. This name will
appear on the Network Map.

............................................................................................................................................................

3 In the Acronym field, specify an acronym.

............................................................................................................................................................

4 (Optional) In the Customer Information field, enter any relevant
information about the black box you wish other users to view.

............................................................................................................................................................

5 Click OK.

Result:

A confirmation window appears and informs you of either the
success or failure of the operation.

............................................................................................................................................................

6 Click OK.

Result:

The black box is added to the Network Map.
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Display black box list
....................................................................................................................................................................................................................................

Purpose Use this task to view all currently existing black boxes known to
Navis™ Optical PM - NP.

Task Perform the following task to display a complete listing of all
existing black boxes.
............................................................................................................................................................

1 From the Network Map, select Configuration > Black Box > Display
List.

Result:

The Black Box Display List Query window appears.

............................................................................................................................................................

2 Enter * within the Black Box ID field.

............................................................................................................................................................

3 Press OK.

Result:

All the currently existing black boxes appear within the Black
Box Display List window.
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Search for a specific black box
....................................................................................................................................................................................................................................

Purpose Use this task to search for a specific black box.

Task Perform the following task to search for a specific black box.
............................................................................................................................................................

1 From the Network Map, select Configuration > Black Box > Display
List.

Result:

The Black Box Display List Query window appears.

............................................................................................................................................................

2 Enter the black box name within the Black Box ID field. You can
search for multiple related black boxes via a wildcard (*). Simply
enter an alphanumeric string followed (or preceded) by the *
character.

............................................................................................................................................................

3 Press OK.

Result:

If you entered a valid name, the specified black box will appear
within the Black Box Display List window. If you entered a
wildcard, the specified black boxes will appear within the
window.
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Delete a black box
....................................................................................................................................................................................................................................

Purpose Use the following task to delete a black box from the Network Map.

Before you begin Before you delete a black box from the Network Map, consider the
following items:

• Similar to deleting a network element, users must delete any
digital links or circuits/trails associated with the black box prior
to deleting it.

Task Perform the following task to delete a black box from the
Network Map.
............................................................................................................................................................

1 From the Network Map, right-click on the black box you wish to
delete.

Result:

The Node menu appears.

............................................................................................................................................................

2 From the menu, select Node Operation > Delete Node.

Result:

A confirmation window appears asking you to confirm the
deletion.

............................................................................................................................................................

3 Select Yes.

Result:

A confirmation window appears.

............................................................................................................................................................

4 Press OK.

Result:

The black box is deleted from the Network Map.
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Add equipment
....................................................................................................................................................................................................................................

Purpose Use this task to add equipment to the Navis™ Optical PM - NP
Network Map.

Important! Locations created as “Equipment” do not appear as
icons on the Network Map. They are only listed in the Location
Reference Table. When used as the termination of a digital link
or connection, they appear on the Graphical Layout to clarify the
overall assignment.

Task Perform the following task to add equipment to the Network
Map.
............................................................................................................................................................

1 From the Network Map, select Configuration > Equipment > Add.

Result:

The Add equipment form is displayed. The Model field displays
EQPT.

............................................................................................................................................................

2 In the Equipment ID field, enter the network element identification.

............................................................................................................................................................

3 In the Acronym field, enter the acronym.

............................................................................................................................................................

4 In the Customer Information field, enter any information you wish
other users to view.

............................................................................................................................................................

5 Click OK.

Result:

A window informs you of the success or failure of the operation,
and the newly added equipment can be viewed on the
Equipment Display List.
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Display equipment list
....................................................................................................................................................................................................................................

Purpose Use this task to display a listing of existing equipment.

Task Perform the following task to display a listing of existing
equipment.
............................................................................................................................................................

1 From the Network Map, select Configuration > Equipment >
Display List.

Result:

The Equipment Display List Query Box form displays.

............................................................................................................................................................

2 In the Equipment ID field, enter the ID of the equipment you wish to
display (or enter * to list all existing equipment). Of course, you can
search for groupings of equipment by using a wildcard (*). Simply
enter an alphanumeric string followed (or preceded) by the *
character.

............................................................................................................................................................

3 Click OK.

Result:

The Equipment Display List appears and displays all the
equipment in the network with the specified ID.
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Delete equipment
....................................................................................................................................................................................................................................

Purpose Use this task to delete equipment from the Navis™ Optical PM - NP
Network Map.

Task Perform the following task to delete equipment from the Navis™

Optical PM - NP Network Map.
............................................................................................................................................................

1 Display the equipment list (see preceding task).

............................................................................................................................................................

2 Select an entry.

............................................................................................................................................................

3 Select Actions > Delete Node.

Result:

The equipment is deleted from the Network Map.
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4 Provisioning Tasks

Overview
....................................................................................................................................................................................................................................

Purpose This chapter presents provisioning tasks usable with Navis™ Optical
PM - NP.

Contents
Section I: Digital Links 4-4

Add a digital link between two network elements 4-5

Add a 1+1 APS protected digital link 4-8

Display protection group names associated with
digital links

4-11

Display digital link specifications 4-12

Add a regenerator to a digital link 4-13

Delete a regenerator from a digital link 4-15

Disconnect a digital link 4-17

Section II: Connections 4-19

Add a circuit between two controlled network
elements

4-21

Add a circuit between two noncontrolled network
elements

4-23

Add a circuit between a controlled network element
and a noncontrolled network element

4-25
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Display circuit list 4-27

Display circuit list by type 4-28

Copy a connection using the Clone feature 4-30

Modify circuit order transmission parameters 4-31

Disconnect a circuit 4-33

Perform a virtual disconnect 4-35

Section III: Optical Layers 4-37

Create an optical multiplex section 4-39

Create an optical link 4-41

Create an optical channel trail 4-43

Add an optical amplifier to an optical multiplex
section

4-46

Delete an optical amplifier from an optical
multiplex section

4-48

Insert an optical layer into a digital link 4-50

Create a digital link through an optical channel trail 4-52

Disconnect an optical channel trail 4-54

Disconnect an optical link 4-56

Disconnect an optical multiplex section 4-57

Section IV: Lucent Optical Network Navigation
System

4-58

Establish a connection with the ONN 4-60

Start communication with the ONN 4-62

Stop communication with the ONN 4-63

Modify Lucent ONNS session parameters 4-64

View Lucent ONNS network elements 4-66

View Lucent ONNS switch connection spans 4-67

View and modify bandwidth allocation by trail 4-69

View and modify bandwidth allocation by port 4-71

Provision an Lucent ONNS connection 4-73

Section V: Subnets 4-74

Add a BLSR (automatic) 4-76
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Add a BLSR (manual) 4-79

Add a UPSR (automatic) 4-81

Add a UPSR (manual) 4-84

Modify a ring name 4-86

Modify a ring 4-87

Delete a ring 4-88

Section VI: Virtual Concatenation Groups 4-90

Add a virtual concatenation group 4-91

Modify a virtual concatenation group 4-93

Delete a virtual concatenation group 4-94

Section VII: Shared Risk Groups 4-95

Create a shared risk group ID 4-97

Display a list of shared risk groups 4-98

Display the shared risk groups associated with a
digital link

4-99

Display the digital links associated with a shared
risk group

4-101
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Disassociate a shared risk group with a digital link 4-104
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Section I: Digital Links

Overview
....................................................................................................................................................................................................................................

Purpose This section discusses provisioning tasks associated with digital links
as they relate to Navis™ Optical PM - NP.

Definition Digital links are fiber or electrical connections between two points.
These transport facilities are assignable to high-order and low-order
circuits to carry customer services.

Digital links can be unprotected or protected. When protected by
another link, it is called automatic protection switching (APS).

Supported digital links Refer to Chapter 5: Provisioning Concepts of this guide for
descriptions of the digital links supported by Navis™ Optical PM - NP.

Before you begin Refer to the individual tasks contained within this section for
important “Before You Begin” information.

Additional information For additional information about digital links as they relate to Navis™

Optical PM - NP, refer to Chapter 5: Provisioning Concepts of this
guide.

Contents
Add a digital link between two network elements 4-5

Add a 1+1 APS protected digital link 4-8

Display protection group names associated with
digital links

4-11

Display digital link specifications 4-12

Add a regenerator to a digital link 4-13

Delete a regenerator from a digital link 4-15

Disconnect a digital link 4-17
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Add a digital link between two network elements
....................................................................................................................................................................................................................................

Purpose Use this task to add a digital link between two network elements.

Before you begin Before adding a digital link between two network elements, note the
network element capabilities with regards to the types of digital links
you can use and the protection offered. Although Navis™ Optical PM -
NP will automatically show only the digital links usable with a
particular network element pair, Chapter 5 of this guide presents the
digital link and protection support per network element so that
provisioning can be planned.

Important! For details about provisioning an E_Link and use of
Ethernet cards, refer to Section II: Digital Links of Chapter 5:
Provisioning Concepts.

Task Perform the following task to add a digital link between two
network elements on the Network Map. This task assumes that
two network elements already exist on the Network Map.
............................................................................................................................................................

1 From the Network Map, select a network element.

Result:

The selected network element is highlighted.

............................................................................................................................................................

2 Synchronize the network element’s ports. Refer to the network
element synchronization task in Chapter 3: Network Element
Configuration Tasks for details on how to perform this task.

Result:

The network element is synchronized.

............................................................................................................................................................

3 Select a second network element and repeat Step 2.

............................................................................................................................................................

4 On the Network Map, select Configuration > Digital Link > Add >
(select an applicable digital link according to the selected
network elements).
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Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

5 Under the Essentials tab, specify a circuit ID within the last field of
the CKT/Trail ID field. The previous two fields should be prepopulated
with the two previously selected network elements while the third
field specifies the selected digital rate.

............................................................................................................................................................

6 Press the A port button. The A Location field should have been
prepopulated with one of the selected network elements.

Result:

The Port Selection window appears.

............................................................................................................................................................

7 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

8 Repeat Steps 6 and 7 to add the Z port (of course, exchange any
instances of A port with Z port). Note that you have to select a port
that is different than the port selected in Step 7.

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

9 Verify that Order Action is set to Add.

............................................................................................................................................................

10 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

11 Note the information pertaining to the newly created digital link and
press OK.

Section I: Digital Links
Add a digital link between two network
elements
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Result:

A confirmation window appears.

............................................................................................................................................................

12 Confirm all confirmation windows that appear.

Result:

The new digital link, linking the specified network elements,
appears on the Network Map.

Section I: Digital Links
Add a digital link between two network
elements
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Add a 1+1 APS protected digital link
....................................................................................................................................................................................................................................

Purpose Use this task to provision a 1+1 APS protected digital link.

Task Perform the following task to provision a 1+1 APS protected
digital link. This task assumes that two network elements already
exist on the Network Map.
............................................................................................................................................................

1 From the Network Map, select a network element. Be sure to select a
network element type that supports 1+1 protection. Refer to Chapter
5: Provisioning Concepts for a list of network elements that support
1+1 protection.

Result:

The selected network element is highlighted.

............................................................................................................................................................

2 Synchronize the network element’s ports. Refer to the network
element synchronization task in Chapter 3: Network Element
Configuration Tasks for details on how to perform this task.

Result:

The network element is synchronized.

............................................................................................................................................................

3 Select a second network element and repeat Step 2.

............................................................................................................................................................

4 On the Network Map, select Configuration > Digital Link > Add >
(select an applicable digital link according to the selected
network elements).

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

5 Under the Essentials tab, specify a circuit ID within the last field of
the CKT/Trail ID field. The previous two fields should be prepopulated
with the two previously selected network elements while the third
field presents the selected digital rate.

Section I: Digital Links Provisioning Tasks
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............................................................................................................................................................

6 For Service Path, press the A port button. The A Location field
should have been prepopulated with one of the selected network
elements.

Result:

The Port Selection window appears.

............................................................................................................................................................

7 Select a port and press OK.

Result:

The selected port appears in the field as the A Port.

............................................................................................................................................................

8 Repeat Steps 6 and 7 to add the Z port (of course, exchange any
instances of A port with Z port). Note that you have to select a port
that is different than the port selected in Step 7.

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

9 For APS Protected?, select 1+1 Protected.

Result:

The interface alters to display a new panel (Protection Path)
and field (APS Type).

............................................................................................................................................................

10 For Protection Path, press the A Protect Port button.

Result:

The Port Selection window appears.

............................................................................................................................................................

11 Select a port for the protection path and press OK.

Result:

The selected port appears in the field as the A Protect Port.

............................................................................................................................................................

12 Repeat Steps 10 and 11 to add the Z Protect Port (of course,
exchange any instances of A Protect Port with Z Protect Port).

Section I: Digital Links
Add a 1+1 APS protected digital link
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Result:

The selected port appears as the Z Protect Port.

............................................................................................................................................................

13 For APS Type, select either UNI (unidirectional) or BI (bidirectional).

............................................................................................................................................................

14 Verify that Order Action is set to Add.

............................................................................................................................................................

15 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

16 Note the information pertaining to the newly created digital link and
press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

17 Confirm all confirmation windows that appear.

Result:

The new 1+1 digital link, linking the specified network
elements, appears on the Network Map.

Section I: Digital Links
Add a 1+1 APS protected digital link
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Display protection group names associated with digital links
....................................................................................................................................................................................................................................

Purpose Use this task to display a list of protection group names associated
with the APS digital links existing on the Network Map.

In addition to the procedure described below, APS group names are
also displayed in the Graphical Layout, Modify Parameters, and Order
Parameters forms. This procedure allows you to view a complete
listing of protection group names.

Task Perform the following task to display a list of protection group
names associated APS digital links.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection >
Display > MS Protection Group Names.

Result:

The Protection Group Names list is displayed.

Section I: Digital Links Provisioning Tasks
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Display digital link specifications
....................................................................................................................................................................................................................................

Purpose Use this task to display the specifications and graphical layout of an
existing digital link.

Task Perform the following task to display the specifications and
graphical layout of an existing digital link.
............................................................................................................................................................

1 From the Network Map, select a digital link.

Result:

The digital link becomes highlighted.

............................................................................................................................................................

2 Right click on the digital link.

Result:

The Link menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the digital link you wish to
view the specifications for.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears. This form presents the
graphical layout and specifications associated with the digital
link.

Section I: Digital Links Provisioning Tasks
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Add a regenerator to a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to add a regenerator to a digital link.

Task Perform the following task to add a regenerator to a digital link.
This task assumes that a digital link has already been provisioned
and appears on the Network Map.
............................................................................................................................................................

1 From the Network Map, select a digital link.

Result:

The digital link becomes highlighted.

............................................................................................................................................................

2 Right click on the digital link.

Result:

The Link menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the digital link you wish to
add the regenerator to.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Regenerators/Optical Amplifiers.
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Result:

The Regenerator Selection form appears.

............................................................................................................................................................

7 Select a regenerator from the Non-Members sub-window.

Result:

The Add and Remove buttons become enabled.

............................................................................................................................................................

8 Press Add.

Result:

The regenerator is moved to the Service window.

............................................................................................................................................................

9 Specify the regenerator’s left/right ports and service protection.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Press OK.

Result:

A regenerator is added to the digital link.

Section I: Digital Links
Add a regenerator to a digital link
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Delete a regenerator from a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to delete a regenerator from a digital link.

Task Perform the following task to delete a regenerator from a digital
link. This task assumes that a digital link has already been
provisioned and appears on the Network Map.
............................................................................................................................................................

1 From the Network Map, select a digital link.

Result:

The digital link becomes highlighted.

............................................................................................................................................................

2 Right click on the digital link.

Result:

The Link menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the digital link you wish to
delete the regenerator from.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Regenerators/Optical Amplifiers.
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Result:

The Regenerator Selection form appears.

............................................................................................................................................................

7 Select a regenerator from the Service window.

Result:

The Add and Remove buttons become enabled.

............................................................................................................................................................

8 Press Remove.

Result:

The regenerator is moved to the Non-Members window.

............................................................................................................................................................

9 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

10 Press OK.

Result:

The regenerator is deleted from the digital link.

Section I: Digital Links
Delete a regenerator from a digital link
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Disconnect a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to disconnect a digital link.

Important! Deletion of a digital link is only permitted if there
are no in-effect, pending circuits or paths riding on it.

Before you begin Before disconnecting a digital link, note the following:

• Users are not required to stop already running performance
monitoring data collection prior to disconnecting the digital link.

Task Perform the following task to disconnect a digital link.
............................................................................................................................................................

1 From the Network Map, select a digital link.

............................................................................................................................................................

2 From the Network Map, select Configuration > Digital Link >
Disconnect.

Result:

The Ckt/Trail Query Box is displayed.

............................................................................................................................................................

3 In the Order Number field, specify the order number of the digital
link to be disconnected.

............................................................................................................................................................

4 Click OK.

Result:

A confirmation window appears.

............................................................................................................................................................

5 Click Yes.

Result:

An action window appears.

............................................................................................................................................................

6 Click OK.
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Result:

Navis™ Optical PM - NP disconnects the digital link if all
validations are successful. The digital link, linking the specified
network elements, disappears from the Network Map.

Section I: Digital Links
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Section II: Connections

Overview
....................................................................................................................................................................................................................................

Purpose This section discusses the provisioning tasks associated with
connections.

Definition A circuit is a concatenation of link connections and sub-network
connections to provide an end-to-end service to a customer. A circuit
is identified by a rate at which the service is provided. The “rate” of a
circuit is defined by ITU and ANSI standards for SONET and
Asynchronous circuit. An SONET trail is provisioned over SONET
link connections and over SONET cross-connects in Navis™ Optical
PM - NP managed network elements.

Supported connections Refer to Chapter 5: Provisioning Concepts of this guide for
descriptions of the connection types supported by Navis™ Optical PM
- NP.

Before you begin Refer to the individual tasks contained within this section for
important “Before You Begin” information.

Additional information For additional information about connections as they relate to Navis™

Optical PM - NP, refer to Chapter 5: Provisioning Concepts of this
guide.

Contents
Add a circuit between two controlled network
elements

4-21

Add a circuit between two noncontrolled network
elements

4-23

Add a circuit between a controlled network element
and a noncontrolled network element

4-25

Display circuit list 4-27

Display circuit list by type 4-28

Copy a connection using the Clone feature 4-30

Modify circuit order transmission parameters 4-31
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Disconnect a circuit 4-33

Perform a virtual disconnect 4-35
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Add a circuit between two controlled network elements
....................................................................................................................................................................................................................................

Purpose Use this task to add a circuit between two controlled network
elements.

Before you begin Before you add a circuit between two controlled network elements,
note the following items:

• A digital link must exist between the network elements before
attempting to provision a circuit between the two.

Task Perform the following task to add a circuit between two
controlled network elements.
............................................................................................................................................................

1 On the Network Map, select two network element icons that already
have a digital link joining them.

Result:

The icons become highlighted.

............................................................................................................................................................

2 Synchronize the network elements’ ports and cross-connects. Refer to
the network element synchronization task in Chapter 3: Network
Element Configuration Tasks for details on how to perform this task.

Result:

The network elements are synchronized.

............................................................................................................................................................

3 On the Network Map, select Configuration > Connection > Add >
(select an applicable circuit rate according to the selected
network elements).

Result:

The Provision Profile form is displayed.

............................................................................................................................................................

4 Under the Essentials tab, specify a circuit ID next to where the
connection type is listed.

............................................................................................................................................................

5 Press the A port button.
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Result:

A window appears.

............................................................................................................................................................

6 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

7 Repeat steps 5 and 6 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

8 Verify that Order Action is set at Add.

............................................................................................................................................................

9 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Press OK.

Result:

The circuit is created.
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Add a circuit between two noncontrolled network elements
....................................................................................................................................................................................................................................

Purpose Use this task to add a circuit between two noncontrolled network
elements.

Before you begin Before you add a circuit between two noncontrolled network
elements, note the following items:

• A circuit cannot be created directly between two noncontrolled
network elements without at least one intermediate controlled
network element.

• Digital links must already be provisioned from the network
element to each of the two equipment.

Task Perform the following task to add a circuit between two
noncontrolled network elements.
............................................................................................................................................................

1 On the Network Map, select two noncontrolled network elements that
already have a digital link joining them and have at least one
intermediate controlled network element.

Result:

The selections become highlighted.

............................................................................................................................................................

2 Synchronize the network elements’ ports and cross-connects. Refer to
the network element synchronization task in Chapter 3: Network
Element Configuration Tasks for details on how to perform this task.

Result:

The network elements are synchronized.

............................................................................................................................................................

3 On the Network Map, select Configuration > Connection > Add >
(select an applicable circuit rate according to the selected
network elements).

Result:

The Provision Profile form is displayed.
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............................................................................................................................................................

4 Under the Essentials tab, specify a circuit ID next to where the
connection type is listed.

............................................................................................................................................................

5 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

6 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

7 Repeat steps 5 and 6 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

8 Under the Parameters tab, verify that Order Action is set at Add.

............................................................................................................................................................

9 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Press OK.

Result:

The circuit is created.
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Add a circuit between a controlled network element and a
noncontrolled network element
....................................................................................................................................................................................................................................

Purpose Use this task to add a circuit between a controlled network element
and a noncontrolled network element.

Before you begin Before you add a circuit between a controlled network element and a
noncontrolled network element, note the following items:

• A digital link must exist between the controlled and
noncontrolled network elements before attempting to provision a
circuit between the two.

• The equipment list menu item is only highlighted on the node
menu for those network elements connected to originating or
terminating equipment.

Task Perform the following task to add a circuit between a controlled
network element and a noncontrolled network element.
............................................................................................................................................................

1 On the Network Map, select one noncontrolled network element icon
and one controlled network element icon that already have a digital
link joining them.

Result:

The icons become highlighted.

............................................................................................................................................................

2 Synchronize the network elements’ ports and cross-connects. Refer to
the network element synchronization task in Chapter 3 for details on
how to perform this task.

Result:

The network elements are synchronized.

............................................................................................................................................................

3 On the Network Map, select Configuration > Connection > Add >
(select an applicable circuit rate according to the selected
network elements).

Result:

The Provision Profile form is displayed.

Section II: Connections Provisioning Tasks

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 4 - 2 5



............................................................................................................................................................

4 Under the Essentials tab, specify a circuit ID next to where the
connection type is listed.

............................................................................................................................................................

5 Press the A port button.

Result:

A window appears.

............................................................................................................................................................

6 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

7 Repeat steps 5 and 6 to add the Z port (of course, exchange any
instances of A port with Z port).

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

8 Under the Parameters tab, verify that Order Action is set at Add.

............................................................................................................................................................

9 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Press OK.

Result:

The circuit is created.
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Display circuit list
....................................................................................................................................................................................................................................

Purpose Use this task to display a list of existing circuits.

Task Perform the following task to display a complete listing of
existing circuits.
............................................................................................................................................................

1 From the Network Map, select Configuration > Display >
Circuit/Trail List.

Result:

The Circuit/Trail List Query Box form appears.

............................................................................................................................................................

2 Place a check in the Free Form box.

Result:

The Free Form field alters.

............................................................................................................................................................

3 Within the Free Form field, enter *.

............................................................................................................................................................

4 From the field’s pull-down menu, select All.

Result:

The OK button will become active.

............................................................................................................................................................

5 Click OK.

Result:

The Circuit/Trail List form appears listing all existing circuits.
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Display circuit list by type
....................................................................................................................................................................................................................................

Purpose Use this task to display a list of particular circuit types.

Task Perform the following task to display a list of particular circuit
types.
............................................................................................................................................................

1 From the Network Map, select Configuration > Display >
Circuit/Trail List.

Result:

The Circuit/Trail List Query Box form appears.

............................................................................................................................................................

2 Place a check in the Free Form box.

Result:

The Free Form field alters.

............................................................................................................................................................

3 Within the Free Form field, enter *.

............................................................................................................................................................

4 From the field’s drop-down menu, specify a transmission rate.

Result:

The OK button becomes active.

............................................................................................................................................................

5 For Status, specify an order status. Your query will show all the
circuits that abide by this criteria. For example, if you select Pending,
only pending circuits will be polled for.

............................................................................................................................................................

6 For Order Action, select an order action if desired to narrow the
display criteria.

............................................................................................................................................................

7 Press the More button if you wish to apply additional search criteria.

Result:

If pressed, the form lengthens to provide additional selections.
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............................................................................................................................................................

8 Click OK.

Result:

The Circuit/Trail List form appears and lists all existing circuits
that fit the search criteria.
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Copy a connection using the Clone feature
....................................................................................................................................................................................................................................

Purpose Use this task to use the Clone feature to copy an existing circuit.

Task Perform the following task to copy a circuit using the Clone
feature.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection > Clone.

Result:

A query box form appears.

............................................................................................................................................................

2 Specify a circuit identification so as to filter through all the currently
existing circuits.

............................................................................................................................................................

3 Press OK.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select a circuit to clone.

Result:

A provisioning screen appears pre-populated.

............................................................................................................................................................

5 From the Essentials tab, change the ID field to name the clone of the
circuit.

............................................................................................................................................................

6 Change the port addresses for the circuit clone.

............................................................................................................................................................

7 Click OK.

Result:

The circuit is cloned.
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Modify circuit order transmission parameters
....................................................................................................................................................................................................................................

Purpose Use this task to modify a circuit’s order transmission parameters.

Important! Modifying transmissions can only be done for
in-effect circuits.

Task Complete the following task to modify a circuit’s order
transmission parameters.
............................................................................................................................................................

1 From the Network Map, select a circuit.

............................................................................................................................................................

2 Right click on the circuit.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the circuit you wish to
disconnect.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Transmission Parameters.

Result:

The Transmission Parameters form appears.
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............................................................................................................................................................

7 Make the modifications to the circuit’s order parameters.

............................................................................................................................................................

8 Select OK.

Result:

The circuit’s new transmission parameters are saved.
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Disconnect a circuit
....................................................................................................................................................................................................................................

Purpose Use this task to disconnect a circuit.

Before you begin When attempting to disconnect a circuit, note the following items:

• A backbone circuit cannot be disconnected unless all its
tributaries, or other backbones it is feeding, are disconnected
first. Users may disconnect backbones and tributaries in the same
manner as with any other circuit except for the first circuit that
terminates at a customers location containing the backbone.

• You may not disconnect the first circuit in Navis™ Optical PM -
NP.

• You must disconnect the circuit that contains the backbone and
add a new circuit. This circuit will contain the new backbone.

• You may then add remaining circuits you wish to maintain.

• You are not required to stop data collection prior to disconnecting
a circuit.

• If the circuit to be deleted is part of a broadcast circuit, the
circuit that was added last must be disconnected first.

Task Perform the following task to disconnect a circuit.
............................................................................................................................................................

1 From the Network Map, select a circuit.

............................................................................................................................................................

2 Right click on the circuit.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the circuit you wish to
disconnect.

Section II: Connections Provisioning Tasks

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 4 - 3 3



Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Actual.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Select Yes.

Result:

The circuit is disconnected.
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Perform a virtual disconnect
....................................................................................................................................................................................................................................

Purpose Use this task to perform a virtual disconnect on a circuit.

Task Perform the following task to perform a virtual disconnect on a
circuit.
............................................................................................................................................................

1 From the Network Map, select a circuit.

............................................................................................................................................................

2 Right click on the circuit.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the circuit you wish to
disconnect.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Virtual (DB only).

Result:

A confirmation window appears.

............................................................................................................................................................

7 Select Yes.
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Result:

A virtual disconnect is performed on the circuit.
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Section III: Optical Layers

Overview
....................................................................................................................................................................................................................................

Purpose This section contains tasks associated with optical layers as they relate
to Navis™ Optical PM - NP.

Definition An optical layer refers to an existing optical multiplex section, optical
link or optical channel trail that connects particular types of network
elements on the Navis™ Optical PM - NP Network Map. An optical
link can connect a network element with a DWDM network element,
a DWDM network element with a LambdaRouter, two
LambdaRouters together, or a LambdaRouter with a network element.
Unlike an optical multiplex section, however, an optical link can not
join two DWDM network elements.

Supported optical layers Refer to Chapter 5: Provisioning Concepts of this guide for
descriptions of the optical layers supported by Navis™ Optical PM -
NP.

Before you begin Refer to the individual tasks contained within this section for
important ’Before You Begin’ information. Note that this tasks
themselves are presented in the order in which they should occur.
Failure to follow the order presented here could result in system
errors.

Additional information For additional information about optical layers as they relate to
Navis™ Optical PM - NP, refer to Chapter 5: Provisioning Concepts of
this guide.

Contents
Create an optical multiplex section 4-39

Create an optical link 4-41

Create an optical channel trail 4-43

Add an optical amplifier to an optical multiplex
section

4-46
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Delete an optical amplifier from an optical
multiplex section

4-48

Insert an optical layer into a digital link 4-50

Create a digital link through an optical channel trail 4-52

Disconnect an optical channel trail 4-54

Disconnect an optical link 4-56

Disconnect an optical multiplex section 4-57
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Create an optical multiplex section
....................................................................................................................................................................................................................................

Purpose Use this procedure to create an optical multiplex section (OMS). An
OMS is used to connect two DWDM network elements.

Before you begin Before you create an OMS, note the following:

• The optical amplifier list contains only the amplifiers that support
the OMS section with the appropriate number of channels (16 or
40/80). It is assumed that the optical amplifiers are all
bi-directional.

Task Perform the following task to create an OMS. This procedure
assumes that the appropriate network elements already exist.
............................................................................................................................................................

1 From the Network Map, select two DWDM network element icons.

Result:

The two selected network elements become highlighted.

............................................................................................................................................................

2 Synchronize the network elements’ ports and cross-connects. Refer to
the network element synchronization task in Chapter 3: Network
Element Configuration Tasks for details on how to perform this task.

Result:

The network elements are synchronized.

............................................................................................................................................................

3 From the Network Map, select Configuration > Optical Layer > Add
> OMS.

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

4 Under the Essentials tab, specify an ID within the last field of the
CKT/Trail ID field. The previous two fields should be prepopulated
with the two previously selected network elements while the third
field specifies the OMS name.
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............................................................................................................................................................

5 Press the A port button. The A Location field should have been
prepopulated with one of the selected network elements.

Result:

The Port Selection window appears.

............................................................................................................................................................

6 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

7 Repeat Steps 5 and 6 to add the Z port (of course, exchange any
instances of A port with Z port). Note that you have to select a port
that is different than the port selected in Step 6.

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

8 Verify that Order Action is set to Add.

............................................................................................................................................................

9 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Confirm all confirmation windows that appear.

Result:

The newly created OMS appears on the Network Map.
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Create an optical link
....................................................................................................................................................................................................................................

Purpose Use this task to create an optical link. An optical link can connect a
network element with a DWDM network element, a DWDM network
element with a LambdaRouter, two LambdaRouters together, or a
LambdaRouter with a network element. Unlike an OMS, an optical
link can not join two DWDM network elements.

Task Perform the following task to create an optical link. This
procedure assumes that the appropriate network elements already
exist.
............................................................................................................................................................

1 From the Network Map, select two network element icons. As stated
previously, the network elements can be DWDM or a LambdaRouter.
However, only one network element you select can be a DWDM.

Result:

The two selected network elements become highlighted.

............................................................................................................................................................

2 Synchronize each network element’s ports and cross-connects. Refer
to the network element synchronization task in Chapter 3: Network
Element Configuration Tasks for details on how to perform this task.

Result:

The network elements are synchronized.

............................................................................................................................................................

3 From the Network Map, select Configuration > Optical Layer > Add
> OL.

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

4 Under the Essentials tab, specify an ID within the last field of the
CKT/Trail ID field. The previous two fields should be prepopulated
with the two previously selected network elements while the third
field specifies the OL name.
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............................................................................................................................................................

5 Press the A port button. The A Location field should have been
prepopulated with one of the selected network elements.

Result:

The Port Selection window appears.

............................................................................................................................................................

6 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

7 Repeat Steps 5 and 6 to add the Z port (of course, exchange any
instances of A port with Z port). Note that you have to select a port
that is different than the port selected in Step 6.

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

8 Verify that Order Action is set to Add.

............................................................................................................................................................

9 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Confirm all confirmation windows that appear.

Result:

The newly created optical link appears on the Network Map.
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Create an optical channel trail
....................................................................................................................................................................................................................................

Purpose Use this task to create an optical channel trail. An optical channel trail
transverses the connections established by either an OMS or an OMS
and optical link combination. As such, an optical channel trail can
span such combinations as two DWDMs (in the case of a single
OMS)/network element (optical link)/DWDM (OMS)/DWDM (optical
link)/network element scheme.

Before you begin Before you create an optical channel trail, note the following:

• There must be at least one OMS provisioned. There also must be
the desired number of optical links provisioned prior to creating
an optical channel trail.

• There must be the desired number of optical links provisioned
prior to creating an optical channel trail.

• Optical channel SNCP is supported for LambdaRouter 256/128.

• Cascaded SNCPs are not supported.

Task Perform the following task to create an optical channel trail. This
procedure assumes that the appropriate network elements already
exist. For sake of clarity, this procedure will discuss the
provisioning of an optical channel trail for a single OMS. Note
that an optical channel trail can be provisioned so as to include
several optical links and OMSs.
............................................................................................................................................................

1 From the Network Map, select an existing OMS.

Result:

The selected OMS becomes highlighted.

............................................................................................................................................................

2 From the Network Map, select Configuration > Optical Layer > Add
> OChTrail.

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

3 Under the Essentials tab, specify an ID within the last field of the
CKT/Trail ID field. The previous two fields should be prepopulated
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with the two previously selected network elements while the third
field specifies the OCh trail name.

............................................................................................................................................................

4 Press the A port button. The A Location field should have been
prepopulated with one of the selected network elements.

Result:

The Port Selection window appears.

............................................................................................................................................................

5 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.

............................................................................................................................................................

6 Repeat Steps 4 and 5 to add the Z port (of course, exchange any
instances of A port with Z port). Note that you have to select a port
that is different than the port selected in Step 5.

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

7 Verify that Order Action is set to Add.

............................................................................................................................................................

8 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

9 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

10 Confirm all confirmation windows that appear.
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Result:

The newly created optical channel trail appears on the Network
Map.

Important Note for WaveStar OLS 1.6T

When provisioning an optical channel with a fixed connection span on
WaveStar OLS 1.6T, the sequence of provisioning matters. In short, a
cross-connect database synchronization must be performed before an
optical link or optical multiplex section is provisioned. To successfully
provision an optical channel with WaveStar OLS 1.6T, you must do
the following:

1. Synchronize the ports of the WaveStar OLS 1.6T (database
synchronization). Refer to Chapter 3 of this guide for information
on how to perform a database synchronization.

2. Synchronize the cross-connects of the WaveStar OLS 1.6T
(database synchronization). Refer to Chapter 3 of this guide for
information on how to perform a database synchronization.

3. Provision the optical links between the network elements and
WaveStar OLS 1.6T. Refer to the task within this section for
details.

4. Provision the optical multiplex section between the two WaveStar
OLS 1.6Ts. Refer to the task within this section for details.

5. Provision the optical channel. Refer to the task within this
section for details.
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Add an optical amplifier to an optical multiplex section
....................................................................................................................................................................................................................................

Purpose Use this task to add an optical amplifier to an OMS.

Task Perform the following task to add an optical amplifier to an
OMS.
............................................................................................................................................................

1 From the Network Map, select an OMS.

............................................................................................................................................................

2 Right click on the OMS.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the OMS you wish to add
the optical amplifier to.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Regenerators/Optical Amplifiers.

Result:

The Optical Amplifier Selection form appears.

............................................................................................................................................................

7 Select an optical amplifier from the Non-Members sub-window.
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Result:

The Add and Remove buttons become enabled.

............................................................................................................................................................

8 Press Add.

Result:

The optical amplifier is moved to the Service window.

............................................................................................................................................................

9 Specify the optical amplifier’s left/right ports and the service
protection.

............................................................................................................................................................

10 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

11 Press OK.

............................................................................................................................................................

12 From the Network Map, select File > Query Again.

Result:

An optical amplifier is added to the OMS.
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Delete an optical amplifier from an optical multiplex section
....................................................................................................................................................................................................................................

Purpose Use this task to delete an optical amplifier from an OMS.

Task Perform the following task to delete an optical amplifier from an
OMS.
............................................................................................................................................................

1 From the Network Map, select an OMS.

............................................................................................................................................................

2 Right click on the OMS.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Circuit/Trail List.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

4 Select the CKT/Trail ID corresponding to the OMS you wish to add
the optical amplifier to.

Result:

The selection becomes highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Modify > Regenerators/Optical Amplifiers.

Result:

The Optical Amplifier Selection form appears.

............................................................................................................................................................

7 Select an optical amplifier from the Service window.
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Result:

The Add and Remove buttons become enabled.

............................................................................................................................................................

8 Press Remove.

Result:

The amplifier is moved to the Non-Members window.

............................................................................................................................................................

9 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

10 Press OK.

............................................................................................................................................................

11 From the Network Map, select File > Query Again.

Result:

The optical amplifier is deleted from the OMS.
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Insert an optical layer into a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to insert an optical layer into an existing digital link. An
optical layer, in this case, refers to an existing OMS, optical link or
optical channel trail.

Before you begin Before attempting to insert an optical layer into a digital link, consider
the following items:

• In the case of an APS-protected digital link, it is not necessary to
have an optical layer both in the service link and protection link.
One of the links does not have to go through the optical layer.

Task Perform the following steps to insert an optical layer into a
digital link. This task assumes that all necessary optical layer
components are provisioned in Navis™ Optical PM - NP before
attempting to insert the optical layer.
............................................................................................................................................................

1 From the Network Map, right click on a terminating network element
icon of a digital link.

Result:

The Node menu appears.

............................................................................................................................................................

2 Select Assigned Ports List.

Result:

The Assigned Ports List window appears.

............................................................................................................................................................

3 From the list, select a digital link.

Result:

The digital link becomes highlighted.

............................................................................................................................................................

4 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.
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............................................................................................................................................................

5 Select Actions > Insert Optical Layer.

Result:

A confirmation window appears.

............................................................................................................................................................

6 Press Yes.

Result:

The optical layer is inserted into the digital link.
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Create a digital link through an optical channel trail
....................................................................................................................................................................................................................................

Purpose Use this task to create a digital link through an optical channel trail.

Task Perform the following task to create a digital link through an
optical channel trail. This task assumes that all necessary optical
layer components are provisioned in Navis™ Optical PM - NP
before attempting to create the digital link.
............................................................................................................................................................

1 From the Network Map, select the terminating network element icons
of an optical trail.

............................................................................................................................................................

2 From the Network Map, select Configurations > Digital Link > Add
> (select an applicable rate according to the selected network
elements).

Result:

The Network Map becomes the Provisioning Profile form.

............................................................................................................................................................

3 Under the Essentials tab, specify an ID within the last field of the
CKT/Trail ID field. The previous two fields should be prepopulated
with the two previously selected network elements while the third
field specifies the OCh trail name.

............................................................................................................................................................

4 Press the A port button. The A Location field should have been
prepopulated with one of the selected network elements.

Result:

The Port Selection window appears.

............................................................................................................................................................

5 Select a port and press OK.

Result:

The selected port appears within the Essentials tab as the A
port.
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............................................................................................................................................................

6 Repeat Steps 4 and 5 to add the Z port (of course, exchange any
instances of A port with Z port). Note that you have to select a port
that is different than the port selected in Step 5.

Result:

The selected port appears within the Essentials tab as the Z port.

............................................................................................................................................................

7 Verify that Order Action is set to Add.

............................................................................................................................................................

8 Press OK.

Result:

The graphical layout form appears.

............................................................................................................................................................

9 Press OK.

Result:

A confirmation window appears.

............................................................................................................................................................

10 Confirm all confirmation windows that appear.

Result:

The newly created digital link follows the optical channel trail.
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Disconnect an optical channel trail
....................................................................................................................................................................................................................................

Purpose Use the following task to disconnect an optical channel trail.

Task Perform the following task to disconnect an optical channel trail.
............................................................................................................................................................

1 From the Network Map, select an optical channel trail (by selecting
one of its end points).

............................................................................................................................................................

2 Right click on the end point (a network element icon).

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Assigned Ports List.

Result:

The Assigned Ports List window appears.

............................................................................................................................................................

4 From the listing, select an optical channel trail. Make sure it is
In-Effect (IE).

Result:

The selection becomes highlighted.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Actual.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Press OK.
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Result:

The optical channel trail is disconnected.
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Disconnect an optical link
....................................................................................................................................................................................................................................

Purpose Use the following task to disconnect an optical link.

Task Perform the following task to disconnect an optical link.
............................................................................................................................................................

1 From the Network Map, select an optical link (by selecting one of its
end points).

............................................................................................................................................................

2 Right click on the end point (a network element icon).

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Assigned Ports List.

Result:

The Assigned Ports List window appears.

............................................................................................................................................................

4 From the listing, select the optical link. Make sure it is In-Effect (IE).

Result:

The selection becomes highlighted.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Actual.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Press OK.

Result:

The optical link is disconnected.
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Disconnect an optical multiplex section
....................................................................................................................................................................................................................................

Purpose Use the following task to disconnect an OMS.

Task Perform the following task to disconnect an OMS.
............................................................................................................................................................

1 From the Network Map, select an OMS (by selecting one of its end
points).

............................................................................................................................................................

2 Right click on the end point (a network element icon).

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Assigned Ports List.

Result:

The Assigned Ports List window appears.

............................................................................................................................................................

4 From the listing, select the OMS. Make sure it is In-Effect (IE).

Result:

The selection becomes highlighted.

............................................................................................................................................................

5 Select Actions > Graphical Layout.

Result:

The Graphical Layout form appears.

............................................................................................................................................................

6 Select Actions > Disconnect > Actual.

Result:

A confirmation window appears.

............................................................................................................................................................

7 Press OK.

Result:

The OMS is disconnected.
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Section IV: Lucent Optical Network Navigation System

Overview
....................................................................................................................................................................................................................................

Purpose This section discusses the provisioning tasks associated with the
Lucent Optical Network Navigation System (ONN) Release 1.0.

Note: The Lucent ONNS is a limited-availability feature of Navis™

Optical PM - NP.

Definition The Lucent ONNS is the software and hardware present in the
LambdaRouter network element which performs management
functions, such as configuration management and fault management,
on optical connections across a network of LambdaRouters.

The Lucent ONNS system consists of a number of Lucent ONNS
modules, each on a different LambdaRouter.

Icons for ONN Navis™ Optical PM - NP uses a unique icon to identify that a
LambdaRouter has been associated to a signalling element. For
additional information regarding what icons map to the ONN, refer to
Chapter 5: Provisioning Concepts located within this guide.

Before you begin Refer to the individual tasks contained within this section for
important “Before You Begin” information. Review the Lucent ONNS
section of Chapter 5: Provisioning Concepts for details about Lucent
ONNS provisioning features.

Note: the Lucent ONNS Domain will always be prepopulated (and
uneditable) as there is only one Lucent ONNS domain currently
supported.

Important! When a LambdaRouter associated with Lucent
ONNS is deleted from Navis™ Optical PM - NP, the system will
also delete all associations and data shared between Navis™

Optical PM - NP and the Lucent ONNS associated with the
LambdaRouter.

Additional information For additional information about the ONN, refer to Chapter 5:
Provisioning Concepts of this guide.
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Establish a connection with the ONN
....................................................................................................................................................................................................................................

Purpose Use this task to establish a connection between Navis™ Optical PM -
NP and the ONN.

Before you begin Before you perform this task, refer to the Lucent ONNS section of
Chapter 5: Provisioning Concepts for important details regarding the
features discussed in this task.

Task Perform the following task to establish a connection between
Navis™ Optical PM - NP and the ONN.
............................................................................................................................................................

1 On the Network Map, select Configuration > Lucent ONNS >
Session Parameters > Add.

Result:

The Add Lucent ONNS Session Parameters form appears.

............................................................................................................................................................

2 In the NE ID field, press the Location button.

Result:

The Selection box appears.

............................................................................................................................................................

3 In the Location field, select a network element that is not yet
associated with ONN.

Result:

The network element is highlighted.

............................................................................................................................................................

4 Press OK.

Result:

The selected network element populates that NE ID field.

............................................................................................................................................................

5 In the Signalling ID field, enter the IP address Navis™ Optical PM -
NP can use for Lucent ONNS connection requests.
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............................................................................................................................................................

6 In the Lucent ONNS Session Parameters field, enter a valid login
(an alpha-numeric string up to eight characters) at the Login prompt.

............................................................................................................................................................

7 Enter a valid password (an alphanumeric string up to eight characters)
at the Password prompt.

............................................................................................................................................................

8 In the IP Address field, enter the IP address Navis™ Optical PM - NP
can use to communicate with the ONN.

............................................................................................................................................................

9 Press OK.

Result:

A connection between Navis™ Optical PM - NP and the Lucent
ONNS is established.
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Start communication with the ONN
....................................................................................................................................................................................................................................

Purpose Use this task to start communication with the ONN.

Before you begin Before you perform this task, refer to the Lucent ONNS section of
Chapter 5: Provisioning Concepts for important details regarding the
features discussed in this task.

Task Perform the following task to start communication with the ONN.
............................................................................................................................................................

1 From the Network Map, select a LambdaRouter network element icon
associated with the Lucent ONNS but not in communication with the
ONN.

Result:

The selected network element becomes highlighted.

............................................................................................................................................................

2 Right-click the network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Manage Lucent ONNS > Start Lucent ONNS
Communications.

Result:

Communication is started, and the icon will specify the session
status (UP).
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Stop communication with the ONN
....................................................................................................................................................................................................................................

Purpose Use this task to stop communication with the ONN.

Before you begin Before you perform this task, refer to the Lucent ONNS section of
Chapter 5: Provisioning Concepts for important details regarding the
features discussed in this task.

Task Perform the following task to stop communication with the ONN.
............................................................................................................................................................

1 From the Network Map, select a LambdaRouter network element icon
that is in communication with the ONN.

Result:

The selected network element becomes highlighted.

............................................................................................................................................................

2 Right-click the network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Manage Lucent ONNS > Stop Lucent ONNS
Communications.

Result:

Communication is stopped, and the icon will specify the session
status (DOWN).
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Modify Lucent ONNS session parameters
....................................................................................................................................................................................................................................

Purpose Use this task to modify the Lucent ONNS session parameters of a
network element that is DOWN so as to re-establish communication
with the Lucent ONNS using the new Lucent ONNS session
parameters.

Important! After performing this task, Navis™ Optical PM - NP
will not start communication with the ONN. The user must start
communication using the “Start Communication” option from the
node menu. Navis™ Optical PM - NP will then use the newly
specified session parameters (changed through this task) and
establish communication between the Lucent ONNS and Navis™

Optical PM - NP.

Before you begin Before you perform this task, refer to the Lucent ONNS section of
Chapter 5: Provisioning Concepts for important details regarding the
features discussed in this task.

Task Perform the following task to modify the Lucent ONNS session
parameters so as to re-establish communication between a
network element and the ONN.
............................................................................................................................................................

1 From the Network Map, select a LambdaRouter/Lucent ONNS
network element icon that is DOWN (out of communication).

Result:

The selected network element becomes highlighted.

............................................................................................................................................................

2 Right-click the network element.

Result:

The Node menu appears.

............................................................................................................................................................

3 Select Session > Manage Lucent ONNS > Display/Modify Session
Parameters.

Result:

The Lucent ONNS Session Parameters form appears.
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Note: a user may also reach this form by selecting from the Network
Map: Configuration > Lucent ONNS > Session Parameters >
Add/Modify. From this alternate approach, the user can modify the
Lucent ONNS session parameters for multiple LambdaRouters within
the same form.

............................................................................................................................................................

4 Select and edit a single editable field. Editable fields include: IP
Address, Signalling IP Address, Login, and Password.

Result:

The edited field remains active.

............................................................................................................................................................

5 Select Actions > Update.

Result:

The field is updated to include the edit.

............................................................................................................................................................

6 Repeat Steps 4 and 5 to edit any additional fields.

............................................................................................................................................................

7 Press OK.

Result:

The Lucent ONNS session parameter is modified.
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View Lucent ONNS network elements
....................................................................................................................................................................................................................................

Purpose Use this task to view only the Lucent ONNS network elements on the
Network Map. This task is useful when you wish to quickly view only
the Lucent ONNS network elements on a Network Map crowded with
many network element types.

Before you begin Before you perform this task, refer to the Lucent ONNS section of
Chapter 5: Provisioning Concepts for important details regarding the
features discussed in this task.

Task Perform the following task to view only the Lucent ONNS
network elements on the Network Map. This task assumes that
the Network Map view already has an expanded view of an area.
............................................................................................................................................................

1 From the Network Map, select View > Lucent ONNS network
elements.

Result:

The Expanded Area window of the Network Map alters so as to
show only the ONN-related network elements.

Note

The user can return to the Network Map’s default view by selecting
View > Network View Reset.
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View Lucent ONNS switch connection spans
....................................................................................................................................................................................................................................

Purpose Use this task to view the Lucent ONNS switch connection spans
appearing on the Network Map.

Through this task, Navis™ Optical PM - NP will display all the fixed
connection spans and optic links based on whether they are:

• allocated and unallocated to the ONN

• terminating on a LambdaRouter or any SONET network element

• not terminating on DWDMs.

Before you begin Before you perform this task, refer to the Lucent ONNS section of
Chapter 5: Provisioning Concepts for important details regarding the
features discussed in this task.

Task Perform the following task to view the Lucent ONNS switch
connections on the Network Map.
............................................................................................................................................................

1 From the Network Map, select View > Link View > Lucent ONNS
Switch Connection Spans.

Result:

The Expanded Area window of the Network Map alters so as to
show the Lucent ONNS switch connection spans.
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Note

The user can return to the Network Map’s default view by selecting
View > Network View Reset.
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View and modify bandwidth allocation by trail
....................................................................................................................................................................................................................................

Purpose Use this task to view and modify the bandwidth allocation parameters
by trail.

Before you begin Before you perform this task, refer tothe Lucent ONNS section of
Chapter 5: Provisioning Concepts for important details regarding the
features discussed in this task.

Task Perform the following task to modify the bandwidth allocation
parameters by trail.
............................................................................................................................................................

1 From the Network Map, select Configuration > Lucent ONNS >
Allocate Bandwidth.

Result:

The Bandwidth Allocation Query Box appears.

Users may also access this form by right-clicking on an Lucent ONNS
network element and selecting Link > Ckt/Trail List.

............................................................................................................................................................

2 From the Trails tab, select a trail type for Trail.

Result:

The Trail field contains the selection.

............................................................................................................................................................

3 Press CKT/Trail ID.

Result:

The Selection box appears.

............................................................................................................................................................

4 Select a trail.

Result:

The trail becomes highlighted.

............................................................................................................................................................

5 Press OK.
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Result:

The CKT/Trail ID field contains the selected trail.

............................................................................................................................................................

6 Press OK.

Result:

The Bandwidth Allocation window appears listing the bandwidth
allocation details for the selected trail.

............................................................................................................................................................

7 Select and edit a single editable field.

Result:

The edited field remains active.

............................................................................................................................................................

8 Select Actions > Allocate.

Result:

The field is updated to include the edit.

............................................................................................................................................................

9 Repeat Steps 7 and 8 to edit any additional fields.

............................................................................................................................................................

10 Press OK.

Result:

The bandwidth allocation is modified.
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View and modify bandwidth allocation by port
....................................................................................................................................................................................................................................

Purpose Use this task to view and modify the bandwidth allocation parameters
by port.

Before you begin Before you perform this task, refer to the Lucent ONNS section of
Chapter 5: Provisioning Concepts for important details regarding the
features discussed in this task.

Task Perform the following task to view and modify the bandwidth
allocation parameters by port.
............................................................................................................................................................

1 From the Network Map, select Configuration > Lucent ONNS >
Allocate Bandwidth.

Result:

The Bandwidth Allocation Query Box appears.

Users may also access this form by right-clicking on an Lucent ONNS
network element and selecting “Session.”

............................................................................................................................................................

2 Select the Ports tab.

Result:

The Ports tab appears.

............................................................................................................................................................

3 Press the Node button.

Result:

The Selection Box form appears.

............................................................................................................................................................

4 Select a network element.

Result:

The network element becomes highlighted.

............................................................................................................................................................

5 Press OK.
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Result:

The Node field contains the selected network element.

............................................................................................................................................................

6 Press OK.

Result:

The Bandwidth Allocation window appears listing the bandwidth
allocation details for the selected network element.

............................................................................................................................................................

7 Select and edit a single editable field.

Result:

The edited field remains active.

............................................................................................................................................................

8 Select Actions > Allocate.

Result:

The field is updated to include the edit.

............................................................................................................................................................

9 Repeat Steps 7 and 8 to edit any additional fields.

............................................................................................................................................................

10 Press OK.

Result:

The bandwidth allocation is modified.
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Provision an Lucent ONNS connection
....................................................................................................................................................................................................................................

Overview For information on provisioning an Lucent ONNS connection, refer to
the Lucent ONNS section of Chapter 5: Provisioning Concepts.
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Section V: Subnets

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the provisioning tasks associated with subnets.

Definition Subnets are defined as devices on a network that shares a common
address component. For example, all devices with IP addresses that
start with 100.100.100. could be part of the same subnet. Dividing a
network into subnets is useful for both security and performance
reasons.

Navis™ Optical PM - NP subnet support allows users to create rings
on the Network Map. In terms of the Navis™ Optical PM - NP, a ring
is defined as when three or more network elements are connected to
form a closed loop. Messages travel around the ring, with each
network element reading those messages addressed to it.

An advantage of ring networks is that they can span larger distances
than other types of networks, such as bus networks, because each
network element regenerates messages as they pass through it.
Another advantage is that one half of the ring’s channels can be
defined as working (carrying data) while the other half can be defined
as protection.

Creating subnets Navis™ Optical PM - NP allows users to create rings either
automatically or manually. Refer to Chapter 5: Provisioning Concepts
for details about rings.

Supported subnets Navis™ Optical PM - NP supports two broad categories of rings:

• bidirectional line switched rings (BLSR).

• unidirectional path switched rings (UPSR).

In addition to the BLSR and UPSR ring types, Navis™ Optical PM -
NP also provides support for subtending and virtual rings. These two
type rings are dependent on BLSR and UPSR ring types and can not
exist independently from one of those types.

Before you begin Refer to the individual tasks contained within this section for
important “Before You Begin” information.

Provisioning Tasks
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Additional information For additional information about subnets as they relate to Navis™

Optical PM - NP, refer to Chapter 5: Provisioning Concepts of this
guide.

For information on how to create subtending and virtual rings, refer to
Chapter 5: Provisioning Concepts of this guide.

For information on using Navis™ Optical PM - NP’s hairpinning
feature, refer to Chapter 5: Provisioning Concepts of this guide.

Contents
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Add a BLSR (manual) 4-79

Add a UPSR (automatic) 4-81

Add a UPSR (manual) 4-84
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Modify a ring 4-87

Delete a ring 4-88
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Add a BLSR (automatic)
....................................................................................................................................................................................................................................

Purpose Use this task to automatically add a bidirectional line-switched ring
(BLSR) to the Navis™ Optical PM - NP Network Map.

Before you begin Before you attempt to add a BLSR to the Network Map automatically,
note the following items:

• A ring is uniquely identified by the digital link rates forming the
ring. An OC-48 BLSR and OC-192 BLSR that share the same
exact network elements are different from one another due to
their rates.

• A maximum of 16 network elements are allowed.

• The ring forming digital links are all of the same level.

• The ring is closed.

• No black boxes are included.

• The ring forming digital links have identical (2-fiber or 4-fiber)
protection groups.

• All the network elements in the ring can interwork in a
BLSR-forming capacity.

• Within each ring, the same timeslot and channel must be used.

Task Perform the following task to automatically add a BLSR to the
Network Map. This task will show you how to add a BLSR
consisting of three network elements. Note that a BLSR can
consist of up to 16 network elements.
............................................................................................................................................................

1 From the Network Map, select a network element. Be sure the
selected network element has BLSR forming capabilities.

Result:

The selected network element is highlighted.

............................................................................................................................................................

2 Synchronize the network element’s ports. Refer to the network
element synchronization task in Chapter 3: Network Element
Configuration Tasks for details on how to perform this task.
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Result:

The network element is synchronized.

............................................................................................................................................................

3 Select a second network element and repeat Step 2. Be sure that the
network element can interwork with the first network element in a
BLSR-forming capacity.

Result:

The network element is synchronized.

............................................................................................................................................................

4 Provision a digital link between the two network elements. Refer to
Section I: Digital Links in this chapter for information on how to
provision a digital link between two network elements.

Result:

A digital link joins the two network elements (network element
A and network element B).

............................................................................................................................................................

5 From the Network Map, select a third network element and repeat
Step 2.

Result:

The network element is synchronized.

............................................................................................................................................................

6 Provision a digital link between this network element (network
element C) and network element A. Note that the digital link you
provision in this step must be identical in rate to the digital link you
provisioned in Step 4.
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Result:

A digital link joins the two network elements (network element
A and network element C).

............................................................................................................................................................

7 Provision a digital link between network element C and network
element B being sure to form an enclosed ring. Note that the digital
link you provision in this step must be identical in rate to the digital
link you provisioned in Steps 4 and 6.

Result:

Assuming the conditions mentioned in the “Before You Begin”
section are met, Navis™ Optical PM - NP automatically creates a
BLSR and adds its name (automatically generated) to the Subnet
List.
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Add a BLSR (manual)
....................................................................................................................................................................................................................................

Purpose Use this task to manually add a bidirectional line-switched ring
(BLSR) to the Navis™ Optical PM - NP Network Map.

Before you begin Before you attempt to manually add a BLSR to the Network Map,
note the items presented in the “Add a BLSR (automatic)” task.

Task Perform the following task to manually add a BLSR to the
Network Map. This task assumes that the appropriate network
elements and digital links, for forming a BLSR, have already
been provisioned.
............................................................................................................................................................

1 From the Network Map, select Configuration > Subnet > Add > LSR
> (select a rate). The rate you select must be compatible with the
network elements and digital links you are planning to use in creating
the BLSR.

Result:

The Subnet Manual Creation form appears.

............................................................................................................................................................

2 From the Network Map, select a digital link you wish to add to the
ring.

Result:

The A and Z fields within the Subnet Manual Creation form
become populated with the digital link information.

............................................................................................................................................................

3 From the Subnet Manual Creation form, select the digital link.

Result:

Selection becomes highlighted and the arrow icon becomes
enabled.

............................................................................................................................................................

4 Press the arrow icon to move the digital link to the Subnet
Designation sub-window.
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Result:

The subwindow’s fields become populated with the digital link
information. The digital link on the Network Map becomes
thicker to signify the creation of a piece of the BLSR.

............................................................................................................................................................

5 Repeat Steps 2 through 4 until you form an enclosure using the digital
links and network elements.

............................................................................................................................................................

6 Press OK.

Result:

The BLSR is created.

Section V: Subnets
Add a BLSR (manual)

Provisioning Tasks

....................................................................................................................................................................................................................................

4 - 8 0 Lucent Technologies 365-314-106R1.1
Issue 1, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Add a UPSR (automatic)
....................................................................................................................................................................................................................................

Purpose Use this task to automatically add a unidirectional line-switched ring
(UPSR) to the Navis™ Optical PM - NP Network Map.

Before you begin Before you attempt to add a UPSR to the Network Map automatically,
note the following items:

• A ring is uniquely identified by the digital link rates forming the
ring. An OC-48 UPSR and OC-192 UPSR that share the same
exact network elements are different from one another due to
their rates.

• A maximum of 65 network elements are allowed.

• The ring forming digital links are all of the same level.

• The ring is closed.

• No black boxes are included.

• The ring forming digital links have identical (2-fiber or 4-fiber)
protection groups.

• All the network elements in the ring can interwork in a
UPSR-forming capacity.

• Only homogenous network elements are allowed in automatically
forming a UPSR. Note, however, that the Metropolis DMX and
DMXpress network elements are considered as the same network
element type in forming a UPSR.

• Within each ring, the same timeslot and channel must be used.

Task Perform the following task to automatically add a BLSR to the
Network Map. This task will show you how to add a UPSR
consisting of three network elements. Note, however, that a
BLSR can consist of up to 65 network elements.
............................................................................................................................................................

1 From the Network Map, select a network element. Be sure the
selected network element has UPSR forming capability.

Result:

The selected network element is highlighted.
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............................................................................................................................................................

2 Synchronize the network element’s ports. Refer to the network
element synchronization task in Chapter 3: Network Element
Configuration Tasks for details on how to perform this task.

Result:

The network element is synchronized.

............................................................................................................................................................

3 Select a second network element and repeat Step 2. Be sure that the
network element can interwork with the first network element in a
UPSR-forming capacity,

Result:

The network element is synchronized.

............................................................................................................................................................

4 Provision a digital link between the two network elements. Refer to
Section I: Digital Links in this chapter for information on how to
provision a digital link between two network elements.

Result:

A digital link joins the two network elements (network element
A and network element B).

............................................................................................................................................................

5 From the Network Map, select a third network element that is
compatible with the other two network elements and repeat Step 2.

Result:

The network element is synchronized.

............................................................................................................................................................

6 Provision a digital link between this network element (network
element C) and network element A. Note that the digital link you
provision in this step must be identical in rate to the digital link you
provisioned in Step 4.
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Result:

A digital link joins the two network elements (network element
A and network element C).

............................................................................................................................................................

7 Provision a digital link between network element C and network
element B being sure to form an enclosed ring. Note that the digital
link you provision in this step must be identical in rate to the digital
link you provisioned in Steps 4 and 6.

Result:

Assuming the conditions mentioned in the “Before You Begin”
section are met, Navis™ Optical PM - NP automatically creates a
UPSR and adds its name (automatically generated) to the Subnet
List.

Section V: Subnets
Add a UPSR (automatic)

Provisioning Tasks

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 4 - 8 3

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Add a UPSR (manual)
....................................................................................................................................................................................................................................

Purpose Use this task to manually add a unidirectional line-switched ring
(UPSR) to the Navis™ Optical PM - NP Network Map.

Before you begin Before you attempt to manually add a UPSR to the Network Map,
note the items presented in the “Add a UPSR (automatic)” task.

Task Perform the following task to manually add a UPSR to the
Network Map. This task assumes that the appropriate network
elements and digital links, for forming a UPSR, have already
been provisioned.
............................................................................................................................................................

1 From the Network Map, select Configuration > Subnet > Add > PSR
> (select a rate). The rate you select must be compatible with the
network elements and digital links you are planning to use to create
the ring.

Result:

The Subnet Manual Creation form appears.

............................................................................................................................................................

2 From the Network Map, select a digital link you wish to add to the
subnet.

Result:

The A and Z fields within the Subnet Manual Creation form
become populated with the digital link information.

............................................................................................................................................................

3 From the Subnet Manual Creation form, select the digital link.

Result:

Selection becomes highlighted and the arrow icon becomes
enabled.

............................................................................................................................................................

4 Press the arrow icon to move the digital link to the Subnet
Designation sub-window.
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Result:

The subwindow’s fields become populated with the digital link
information. The digital link on the Network Map becomes
thicker to signify the creation of a piece of the UPSR.

............................................................................................................................................................

5 Repeat Steps 2 through 4 until you form an enclosure using digital
links and network elements.

............................................................................................................................................................

6 Press OK.

Result:

The UPSR is created.
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Modify a ring name
....................................................................................................................................................................................................................................

Purpose After successful ring creation, Navis™ Optical PM - NP will generate
a unique name to identify the ring. Use this task to modify the name
of an existing ring.

Task Perform the following task to modify the name of an existing
ring. This task assumes that a ring has already been created.
............................................................................................................................................................

1 From the Network Map, select Configuration > Subnet >
Display/Modify.

Result:

The Subnet Display List form appears.

............................................................................................................................................................

2 In the Subnet IDs column, select a subnet.

Result:

The selection is highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

3 Select Actions > Modify Parameters.

Result:

The Subnet window appears.

............................................................................................................................................................

4 Specify a new subnet ID in the Subnet ID field. You must assign a
unique ID.

............................................................................................................................................................

5 Click OK.

Result:

The Network Map displays the new ring name.
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Modify a ring
....................................................................................................................................................................................................................................

Purpose Use this task to modify an existing ring.

Task Important! No modification of a virtual ring is allowed after the
ring is created. To make any changes to an already existing
virtual ring, the user must delete the ring and create it again.

Perform the following task to modify an existing ring.
............................................................................................................................................................

1 From the Network Map, select Configuration > Subnet >
Display/Modify.

Result:

The Subnet Display List form appears.

............................................................................................................................................................

2 In the Subnet IDs column, select a subnet.

Result:

The selection is highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

3 Select Actions > Modify Parameters.

Result:

The Subnet window appears.

............................................................................................................................................................

4 Make the desired modifications to the ring.

............................................................................................................................................................

5 Click OK.

Result:

The Network Map reflect any modifications made to the ring.
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Delete a ring
....................................................................................................................................................................................................................................

Purpose Use this task to delete a ring from the Navis™ Optical PM - NP
Network Map.

Before you begin Before you attempt to delete a ring from the Network Map, note the
following items:

• Navis™ Optical PM - NP allows for the disconnection of a digital
link even if the digital link is part of a ring loop as long as the
ring is not providing any protection.

• If the user disconnects a digital link that is part of a ring forming
loop, Navis™ Optical PM - NP will delete the ring and remove
the ring name from the list of ring names.

• Navis™ Optical PM - NP allows users to delete a virtual ring
without deleting the STS-1 paths as long as there are no VT1.5
circuits riding on the virtual ring. If any of the STS-1 paths that
are part of a virtual ring are deleted, the virtual ring is
automatically deleted. If any of the rings forming the virtual ring
are deleted, the virtual ring is deleted.

Task Perform the following task to delete a ring from the Network
Map.
............................................................................................................................................................

1 Select a digital link that is part of the ring you wish to delete.

............................................................................................................................................................

2 From the Network Map, select Configuration > Digital Link >
Disconnect.

Result:

The Ckt/Trail Query Box is displayed.

............................................................................................................................................................

3 In the Order Number field, specify the order number of the digital
link.

............................................................................................................................................................

4 Click OK.

Result:

A confirmation window appears.
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............................................................................................................................................................

5 Click Yes.

Result:

An action window appears.

............................................................................................................................................................

6 Click OK.

Result:

Navis™ Optical PM - NP disconnects the digital link provided
that it is not in-effect (IE) or pending.

............................................................................................................................................................

7 From the Network Map, select File > Query Again.

Result:

The digital link, that was part of the subnet, disappears from the
Network Map, and Navis™ Optical PM - NP deletes the ring
because there is no longer an enclosed ring.
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Section VI: Virtual Concatenation Groups

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the provisioning tasks associated with virtual
concatenation groups (VCG).

Definition Virtual concatenation is a standards compliant inverse multiplexing
protocol which creates a virtual concatenated entity which is
transported by STS-Ns across the network. The created STS-Ns are
standards compliant. Additional STSs can be added, however it will
be service affecting.

Before you begin Refer to the individual tasks contained within this section for
important “Before You Begin” information.

Additional information For additional information about virtual concatenation groups as they
relate to Navis™ Optical PM - NP, refer to Chapter 5: Provisioning
Concepts of this guide.

Contents
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Delete a virtual concatenation group 4-94
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Add a virtual concatenation group
....................................................................................................................................................................................................................................

Purpose Use this task to add a VCG to the Navis™ Optical PM - NP Network
Map.

Task Perform the following task to add a VCG to the Navis™ Optical
PM - NP Network Map.
............................................................................................................................................................

1 From the Network Map, select Configuration > Virtual
Concatenation Group > Add.

Result:

The Add VCG form appears.

............................................................................................................................................................

2 In the VCG Name field, specify a VCG name (maximum of 83
alphanumeric characters).

............................................................................................................................................................

3 Specify either Single-Ended or Dual-Ended.

Result:

If Single-Ended is selected, either the A or Z field will
disappear.

............................................................................................................................................................

4 Press the A Location button.

Result:

The Selection box appears.

............................................................................................................................................................

5 Select a network element.

............................................................................................................................................................

6 Press OK.

Result:

The A Location field will contain the specified network element,
and the A Port button becomes active.
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............................................................................................................................................................

7 Press the A Port button.

Result:

The Selection box appears.

............................................................................................................................................................

8 Select a port.

............................................................................................................................................................

9 Press OK.

Result:

The A Port field contains the specified port.

............................................................................................................................................................

10 Repeat Steps 4 through 9 to specify the Z location and Z Port.

Result:

The Z Location and Z Port fields specify a network element and
port.

............................................................................................................................................................

11 Specify the options within the VCG Capacity panel.

............................................................................................................................................................

12 Specify the Required Capacity.

............................................................................................................................................................

13 Select LCAS Flag if applicable (this option must be supported by the
network elements select for the A and Z Location). Refer to Chapter
5: Provisioning Concepts for details regarding LCAS.

............................................................................................................................................................

14 Press OK.

Result:

The VCG is created.

Note: If Graphical Layout is checked, the Graphical Layout
screen will appear. Press Approve to dismiss the screen.
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Modify a virtual concatenation group
....................................................................................................................................................................................................................................

Purpose Use this task to modify an existing VCG.

Task Perform the following task to modify an existing VCG.
............................................................................................................................................................

1 From the Network Map, select Configuration > Virtual
Concatenation Group > Display/Modify.

Result:

The VCG List form appears.

............................................................................................................................................................

2 Select a VCG name from the VCG Name field.

Result:

The selection is highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

3 Select Actions > Graphical Layout.

Result:

The VCG Graphical Layout form appears.

............................................................................................................................................................

4 Select Actions > Modify > Order Parameters.

Result:

The Modify VCG form appears.

............................................................................................................................................................

5 Perform edits on the applicable fields.

............................................................................................................................................................

6 Press OK.

Result:

The VCG is modified.
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Delete a virtual concatenation group
....................................................................................................................................................................................................................................

Purpose Use this task to delete an existing VCG.

Before you begin Before attempting to delete a VCG, verify that the VCG to be deleted
does not have any STS-Ns associated with it.

Task Perform the following task to delete an existing virtual
concatenation group.
............................................................................................................................................................

1 From the Network Map, select Configuration > Virtual
Concatenation Group > Display/Modify.

Result:

The VCG List form appears.

............................................................................................................................................................

2 Select a VCG name from the VCG Name field.

Result:

The selection is highlighted, and the Actions menu item
becomes enabled.

............................................................................................................................................................

3 Select Actions > Delete.

Result:

The VCG is deleted.
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Section VII: Shared Risk Groups

Overview
....................................................................................................................................................................................................................................

Purpose This section discusses the provisioning tasks associated with shared
risk groups.

Definition In order to provide physical separacy between a protected route and
service route, Navis™ Optical PM - NP supports the association of
shared risk groups to digital links. One or more shared risk groups
can be associated with one digital link, or a number of digital links
can be associated with one shared risk group.

All fibers, cables and conduits in a given shared risk group may not
survive physical disaster. In order to design a network for maximum
survivability, shared risk groups, which are used for working
paths/circuits, must not be used for protection paths/circuits. In case of
rings or linear protection, network designers must take care of
physical separacy, because links and path are well defined.

Before you begin Before you attempt to create a shared risk group, consider the
following items:

• A maximum of five shared risk groups can be associated with a
single digital link.

• One shared risk group can be used by multiple digital links.

• A shared risk group identification can not exceed 83
alphanumeric characters.

• A shared risk group description can not exceed 32 alphanumeric
characters.

• Shared risk groups are only applicable to digital links, optical
links and optical multiplex sections.

• Users are not allowed to modify or delete a shared risk group ID
when it is associated with a digital link, optical link, or optical
multiplex section.
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Display a list of shared risk groups 4-98

Display the shared risk groups associated with a
digital link
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Create a shared risk group ID
....................................................................................................................................................................................................................................

Purpose Use this task to create a shared risk group ID.

Before you begin Before following this procedure, refer to “Before You Begin” located
at the beginning of this section for important information.

Task Perform the following task to create a shared risk group ID.
............................................................................................................................................................

1 On the Network Map, select Configuration > Shared Risk Group >
Add.

Result:

The Add Shared Risk Group form appears.

............................................................................................................................................................

2 In the SRG Name field, specify a unique name for the shared risk
group.

............................................................................................................................................................

3 In the SRG ID field, specify a unique identification for the shared risk
group.

............................................................................................................................................................

4 In the Description field, provide a description of the shared risk
group so as to distinguish it from other existing shared risk groups.

............................................................................................................................................................

5 Click OK.

Result:

The shared risk group ID is created.
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Display a list of shared risk groups
....................................................................................................................................................................................................................................

Purpose Use this task to display a list of existing shared risk groups.

Before you begin Before following this procedure, refer to “Before You Begin” located
at the beginning of this section for important information.

Task Perform the following task to display a list of existing shared risk
groups.
............................................................................................................................................................

1 From the Network Map, select Configuration > Shared Risk Group
> Display/Modify.

Result:

The Shared Risk Group Display List Query Box appears.

............................................................................................................................................................

2 In the SRG ID field, specify an identification (or specify * to list all
shared risk groups).

............................................................................................................................................................

3 Press OK.

Result:

The Shared Risk Group Display List form appears and displays
a list of all the existing shared risk groups.
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Display the shared risk groups associated with a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to display the shared risk groups associated with a
digital link.

Before you begin Before following this procedure, refer to “Before You Begin” located
at the beginning of this section for important information.

Task Perform the following task to display the shared risk groups
associated with a digital link.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection >
Display > Circuit/Trail List.

Result:

The Circuit/Trail Query Box window appears.

............................................................................................................................................................

2 In the Ckt/Trail ID field, select a rate.

............................................................................................................................................................

3 In the Order Status field, specify an order status.

............................................................................................................................................................

4 In the Order Action field, select an order action.

............................................................................................................................................................

5 Press OK.

Result:

The Circuit Trail List window appears.

............................................................................................................................................................

6 From the list, select a circuit/trail identification.

Result:

The selected identification is highlighted.

............................................................................................................................................................

7 Select Actions > Shared Risk Group Associations/Display.
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Result:

A window appears showing all the shared risk groups associated
with the digital link.
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Display the digital links associated with a shared risk group
....................................................................................................................................................................................................................................

Purpose Use this task to display the digital links associated with a shared risk
group.

Before you begin Before following this procedure, refer to “Before You Begin” located
at the beginning of this section for important information.

Task Perform the following task to display the digital links associated
with a shared risk group.
............................................................................................................................................................

1 From the Network Map, select Configuration > Shared Risk Group
> Display/Modify.

Result:

The Shared Risk Group Display Query Box appears.

............................................................................................................................................................

2 In the SRG ID field, specify a shared risk group ID.

............................................................................................................................................................

3 Press OK.

Result:

The Share Risk Group Display List form appears and lists the
shared risk groups according to the query information that was
specified.

............................................................................................................................................................

4 From the list, select a shared risk group.

Result:

The selection is highlighted.

............................................................................................................................................................

5 Select Actions > Shared Risk Group-Links Associations List.

Result:

The Shared Risk Group-Links Associations List form appears
and displays all the digital links associated with the specified
shared risk group.
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Associate a shared risk group with a digital link
....................................................................................................................................................................................................................................

Purpose Use this task to associate a shared risk group with a digital link.

Before you begin Before following this procedure, refer to “Before You Begin” located
at the beginning of this section for important information.

Task Perform the following task to associate a shared risk group with a
digital link.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection >
Display > Circuit/Trail List.

Result:

The Circuit/Trail Query Box form appears.

............................................................................................................................................................

2 In the Order Status field, specify an order status.

............................................................................................................................................................

3 In the Ckt/Trail ID field, select a rate.

............................................................................................................................................................

4 Press OK.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

5 From the list, select a circuit/trail identification.

Result:

The selected identification is highlighted.

............................................................................................................................................................

6 Select Actions > Shared Risk Group Associations/Display.

Result:

A form appears displaying all the shared risk groups associated
with the digital link.
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............................................................................................................................................................

7 Using the window’s arrow icons, associate a shared risk group with
the digital link by moving the SRG from the Non-associated SRGs
panel to the Associated SRG panel.

Result:

The SRG is moved between panels.

............................................................................................................................................................

8 Select Apply.

Result:

The shared risk group is associated with the digital link.

Section VII: Shared Risk Groups
Associate a shared risk group with a digital
link

Provisioning Tasks

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 4 - 1 0 3

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



Disassociate a shared risk group with a digital link
....................................................................................................................................................................................................................................

Purpose Use the following task to disassociate a shared risk group with a
digital link.

Before you begin Before following this procedure, refer to “Before You Begin” located
at the beginning of this section for important information.

Task Perform the following task to disassociate a shared risk group
with a digital link.
............................................................................................................................................................

1 From the Network Map, select Configuration > Connection >
Display > Circuit/Trail List.

Result:

The Circuit/Trail Query Box form appears.

............................................................................................................................................................

2 In the Order Status field, specify an order status.

............................................................................................................................................................

3 In the Ckt/Trail ID field, select a rate.

............................................................................................................................................................

4 Press OK.

Result:

The Circuit/Trail List form appears.

............................................................................................................................................................

5 From the list, select a circuit/trail identification.

Result:

The selected identification is highlighted.

............................................................................................................................................................

6 Select Actions > Shared Risk Group Associations/Display.

Result:

A form appears displaying all the shared risk groups associated
with the digital link.
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............................................................................................................................................................

7 Using the window’s arrow icons, disassociate a shared risk group with
the digital link by moving the SRG from the Associated SRG panel
to the Non-associated SRGs panel.

Result:

The SRG is moved between panels.

............................................................................................................................................................

8 Select Apply.

Result:

The digital link is disassociated with the shared risk group.
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Modify a shared risk group ID
....................................................................................................................................................................................................................................

Purpose Use this task to modify a shared risk group ID.

Task Perform the following task to modify a shared risk group ID.
............................................................................................................................................................

1 From the Network Map, select Configuration > Shared Risk Group
> Display/Modify.

Result:

The Shared Risk Group Display List Query Box form appears.

............................................................................................................................................................

2 In the SRG ID field, specify an existing shared risk group
identification. If you specify nothing, you will get a complete list of
existing shared risk groups.

............................................................................................................................................................

3 Press OK.

Result:

The Shared Risk Group Display List form appears and lists the
shared risk groups according to the query information specified
within the previous window.

............................................................................................................................................................

4 In the SRG ID field, select a shared risk group.

............................................................................................................................................................

5 Select Actions > Update.

Result:

A form appears.

............................................................................................................................................................

6 In the New SRG ID and New Description fields, specify new
information for the shared risk group.

............................................................................................................................................................

7 Click OK.

Result:

The shared risk group ID is modified.
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Delete a shared risk group ID
....................................................................................................................................................................................................................................

Purpose Use this task to delete a shared risk group ID.

Task Perform the following task to delete a shared risk group ID.
............................................................................................................................................................

1 From the Network Map, select Configuration > Shared Risk Group
> Display/Modify.

Result:

The Shared Risk Group Display List Query Box form appears.

............................................................................................................................................................

2 In the SRG ID field, specify an existing shared risk group
identification. If you specify nothing, you will get a complete list of
existing shared risk groups.

............................................................................................................................................................

3 Press OK.

Result:

The Shared Risk Group Display List form appears and lists the
shared risk groups according to the query information specified
within the previous window.

............................................................................................................................................................

4 From the list, select a shared risk group.

Result:

The selection is highlighted.

............................................................................................................................................................

5 Select Actions > Delete.

............................................................................................................................................................

6 From the Network Map, select File > Query Again.

Result:

The shared risk group ID is deleted.
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5 Provisioning Concepts

Overview
....................................................................................................................................................................................................................................

Purpose This chapter provides conceptual material related to network elements,
digital links, connections, optical layers, the Optical Network
Navigator, subnets, virtual concatenation groups, and shared risk
groups with Navis™ Optical PM - NP. This information is meant to
compliment and provide detail for the task-related provisioning
information presented in the previous chapters.
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Section I: Network Elements

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information regarding the network
elements supported by Navis™ Optical PM - NP. Navis™ Optical PM -
NP supports two types of network elements: controlled and
noncontrolled.
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Controlled network elements
....................................................................................................................................................................................................................................

Definition Controlled network elements are network elements that can be
controlled by Navis™ Optical PM - NP.

Characteristics Controlled network elements have the following characteristics:

• They are usually displayed on the Network Maps as nodes
(physical locations) interconnected by digital links. A unique icon
represents each network element type.

• They are in constant communication with their EMS.

• They are controlled by commands sent from the EMS (The EMS
receives and processes the responses from the controllable
network element).

• They report and show alarms.

Control techniques Navis™ Optical PM - NP supported network elements are controlled
indirectly through the Navis™ Optical EMS.

Controlled Navis™ Optical
PM - NP network elements

The Navis™ Optical PM - NP products listed within the following
table are controllable network elements.

Table 5-1 Controlled network elements supported by Navis™ Optical PM - NP

Network Element Features Navis™ Optical PM -
NP Model

LambdaRouter All Optical
Switch (AOS) 128 Release
2.0

* 2.5G, 10G OEO packs.

* 1+1 network protection.

* No performance monitoring support.

LAMBDA_ROUTER_
128

LambdaRouter AOS 256
Release 3.0

LAMBDA_ROUTER_
256
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Table 5-1 Controlled network elements supported by Navis™ Optical PM - NP (continued)

LambdaUnite MultiService
Switch (MSS) Release 2.0

* OC-192, OC-48 ports.

* SNC/I and SNC/N protected cross-connects.

* Two-fiber BLSR/MSSPRING on OC192 and
OC48 interfaces.

* 1:2 bridging.

* 1 Gb Ethernet interface.

* Operate/release protection switching.

* Performance monitoring data collection,
TCA generation and TCA threshold
provisioning for all monitoring points.

LAMBDA_UNITE

LambdaUnite MSS Release
2.1

* OC-12, OC-3 optical interface ports.

* 1+1 line protection (APS) on OC12 and C3
(both UNI and BI APS switch types).

* Four-fiber BLSR/MSSPRING on OC192
optical interface ports.

Metropolis EON Dual-Facing
Terminal

* Release 8.0.2; controlled by
Navis™ Optical EMS. Node
types include: DUAL

* Three types - end terminal, ring terminal and
regenerator.

* Sixteen wavelengths.

* OUPSR (similar to ORS in 1.6T) protection.

* Support all monitoring points (performance
monitoring counters and TCAs).

EON_DF

Metropolis EON
Single-Ended Terminal

* Release 8.0.2; controlled by
Navis™ Optical EMS. Node
types include: 1A-TX,
1A-TX-THRU, 1A-RCV,
1A-RCV-THRU, 1A-TX-32,
1A-TX-THRU-32,
1A-RCV-32, 1A-RCV-
THRU-32.

EON_SE

Metropolis EON Repeater

* Release 8.0.2; controlled by
Navis™ Optical EMS. Node
types include: Repeater

EON_RPTR
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Table 5-1 Controlled network elements supported by Navis™ Optical PM - NP (continued)

Metropolis DMXpress Access
Multiplexer, Release 1.0

* OC-48, DS3, DS1 ports.

* STS-12c, STS-3c, STS-1 and VT1.5 (two
way only) XCs.

* Gb Ethernet ports.

* Support all monitoring points (performance
monitoring counters and TCAs).

DMXPRESS

Metropolis DMX Access
Multiplexer, Release 2.0, 2.1

* OC-192 (high speed side only), OC-48 (high
and low speed sides), OC-12 (low speed side
only), OC-3 (low speed side only).

* 1+1 line protection.

* STS-12c, STS-3c, STS-1 and VT1.5 (two
way only).

* DS-3/EC-1, DS1 provisioning.

* Gb Ethernet ports.

* Support all monitoring points (performance
monitoring counters and TCAs).

DMX

WaveStar Bandwidth
Manager, Release 4.1

* Increased capacity.

* New switch fabric shelves.

* Supports all SONET performance monitoring
points (performance monitoring counters and
TCAs).

BWM

WaveStar OLS 1.6T, Release
6.1 Two-Fiber End Terminal

* In-service upgrade from Release 6.0 to 6.1.

* Port AID changes for 10GMUX OTU drop
side.

WS_OLS1.6T

WaveStar OLS 1.6T, Repeater
Release 6.1. Two-Fiber
Repeater

WS_OLS1.6T_
REPEATER

WaveStar TDM 2.5G/10G,
Release 6.0 (OC-192
two-fiber)

* OC-192, OC-48, DS3/EC-1 ports.

* 1+1 line protection, UPSR.

* STS-48c, STS-12c, STS-3c and STS-1 (two
way only) XCs.

* Gb Ethernet ports.

* Support all monitoring points (performance
monitoring counters and TCAs).

2_5G_10G
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Adding controlled network
elements to Navis™ Optical

PM - NP

After a database synchronization with the EMS, Navis™ Optical PM -
NP automatically adds all the network elements managed by the EMS
to the Network Map and stores them in the database. Navis™ Optical
PM - NP allows the user, with appropriate privileges, to add a new
network element through the Configuration menu item of the Network
Map. Refer to Chapter 3: Network Element Configuration Tasks for
details on adding network elements to the Navis™ Optical PM - NP
Network Map.

Icons for controlled
network elements

Controlled network elements managed by Navis™ Optical PM - NP
appear as icons on the Network Map. A legend showing all the icons
and their respective models of network elements is available from the
Network Map when requested by the user. The following table
describes the different controlled network element icons used on the
Network Map.

Table 5-2 Controlled network element icons

LAMBDA_ROUTER_256; LAMBDA_UNITE; BWM; 2_5G_10G.

EON_SF

(All regenerators, repeaters and optical amplifiers); WS_OLS1.6T_
REPEATER; WS_OLS1.6TL_REPEATER; EON_REPEATER.

Aggregate.

WS_OLS1.6T.

DMXPRESS; DMX; EON_DF.

LambdaUnite MSS
support

The LambdaUnite MultiService Switching (MSS) network element is
a flexible single product covering 40G and 10G SONET-based
network elements. The product supports terminal multiplexers,
add-drop-multiplexers, and local cross connect configurations on all
line rates within the same common subrack and software load.
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LambdaUnite MSS supports unidirectional and bidirectional
cross-connections for OC3, OC12, OC48, and OC192. It supports
bridging and facility rolling for each of the supported cross-connection
rates. It also support broadcast option 1:2 unidirectional
cross-connection.

Each physical port can be set in one of three different modes:

• AUTO (automatic): alarms are suppressed until an incoming
signal is detected, the mode of the port switches automatically to
MON.

• MON (monitored): all alarms that originate in the physical
section termination function are reported.

• NMON (non-monitored): all alarms that originate in the physical
section termination function are suppressed.

Note: each path termination port can be either MON or NMON.

LambdaUnite MSS supports the technique of Link Capacity
Adjustment System (LCAS), previously known as Variable Bandwidth
Allocation (VBA), for GigaBit Ethernet transport. The LCAS is
supported which allows manual in-service dynamic sizing of
bandwidth in a STS-N link.

Metropolis EON support The Metropolis EON is a modular ring-based system designed for
metropolitan and regional applications. Metropolis EON provides
efficient support of Metropolis DWDM rings and increased capacity
over OLS 40G network elements.

Navis™ Optical PM - NP’s support for Metropolis EON includes:

• dual-facing DWDMs

• single-ended DWDMs

• repeaters.

Additional information For additional information about controlled network elements, refer to
Chapter 3: Network Element Configuration Tasks.
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Noncontrolled network elements
....................................................................................................................................................................................................................................

Definition Noncontrolled network elements are network elements that cannot be
controlled by Navis™ Optical PM - NP.

Characteristics Noncontrolled network elements share the following characteristics:

• They support only manual provisioning

• They do not report alarms

• They are listed in the database as part of provisioning records

Noncontrolled Navis™

Optical PM - NP network
elements

The following Navis™ Optical PM - NP products are noncontrollable
network elements:

Table 5-3 Noncontrolled network elements supported by Navis™ Optical PM - NP

Network Element Navis™ Optical PM - NP Model

Black Box BBOX

Customer Equipment EQPT

Adding noncontrolled
network elements to

Navis™ Optical PM - NP

The same information that applies to controlled network element
applies to noncontrolled network elements.

Icons for noncontrolled
network elements

Important! Locations created as “Equipment” do not appear as
icons on the Network Map. They are only listed in the Location
Reference Table. When used as the termination of a digital link
or connection, they appear on the Graphical Layout to clarify the
overall assignment.

Noncontrolled network elements managed by Navis™ Optical PM -
NP appear as icons on the Network Map. A legend showing all the
icons and their respective models of network elements is available
from the Network Map when requested by the user. The following
table describes the different noncontrolled network element icons used
on the Network Map.

Table 5-4 Noncontrolled network element icons

BBOX
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Table 5-4 Noncontrolled network element icons (continued)

EQPT

Additional information For additional information about controlled network elements, refer to
Chapter 3: Network Element Configuration Tasks found within this
guide.

Section I: Network Elements
Noncontrolled network elements

Provisioning Concepts

....................................................................................................................................................................................................................................

5 - 1 0 Lucent Technologies 365-314-106R1.1
Issue 1, July 2002



Section II: Digital Links

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information pertaining to the digital
links supported by Navis™ Optical PM - NP.
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Digital link support
....................................................................................................................................................................................................................................

Overview This section provides an overview of the digital link support provided
by Navis™ Optical PM - NP.

Definition Digital Links are transport facilities that are assignable to high order
and low order paths to carry customer services. In Navis™ Optical PM
- NP, digital links are always modelled as bidirectional links that carry
two-way traffic. The regenerator sections within the multiplexer
section layer are not explicitly provisioned; however, Navis™ Optical
PM - NP can add regenerators to the digital links and monitor alarms
at regenerator sections. All digital links are channelized in Navis™

Optical PM - NP so as to be assignable to carry SONET trails.

Protection Digital links can be unprotected or protected. When protected by
another link, it is called automatic protection switching (APS).

When APS is 1+1, the protection link is dedicated to the service link
and cannot carry preemptible extra traffic.

Navis™ Optical PM - NP supports two-fiber and four-fiber
bidirectional line switched ring (BLSR) and unidirectional path
switched ring (UPSR) protection. Refer to Section V: Subnets for
information about rings.

Supported digital links The following table presents the digital links supported by each
network element supported by Navis™ Optical PM - NP.

Table 5-5 Supported digital links per supported network element

Network Element OC-192 OC-48 OC-12 OC-3 DS3/EC-1 DS1 E_Link

Black Box Y Y Y Y Y Y Y

LambdaUnite MSS Y Y Y Y — — Y

Metropolis DMX Y Y Y Y Y Y Y

Metropolis DMXpress — Y — — Y Y Y

WaveStar BandWidth
Manager

Y Y Y Y Y — —

WaveStar TDM 2.5G/10G Y Y Y Y Y — Y
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External circuit types The following table presents the external circuit types associated with
each supported digital link.

Table 5-6 Supported digital link external circuit types

Digital Link External Circuit Type

OC-192 OC192

OC-48 OC48

OC-12 OC12

OC-3 OC3

DS3 T3

EC-1 EC1

DS1 T1

Supported digital
transmission rates

This section presents the digital transmission rates of the digital links
supported by Navis™ Optical PM - NP. For information about the
digital transmission rates of the connections supported Navis™ Optical
PM - NP, refer to Section III: Connections.

The following table presents the digital transmission rates supported
by Navis™ Optical PM - NP.

Table 5-7 Supported digital transmission rates for digital links

Digital Link Transmission Rate Mb/s

OC-192 9,953.28

OC-48 2,488.32

OC-12 622.0

OC-3 155.52

EC-1 51.84

DS3 44.736

DS1 1.544
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Channel support
....................................................................................................................................................................................................................................

Overview This section provides an overview of the channel support provided by
Navis™ Optical PM - NP.

Definition For time division multiplexing equipment, channels represent the time
slots with which information is carried within a digital link or in a
server trail.

Channels are created by Navis™ Optical PM - NP for use during
circuit/trail provisioning. When channels are created for digital links,
depending on the network element capability, alternate channels (to
accommodate the provisioning of different rates of circuits/trails) are
created.

Channel termination
records

Depending on the type of digital link and the terminating network
element type, Navis™ Optical PM - NP creates channel termination
records with a fixed number of channels depending on the channel
type specified during provisioning.

Supported channels The following table presents the channels supported by each network
element supported by Navis™ Optical PM - NP.

Table 5-8 Supported channel types per supported network elements

Network Element STS-192c STS-48c STS-12c STS-3c STS-1 T3 T1

Black Box Y Y Y Y Y Y Y

LambdaUnite MSS Y Y Y Y Y Y —

Metropolis DMX — — Y Y Y Y Y

Metropolis DMXpress — — Y Y Y Y Y

WaveStar BandWidth
Manager

— Y Y Y Y Y —

WaveStar TDM
2.5G/10G

— Y Y Y Y Y —

Creation of channel types Depending on the capability of the terminating network elements,
Navis™ Optical PM - NP creates channel types as specified in the
following table.
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Table 5-9 Channels created per supported digital links

Digital Link Channel types created Number of channels

OC-192 STS-192c 1

STS-48c 4

STS-12c 16

STS-3c 64

STS-1 192

VT1.5 (line side only) 28 x 192

OC-48 STS-48c 1

STS-12c 4

STS-3c 16

STS-1 48

VT1.5 (line side only) 28 x 48

OC-12 STS-12c 1

STS-3c 4

STS-1 12

OC-3 STS-3c 1

STS-1 3

DS3 T3 1

EC-1 STS-1 1

DS1 T1 1
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Provisioning concepts
....................................................................................................................................................................................................................................

Overview This section presents information for provisioning digital links with
Navis™ Optical PM - NP.

Provisioning support Navis™ Optical PM - NP supports the following digital link
provisioning scenarios:

• an unprotected link that connects two supported network
elements.

• an unprotected link that connects one supported network element
and one black box.

• an unprotected link that connects two black boxes.

Note: Each end point network element may be part of a ring.

To provision a digital link, a user would first select two network
elements from the Network Map and then select Configuration >
Digital Link > Add. Because physical connectivities have to exist
before a digital link is provisioned, four main tasks are performed
whenever a user provisions a digital link in Navis™ Optical PM - NP:

1. The digital link is inventoried in Navis™ Optical PM - NP so that
the system can create appropriate channels to provision higher
order trails or circuits.

2. The corresponding ports at the link’s A and Z ends are put
in-service (or verified to be in-service) to enable reporting of
alarms on them.

3. If the digital link is APS protected, the APS protection is verified
by the EMS and the protection switch status data on the
appropriate ports are stored in Navis™ Optical PM - NP.
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Provisioning order action The following order actions are applicable for digital link
provisioning:

• Add (A): used when a digital link is first added to the network
from Navis™ Optical PM - NP. Port provisioning commands will
be generated and sent to the EMS for putting the ports in-service,
if they are not already in-service.

• Disconnect (D): used to delete a digital link from the Navis™

Optical PM - NP database although the link can still physically
exist with the terminations. During the “Disconnect” order,
commands are generated and sent to the EMS to put the ports
“out-of-service”. In Navis™ Optical PM - NP, the “Disconnect”
order will not be processed if there are any “in-effect” or
“pending” higher order trails or PDH circuits that are provisioned
on any of the digital link’s channels.

• In-Effect (IE): used when a digital link is already put in-service
through the EMS or from a local craft terminal and needs to be
inventoried in Navis™ Optical PM - NP. Since the digital link is
already provisioned, the appropriate provisioning commands are
used by the EMS to verify that the ports are put “in-service” and
the APS protection (when specified) exists.

E_Link provisioning Navis™ Optical PM - NP supports the provisioning of E_Links
between the LAN port of a Gigabit Ethernet card or Fast Ethernet
card of a given network element to a black box or equipment. The
E_Link has no specific transport rate value and can not be used as a
server to any clients. Performance monitoring and alarm analysis can
potentially be done using this link. LAN port to LAN port
connections using E_Link is not supported. VCG for Gigabit Ethernet
card and Fast Ethernet card is supported.

User can provision an E_Link using the same Network Map menu
items as they would use to provision a normal digital link. LAN ports
used in E_Link provisioning can either be on a Gigabit Ethernet card
or Fast Ethernet card.

Navis™ Optical PM - NP maintains a history of disconnected E_Links
for a duration set during Navis™ Optical PM - NP installation. In the
absence of an installation set, Navis™ Optical PM - NP will keep the
disconnected link for a period of 24 hours.
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Protection concepts
....................................................................................................................................................................................................................................

Overview This section discusses protection concepts related to digital links.

As noted earlier in this section, digital links can be unprotected or
protected. When protected by another link, it is called automatic
protection switching (APS). Navis™ Optical PM - NP supports 1+1
APS protection. When APS is 1+1, the protection link is dedicated to
the working (service) link and cannot carry preemptible extra traffic.

Automatic protection
switching

Navis™ Optical PM - NP allows users to provision 1+1 linear APS
protected OC-3, -12, -48, or -192 digital links between two network
elements that support the rate or between a network element and a
black box/equipment or between two black boxes. 1+1 linear APS is
supported on DS3/EC1 digital links. APS types include:

UNI: Navis™ Optical PM - NP supports single ended APS digital links.
On the user interface, single ended is called UNI.

BI: Navis™ Optical PM - NP supports dual ended APS digital links.
On the user interface, dual ended is called BI.

Supported protection
types

The following table presents the protection types supported by each
network element supported by Navis™ Optical PM - NP.

Table 5-10 Supported protection types per supported network elements

Network
Element

4F
BLSROC-192

4F
BLSROC-48

2F
BLSROC-192

2F
BLSROC-48

OC-192 OC-48 OC-12 OC-3

Black Box Y Y Y Y 1+1 1+1 1+1 1+1

LambdaUnite
MSS

Y — Y Y 1+1 1+1 1+1 1+1

Metropolis
DMX

— — — — — 1+1 1+1 1+1

Metropolis
DMXpress

— — — — — 1+1 — —

WaveStar
BandWidth
Manager

Y Y Y Y 1+1
(Uni)

1+1
(Uni)

1+1
(Uni)

1+1
(Uni)
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Table 5-10 Supported protection types per supported network elements (continued)

WaveStar
TDM
2.5G/10G

— — Y Y — 1+1 1+1 1+1
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Purpose This section describes the provisioning concepts associated with
connections supported by Navis™ Optical PM - NP.
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Connection support
....................................................................................................................................................................................................................................

Overview This section provides an overview of connections and the support
provided by Navis™ Optical PM - NP.

Definition A circuit provides a service to a customer at a specified rate.
Specifically, a circuit is a concatenation of link connections and
sub-network connections to provide an end-to-end service to a
customer. A circuit is identified by a rate at which the service is
provided. The “rate” of a circuit is defined by ITU and ANSI
standards for SONET and Asynchronous circuit. An SONET trail is
provisioned over SONET link connections and over SONET
cross-connects in Navis™ Optical PM - NP managed network
elements.

A trail, often referred to as a path, can be assignable or non-assignable
depending on the terminating port or based on the sub-structuring of
the port to carry lower order traffic. In Navis™ Optical PM - NP, if
one or both end ports of a trail are asynchronous, or if one or both
end ports are sub-structured to carry lower order traffic, the trail is
called an “assignable” entity. If both end ports are SONET and not
sub-structured to carry low order traffic, then the trail is called as an
“non-assignable” entity. Certain trails, such as STS-192c, STS-48c,
STS-12c, STS-3c, T3, and T1 are always non-assignable. Navis™

Optical PM - NP creates channels for assignable trails in order to
carry the low order trails or asynchronous circuits.

Supported circuit/trail
types

Navis™ Optical PM - NP supports the following circuit/trail types:

• STS-192c

• STS-48c

• STS-12c

• STS-3c

• STS-1

• VT1.5

• T3

• T1

• VCG
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Supported cross-connect
types and rates

This section presents the rates at which cross-connect types are
supported for one-way (O), two-way (T), and broadcast (B) circuits by
Navis™ Optical PM - NP. The network element by itself may support
more rates than are supported with Navis™ Optical PM - NP.

The cross-connect types and rates for each network element supported
by Navis™ Optical PM - NP are shown in the following table.

Table 5-11 Cross-connect types and rates per supported network element

Network Element VT1.5 STS-1 STS-3c STS-12c STS-48c STS-192c

Black box T T T T T T

LambdaUnite MSS - T T T T T

Metropolis DMX T T T T T -

Metropolis
DMXpress

T T T T - -

WaveStar
BandWidth
Manager

- T T T T -

WaveStar TDM
2.5G/10G

- T T T T -

Supported UPSR
protection

This section presents the rates at which UPSR protection is supported
for one-way (O), two-way (T), and broadcast (B) circuits in Navis™

Optical PM - NP.

Note: The network element by itself may support more rates than are
supported with Navis™ Optical PM - NP.

The rates at which UPSR cross-connects are supported by Navis™

Optical PM - NP are shown in the following table.

Table 5-12 UPSR protection supported by Navis™ Optical PM - NP

Network Element VT1.5 STS-1 STS-3c STS-12c STS-48c STS-192c

LambdaUnite MSS - T T T T T

Metropolis DMX T T T T T -

Metropolis
DMXpress

T T T T - -

WaveStar
BandWidth
Manager

- T T T T -
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Table 5-12 UPSR protection supported by Navis™ Optical PM - NP (continued)

Network Element VT1.5 STS-1 STS-3c STS-12c STS-48c STS-192c

WaveStar TDM
2.5G/10G

- - T T T -

Gigabit Ethernet support Navis™ Optical PM - NP supports the provisioning of an E_Link
between a black box and the LAN ports of the network elements that
support Gigabit Ethernet cards. The E_Link can be considered as an
Ethernet digital link with an unspecified signal rate.

Navis™ Optical PM - NP also support the provisioning of a “virtual
concanenation group” (VCG) for the WAN ports of the network
elements that support the Gigabit Ethernet card. As with GbE support,
the VCG can be considered as a virtual concatenation of STS-N using
a grouping concept. The provisioning of STS-Ns used in a VCG is
essentially the same as the provisioning of any other STS-N in Navis™

Optical PM - NP with the exception of port specifications, association
of the STS-N to a VCG, specifying the capacity of the VCG, and of
preserving the port address ordinal symmetry for the “Dual-Ended
VCG.” The capacity can be specified either as rate or number of
STS-Ns in the VCG.

Performance monitoring
support

The Navis™ Optical PM - NP performance monitoring feature is based
on trails and transport connections. Trails must be provisioned by
configuration management on the network elements before
performance monitoring can be started on the Navis™ Optical PM -
NP for the trail.

For performance monitoring, the ITU-T definition of trail is used.
According to the ITU-T definition, two access points delimit a trail,
one at each end of the trail. The trail ends are associated with network
connections. Although performance monitoring is based on a trail, the
monitored points do not have to necessarily be the trail end points.
Supported network elements support performance monitoring on Trail
Termination Points (TTP) and Connection Termination Points (CTP).

Supported trail types are supported at the network element level, from
where the Navis™ Optical PM - NP can obtain and display
performance monitoring data. This assumes that the associated
performance monitors on the trail have been started at the network
element from the EMS.
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Provisioning options Navis™ Optical PM - NP supports the following features for
circuit/trail provisioning:

• Circuit/trail type: two way supported (one-way and broadcast
circuits are not supported).

• Order Type: add, disconnect, rearrange, and virtual disconnect
supported.

• Circuit ID Format: Free, M1400, and Telecordia formats
supported.

• Path Selection: Auto, Partial, and Manual supported.

• Configuration: Point-to-Point (Linear), APS, 1+1 Protection,
bidirectional line switched rings, and unidirectional line switched
rings.

• Routing: supported with exclusion constraints.

• Merging: supported.

• Fault management: supported.

• Performance monitoring: supported.
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Provisioning controls
....................................................................................................................................................................................................................................

Overview This section presents information for provisioning connections with
Navis™ Optical PM - NP. More specialized information pertaining to
particular connection types supported by Navis™ Optical PM - NP can
be found in subsequent sections.

Circuit/trail provisioning
modes

Navis™ Optical PM - NP allows users to provision a circuit/trail in
one of the three modes: auto, manual or partial.

• Auto: Navis™ Optical PM - NP will find a route from the user
specified end ports for the trail and present it to the user for
approval, if requested. In the case of a trail, Navis™ Optical PM -
NP will find the shortest route using the channels from each of
the links in the path.

• Manual: the user can select each link and a channel in the
selected link along the path, and Navis™ Optical PM - NP will
build the layout based on the user selection(s). In the case of a
trail, the user can select each link from the Network Map that
contains one or more channels from the Network Map and can
bring up a display of the Facility Channel List screen showing
only the all the digital links between the two end nodes that
terminate the selected link. Selecting one of the digital links shall
list all the channels in the selected digital link. The user can
select one of the channels from the list. The selected channel
shall automatically get populated in the provisioning screen. In
the case of span of control, the user can select a bridge and
intern select a link which allows user to select any one of the
contained channels.

• Partial: the user picks all the links along the path of the
circuit/trail. The channels within the link are picked by Navis™

Optical PM - NP (broadcast and one-way circuits are exceptions).
In the case of a trail, the user needs to select only the digital
links that are displayed in the Facility Channel List screen.
Navis™ Optical PM - NP will automatically pick an appropriate
channel in the selected digital link and populate it in the
provisioning screen.
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Provisioning controls Navis™ Optical PM - NP provides the following controls, through the
various GUI provisioning screens, to provision connections. A
description of each control is listed.

• Circuit Type: used to specify the circuit type. Valid values are:
Two Way (T). The default value is “two way”.

• Ignore Alarms: when this option is set to “Yes in the “auto”
provisioning mode, Navis™ Optical PM - NP can pick the
channels that are in alarm and put the circuit “in effect” even if
the alarms are present in the circuit path. The default is “No” (do
not ignore alarms for finding the channels and putting the
circuit/trail “in effect”).

• Graphical Layout: when this option is chosen (Yes), Navis™

Optical PM - NP will display the graphical layout for the created
route for approval by the user. The graphical layout shall also be
displayed again when the implementation commands are
successfully sent and the circuit/trail is put “in effect”. The
default is “Yes”.

• Stop at Test Step: allows the user to perform manual testing
after the implementation of the circuit/trail is completed and
before the circuit is put in service (“in effect”). After performing
manual testing, the user can move the provisioning order to the
next step for completion of the provisioning process. The default
is “No.”

• Protection: allows the user to specify if the circuit/trail shall be
protected. The user may specify - Ring Protected, 1+1 Protected,
A End Open, and Z End Open. The user specified selection is
taken in to consideration when finding the path in the “auto”
mode or when validating the layout at the end of provisioning in
the “manual” or “partial” mode. The default is “Unprotected.”

• Quality of Service: an optional field in the provisioning screen
applicable for all circuits/trails including combo rates. The field
is 10 characters long and allows for case-sensitive alphanumeric
’/’, ’-’, ’_’ and blank (single white space) in the middle of a
character string, or all blanks. Users can modify the Quality of
Service field from the “Modify Order Parameters” menu selection
under the “Action” menu in Graphical Layout. The default value
is blank.
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• Customer Priority: an optional field in the provisioning screen
that allows users to set the priority for a service. The value in
this field is only for Navis™ Optical PM - NP users and will not
be used during restoration nor for notifying users on any priority
basis. The Customer Priority is a number up to two digits (0 to
99). Users can modify the Customer Priority field from the
“Modify Order Parameters” menu selection under the “Action”
menu in Graphical Layout. The default value is blank.

• Implement: allows users to instruct Navis™ Optical PM - NP to
implement the circuit/trail immediately when approved or
schedule the provisioning for a later date and time. The allowed
values are “Start Now” or “Schedule”.
If “Start Now” is selected, the implementation commands will be
sent once the layout is approved by the user.
If “Schedule” is selected, another dialog box will be displayed
for the user to enter the date and time when the implementation
commands should be sent to the EMS.

• Comments: an optional field that allows users to enter some free
formatted text pertaining to the circuit/trail.

Specifying path trace
identifiers

Users can specify two path trace identifiers (PTIs) for each trail - one
for A-Z direction and the other for Z-A direction. PTIs can be either a
specific string of up to 62 alphanumeric characters (case sensitive) or
non-specific (system generated 0s or 1s). In order to specify
non-specific byte for the PTIs, the user shall enter the word “NONE”
in the appropriate PTI field(s).

When sending implementation or verification commands, the “pti_t”
(transmitted) and “pti_e” (expected) fields in the data structure shall
be populated as follows:

• For the A end network element, the “pti_t” shall be the value
entered in the PTI for A-Z direction and the “pti_e” shall be the
value entered in the PTI for Z-A direction.

• For the Z end network element, the “pti_t” shall be the value
entered in the PTI for Z-A direction and the “pti_e” shall be the
value entered in the PTI for A-Z direction.

With routing, the user must enter the PTI for all circuit types. The
user can enable or disable the PTI mismatch detection mode
independently from setting the PTI to specific string or to a
non-specific mode.
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The Path Trace ID cannot be left blank when provisioning any type of
STS circuit. If the user intends to leave the Path Trace ID blank, the
user must enter the word NONE (in capitals). Additionally, if the user
wants to send a string of zeros as the Path Trace ID, the user must
enter NULL (in capitals).

Specifying mismatch
detection mode

The user can specify the Mismatch Detection Mode for each trail
provisioned.

The valid values for the Mismatch Detection Mode are: Enable,
Disable or Null.

• Enable: the EMS will turn on the mismatch detection mode.

• Disable: the EMS will turn off the mismatch detection mode.

• Null: used for in-effect circuit orders to instruct the EMS to leave
the mismatch detection mode in its current setting.

Scheduling circuits and
trails for provisioning

Users with administrator privileges can schedule circuits and trails for
provisioning from the Navis™ Optical PM - NP Network Map. Refer
to the Navis™ Optical PM - NP Administration Guide for details.

Y-protected paths Y-protection paths can be viewed as “one half” of a 1+1 UPSR
protected path/circuit. In a 1+1 UPSR protection path, each of the two
network elements at the A-end and the Z-end has a “bridge” and
“selector” function. At each end, the function of the “bridge” is to
split the incoming input signal into two and send them via separate
paths to the other end and the function of the “selector” is to select
one of the two incoming signals from the other end (via the two
separate paths) as its “received” signal.

Y-protection has two types:

• Open-Z Y protection: if only one of the two end network
elements, say A, incorporates the “bridge and selector” functions
and its two outgoing paths terminates at two different network
elements without the “bridge and selector” functions.

• Open-A Y protection: if only the Z end network element
incorporates the “bridge and selector” functions.
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The following figure shows an example of the supported and
non-supported configurations for one-way Y protection.

Figure 5-1 One-way Y-protection configurations
Supported

Protected port is on the transmit side
(one-way transmission)

Not Supported
Protected port is on the receiving side

(one-way transmission)

Protected Port Protected Port

Protected Port

A and Z Open Ended on both sides

Protected Port

Protected Port

Z open end

Z open endA open end

A open end

Section III: Connections
Provisioning controls

Provisioning Concepts

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 5 - 2 9



Provisioning circuits
....................................................................................................................................................................................................................................

Overview This section presents information for the circuit types supported by
Navis™ Optical PM - NP.

STS-1 paths Navis™ Optical PM - NP supports the provisioning of STS-1 paths
(STS1 circuit type) using channels contained in OC-3, -12, -48, -192,
or EC1 digital links subject to the capabilities of the network element.
For the Metropolis DMX and Metropolis DMXpress, STS-1 paths are
channelized to carry one T3 path and/or 28 VT1.5s for all STS-1
paths riding on the OC-192/OC-48/OC-12/OC-3, and EC1digital links.

STS-3c paths Navis™ Optical PM - NP supports the provisioning of STS-3c paths
(STS3C circuit type) using the channels of OC-3, OC-12, OC-48, or
OC-192 links subject to the capabilities of the network element.
STS-3c paths are not channelized. Therefore, the channel type is not
required for STS-3c path.

STS-12c paths Navis™ Optical PM - NP supports the provisioning of STS-12c paths
(STS12C circuit type) using the channels of OC-12, OC-48, or
OC-192 links subject to the capabilities of the network element
involved. STS-12c paths are not channelized. Therefore, the channel
type is not required for STS-12c path.

STS-48c paths Navis™ Optical PM - NP supports the provisioning of STS-48c paths
(STS48C circuit type) using the channels of OC-48 or OC-192 links
subject to the capabilities of the network element involved. STS-48c
paths are not channelized. Therefore, the channel type is not required
for a STS-48c path.

STS-192c paths Navis™ Optical PM - NP supports the provisioning of STS-192c paths
(STS192C circuit type) using OC-192 subject to the capabilities of the
network element involved. STS-192c paths are not channelized.
Therefore, a channel type is not required for a STS-192c path.

VT1.5 paths Navis™ Optical PM - NP supports the provisioning of VT1.5 paths
(VT1.5 circuit type) using channels contained in OC-3, OC-12,
OC-48, OC-192, or EC1 digital links subject to the capabilities of the
network element. For the Metropolis DMX and Metropolis DMXpress
network elements, a VT1.5 path can carry one T1 circuit.
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T3 circuits Navis™ Optical PM - NP supports the provisioning of T3 circuits
using channels contained in OC-3, OC-12, OC-48, OC-192, EC1, or
DS3 digital links subject to the capabilities of the network element. A
T3 path cannot terminate on OC-3, OC-12, OC-48, OC-192, or EC1
ports (a T3 circuit terminates on at least at one end at the logical port
of the DS3 physical port, black box, or equipment).

T1 circuits Navis™ Optical PM - NP supports the provisioning of T1 circuits
using the VT1.5 channels contained in OC-3, OC-12, OC-48, OC-192,
EC1, or DS1 digital link subject to the capabilities of the network
element. A T1 path cannot terminate on OC-3, OC-12, OC-48,
OC-192, or EC1 ports (a T1 circuit terminates on at least at one end
at the logical port of the DS1 physical port, black box, and
equipment.

Co-existence support The following list describes the support for co-existence amongst the
supported circuit types:

• An STS-192c cannot co-exist with STS-48c, STS-12c, STS-3c,
STS-1, VT1.5, or any other path/circuits in the same OC-192.

• An STS-48c can co-exist with STS-12c, STS-3c, STS-1, and
VT1.5 circuits in the same OC-192. An STS-48c cannot co-exist
with STS-12c, STS-3c, STS-1, VT1.5, or any other path/circuit in
the same OC-48.

• An STS-12c can co-exist with STS-3c, STS-1, and VT1.5 circuits
in the same OC-48. An STS-12c cannot co-exist with STS-3c,
STS-1, VT1.5 or any other path/circuit in the same OC-12c.

• An STS-3c cannot co-exist with STS-1, VT1.5, or any other path
circuits in the same OC-3.

Supported circuit
identification formats

This section describes the circuit identifications types supported by
Navis™ Optical PM - NP. At installation time, the user can select one
of three formats for circuit indentification: user-defined free-format,
M.1400, or Telecordia.
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User-defined free-format

The user-defined free-format circuit identification has the following
characteristics:

• Any character string up to 83 characters in length.

• allowable characters include:

- alphanumeric characters (case-sensitive and both upper- and
lower-case characters are allowed).

- Forward slash /

- dash -

- underscore _

- period

- blank

• Tabs are not allowed.

An example of a user-defined free-format circuit ID is: NY1 NY2 T3
0001.

M.1400-specification format

The M.1400 specification format consists of four sub-fields:

• The A Location of the path or circuit

• The Z Location of the path or circuit

• The Type of the path or circuit

• The Identification Number of the path or circuit.

Note: the A Location value will alphabetically precede the Z Location
value by default only if the variable to swap network elements are set
up at installation.

Telecordia circuit id format

The ordering of fields with the Telecordia circuit id format is: ID -
CircuitType - ALocation - ZLocation. This format is a flexible
adaptation for customers with North American and international
networks so that the customer can use either a Telcordia or CNC
scheme in their world-wide operations while retaining the same field
ordering: ID - CircuitType - ALocation - ZLocation or ALocation -
ZLocation - CircuitType - ID.
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The Telecordia format defines the circuit id field as up to 57
characters long of which:

• 7 to 20 characters are assigned to Equipment ID “A.”

• 7 to 20 characters are assigned to Equipment ID “Z.”

• 2 to 10 character are assigned to Circuit Type.

• 1 to 4 characters are assigned to the circuit serial number.

• each field is delimited by the “-” character.

For example, 1-STS12-102/2I1-209/6I1 denotes a STS12 between
locations 102 and 209, where the network elements are ISM
equipment types of 2I1 and 6I1

Circuit ID = Equipment ID “A” + Delimiter + Equipment ID “Z” +
Delimiter + Circuit Type + Delimiter + Circuit Serial Number where:

• Equipment ID “A”: 7 - 20 alphanumeric characters

• Delimiter: 1 character (“-”)

• Equipment ID “Z”: 7 - 20 alphanumeric characters

• Delimiter: 1 character (“-”)

• Circuit Type: 2 - 10 alphanumeric characters

• Delimiter: 1 character (“-”)

• Circuit Serial Number: 1- 4 digits.

Merging circuits Navis™ Optical PM - NP supports the following merge capabilities per
supported circuit type:

• STS-48c paths can only be merged with STS-48c paths.

• STS-12c paths can only be merged with STS-12c paths.

• STS-3c paths can only be merged with STS-3c paths.

• STS-1 paths can only be merged with STS-1 paths.

• VT1.5 paths can only be merged with VT1.5 paths.

• T3 paths can only be merged with T3 paths.

• T1 paths can only be merged with T1 paths.

Rearranging circuits Navis™ Optical PM - NP supports the rearranging of the following
circuit types: STS-48c, STS-12c, STS-3c, STS-1, VT1.5, T3, and T1.
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Time slot assignment The time slot assignment for SONET trails is similar to that of SDH
trails where the concatenation mechanism follows a strict numerical
order. For example, the time slot assignment for four STS-48cs in an
OC-192 begins in time slot 1, 49, 97, 145, respectively.

Any time slot in an OC-192, OC-48, OC-12, and OC-3 can only
occupy one applicable STS-48c, STS-12c, STS-3c, and STS-1 at any
moment.

Delete history Whenever a circuit is rearranged, the data from the previous circuit is
retained in the Navis™ Optical PM - NP database. A circuit that has
been rearranged several times accumulates a large amount of history
information. The delete history script retains only the necessary
history data associated with each circuit and deletes all unnecessary
history data from the database.

The delete history script consists of two parts:

• A script that automatically runs once when upgrading the
database. If you need to refer to any circuits listed in the history
that are not the most recent non-RS, non-RI circuits, you should
print out these circuits before upgrading the database. The delete
history script will delete these circuits from the history during the
upgrade.

• A daily script execution that runs immediately following each
successful daily backup.
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4-ended protection paths
....................................................................................................................................................................................................................................

Overview The 4-Ended Protection path/circuit is sort of an extension of the
3-ended Y Protection path, that is already supported. The 4-Ended
protection maybe used in a configuration with both Open-A and
Open-Z simultaneously in the same path/circuit. The service and
protection path specifications are similar to the Y-Protection case,
except that it necessiates specification of both A-Protection and
Z-Protection location and port, respectively. For the current release,
there’s a restriction for the A-Protection location to be the same as
A-Location, and the Z-Protection location to be the same as
Z-Location.

Support Important! 4-ended protection path provisioning is restricted to
STS-1 rate only (the protection type selection shall not be
available for all rates other than STS-1). Also, Navis™ Optical
PM - NP will restrict the A-Location and Z-Location of the
4-ended protection path to be terminated at a Metropolis® DMX
or the Metropolis® DMXpress only.

The provisioning of 4-Ended protection paths are supported by Navis™

Optical PM - NP. The “4 Ended” protection type exists on the list of
available protection types on the circuit/trail provisioning screen.
When “4 Ended” protection type is selected, “A Protect Location”, “A
Protect Port”, “Z Protect Location”, and “Z Protect Port,” becomes
available as input fields.

The parent (OC-n) ports at both A and Z end of the 4-ended
protection path must form UPSR rings.

Termination location Navis™ Optical PM - NP will restrict the protection path to have the
same terminations as the service path. This shall be achieved by
prepopulating, the value of “A Protect Location” with value of A
Location, and the value of “Z Protect Location” with that of “Z
Location”. Also, the “A Protect Location” and “Z Protect Location”
fields shall be uneditable/disabled.
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Port restrictions For the “4 Ended” protection selection, Navis™ Optical PM - NP
makes sure that the service and protection path pair at each end
terminates either at Main slots, or Function slots in the same function
unit. For each end (A and Z), the terminating pair of ports (service
and protection) should be belonging either to the Main slots(m-1-1
and m-2-1), or to Function slots in the same function unit (e.g - ‘a-1-1
and a-2-1).

Graphical layout Navis™ Optical PM - NP supports a Graphical layout display of the
4-Ended protection path, consistent with (and similar to) current
Graphical layout for 3-ended Y-protected paths.

T1/T3 Circuit Provisioning
in Partial/Auto Mode with
4-Ended Protected STS-1

For T1 or T3 circuit provisioning in either “Auto” or “Partial” mode,
if there is an underlying 4-Ended protected STS-1 path, Navis™

Optical PM - NP shall pick the 4-ended STS-1 as a preferred path.

Figure 5-2 End-to-end Protected VT1.5 Circuit
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Figure 5-3 Segment Protected VT1.5 Circuit
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Section IV: Optical Layers

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information pertaining to
provisioning optical layers with Navis™ Optical PM - NP.
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Optical layer support
....................................................................................................................................................................................................................................

Overview This section describes Navis™ Optical PM - NP’s support for optical
layers.

Optical layer hierarchy The following figure shows the hierarchy of optical layers for
provisioning between DWDMs and SONET network elements or
black boxes.

Terminology The following optical layer-related terms appear within this section.

Figure 5-4 Hierarchy of Optical Layers
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Fixed connection: fixed connections are stored in the Navis™ Optical
PM - NP and used for provisioning. A fixed connection can be
terminated by one or two point(s) of flexibility, the tributary side of a
DWDM network element, a SONET network element or a black box.
It can only be discovered. It is only visible in the ‘trail/channel
selection’ screen.

Paired Fixed Connection: a pair of two fixed connection that share
some common channels.

OCH assignable port: an OCH assignable port terminates an OCH
trail. OCH assignable ports are located either on the SONET network
element, a non-managed network element (Black Box/Equipment), or
on the muxed port of a 10G mux card. The OCH assignable port can
also be referred as a OCH TTP.

OCH non assignable port: any intermediate port of an OCH
connection.

OCH connection: an OCH connection is a end to end optical path.

OCH server: is an OCH that is used to carry other OCH connections
instead of regular client types, such as a digital link.

Optical channel trail: an optical connection that is either assignable
to a digital link or non-assignable. OCh trails can be of two types.
The first type is an OCh trail (assignable OCh trail) that terminates on
an SONET network element or black box at either end in its layout
(does not terminate in a LambdaRouter with a cross-connect or in a
DWDM network element). The second type of OCh trail
(non-assignable) does not fall in to the above category of assignable
OCh trail but may have a termination in a LambdaRouter having a
cross-connect in it or may terminate on both ends of DWDM network
elements.

Point of flexibility: a port that belongs to a LambdaRouter connected
to a DWDM network element via a physical link.

Topological link: in the scope of the optical layer, the topological
links are optical multiplex sections and optical links.
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Provisioning optical layers
....................................................................................................................................................................................................................................

Overview This section describes the provisioning concepts associated with
optical layers.

Provisioning order Important! In order to use the optical layer for provisioning, the
physical connectivities between the optical network elements
must have been established prior to the provisioning of the
optical layers from Navis™ Optical PM - NP.

The following steps are required to provision the different layers in
the optical layer. Provisioning in Navis™ Optical PM - NP is mainly
to provide the inventory, display and correlation of alarms in the
optical layer in addition to some validations by the EMS.

1. The user provisions optical multiplex section (OMS) between two
similar types of DWDM network elements specifying any optical
amplifiers (OA) between them. The OMS provisioning is always
treated in Navis™ Optical PM - NP as a bi-directional section.
Note: The OMS between two Metropolis EON terminals can be
unprotected or 1+1 protected. However, the OMS between two
WaveStar OLS 1.6T terminals can only be unprotected.

2. If there are connectivities from the DWDM network elements to
other SONET network elements or black boxes then the user
provisions an optical link between them specifying the “Client
Service Type” (CST).

3. The optical channel trail is provisioned. When provisioning an
optical channel trail (OCh Trail) the user is required to specify
the client service type the OCh trail will carry.

4. If there are connectivities with SONET network elements or
black boxes to DWDMs, the user can then provision the
conventional SONET digital links between them. If Navis™

Optical PM - NP finds connectivities of the two SONET ports
through the optical layer, it will prompt the user to “insert
Optical Layer” at the time of the digital link’s order completion.
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OMS layer provisioning Navis™ Optical PM - NP supports the provisioning of OMSs between
the optical line sides of two WaveStar OLS 1.6T DWDM network
elements. Navis™ Optical PM - NP provides a cut-through to the
Navis™ Optical EMS-EMS interface for port selection and automatic
population. Navis™ Optical PM - NP checks for the same network
element model type for both ends of the OMS section. The selection
for “OMS” in the Network Map’s Configuration menu is only enabled
if both of the selected network elements are DWDM network
elements of the same type.

The following table summarizes the interworking of DWDMs and
their releases for OMS provisioning. Note: if the user provisions an
OMS between two WaveStar OLS 1.6Ts, the user must select the OA
ports (OA part of network element) on the WaveStar OLS 1.6T. If the
user provisions an OMS between two WaveStar OLS 1.6T or two
EON network elements, the user should select the OMU ports.

Table 5-13 DWDM network elements for OMS provisioning

A/Z End Type/Release No. Z/A End Type/Release No.

Metropolis EON End terminal or ring
terminal (includes
dual-facing)

Metropolis EON End terminal or ring terminal
(includes dual-facing)

WaveStar OLS
1.6T (C-Band)

End terminal, ring or WAD
(Type 1 and 2) terminal
(R6.0 and 6.1)

WaveStar OLS
1.6T (C-Band)

End terminal, ring or WAD
(Type 1 and 2) terminal
(R6.0 and 6.1)

WaveStar OLS
1.6T (L-Band)

End or ring terminal (R6.0
and 6.1)

WaveStar OLS
1.6T (L-Band)

End or ring terminal (R6.0
and 6.1)

Optical amplifiers: during provisioning of an OMS, users can add
optical amplifiers similar to adding regenerators during digital link
provisioning. The list of available optical amplifiers is displayed for
the user to choose. The list of optical amplifiers contains only those
that support the OMS section with the appropriate number of channels
(16 or 40/80). For OMS sections between two WaveStar OLS 1.6T
(C-band) DWDMs, only the C-band optical amplifiers are displayed
for user selection. For an OMS section between two WaveStar OLS
1.6T (L-band) DWDMs, only the L-band optical amplifiers are
displayed for user selection. The order of optical amplifiers determines
their sequence from left to right in the layout in the optical multiplex
section. It is assumed that the optical amplifiers are all bi-directional
providing amplification of the optical signals in both directions of the
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fiber. As with regenerators in digital links, the user shall be allowed to
add or delete optical amplifiers to the optical multiplex section.

C+L band: the C+L Band OLS 1.6T DWDMs provide more
bandwidth (up to 160 wavelengths) over a single fiber. The output of
the C-Band and L-Band WaveStar OLS 1.6T DWDMs are fed in to a
CLSC (C and L band Separator and Combiner) unit that combines all
the 160 wavelengths (80 from C-Band and 80 from L-Band) on a
single fiber. This maximizes the output of each fiber in backbone and
longhaul networks. When repeater stations are needed in long haul
applications, before each Repeater Station, the wavelengths have to be
separated in to the C-band and L-band frequencies and fed in to their
respective Optical Amplifiers and then re-combined for transmission
again. The CLSC unit is a passive device that does not need any
provisioning commands nor does it generate any alarm. However,
when combining a L-band with a C-band system, a parameter has to
be set in the C-band system that tells the C band system that it is
working in conjunction with a L band system. This is required to
adjust some power gain in the C band system. It is not expected that
this parameter is set from Navis™ Optical PM - NP. The following
figure illustrates OMS provisioning between pairs of C-Band and
L-Band DWDMs. For this figure, OLS400G and OLS 1.6T are
interchangeable.

From the Navis™ Optical EMS and Navis™ Optical PM - NP
perspective, the C-band and L-band DWDMs are treated as two
separate network elements. Therefore, the OMS provisioning between

Figure 5-5 OMS provisioning between pairs of C-Band and
L-Band DWDMs
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C+L band DWDMs are treated as two separate OMS sections, one
between two C-band DWDMs and the other between two L-band
DWDMs with their own set of Optical Amplifiers (Regenerators). It is
understood that in case of a fiber break between two C+L Band
systems, Navis™ Optical PM - NP will receive alarms from both C
and L band DWDMs resulting in showing two OMS section failures
even though in reality there is only one fiber break. The functionality
of Navis™ Optical PM - NP is not in any way affected by this
behavior.

Modifying an OMS: users can not modify paths for OMS sections
that are already “in-effect.”

Deleting an OMS: when the user tries to delete an OMS Section
through a Delete Order, the request for deletion shall be denied if
there is at least one OCh Trail (in-effect or pending) that is assigned
to one of the OMS channels.

Optical channel layer
provisioning

Discovery of Fixed Connections: The existence of cross-connections
(associations) between the tributary ports and the logical port derived
from the line port of a DWDM and the client service types of the
established cross-connections in the DWDM network can be
discovered from the response to the cross-connect synchronization
request (for example, “getAllSNCs”) from each DWDM that is
managed by the Navis™ Optical EMS.

The following descriptions for the discovery of fixed connections will
be useful to understand how Navis™ Optical PM - NP uses those fixed
connections during OCh trail provisioning.

1. The discovery process is triggered by Navis™ Optical PM - NP
by a background process and is not triggered by the user.

2. All the OMSs and optical links must have been provisioned,
inventoried and the channel termination records created in
Navis™ Optical PM - NP.

3. Both the cross-connect sync (for Navis™ Optical EMS managed
DWDMs only) and the port sync for the selected DWDM
network elements are previously performed by the user. The
cross-connect synchronization response from Navis™ Optical
EMS will provide the connectivity (association between OTU and
input to OMU/output of ODU, frequency for both directions of
the OCh trail).
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4. For the fixed connections that do not terminate in an optical
translator unit (those trails that have compatible optics at the
SONET network element), it is assumed that the client service
types will be derived from the SONET network element port
addresses or from the client service types of optical links that
terminate on the tributary port of DWDM. In the case of black
boxes at the ends, the fixed connections will be
discovered/provisioned with alternate channels (client service
types). When the user provisions an OCh trail on those
terminating ports, the client service types will have to be
specified.

5. A fixed connection will not have any order number associated.

6. No alarm correlation to fixed connections.

7. Fixed connections:

• are created only by the discovery process and cannot be
provisioned as an entity by the Navis™ Optical PM - NP
user.

• will be automatically deleted from Navis™ Optical PM - NP
if a subsequent discovery does not discover them again or
after a virtual disconnect of OMS.

• will remain in the Navis™ Optical PM - NP when OCh trail
use them or even when an OCh trail using them is deleted.

• are not visible entities for the user but will be indicated in
the selectable entities in the OCh Trail provisioning view.

Navis™ Optical PM - NP allows the user to discover fixed connection
between the following network elements:

Table 5-14 Fixed connections per network element

A-end Z-end Preconditions

SONET network
element/black box

SONET network
element/black box

At least 2 DWDM network elements between
A-end and Z-end.

No LambdaRouter between A-end and Z-end.

DWDM network
element (tributary
side)

DWDM network element
(tributary side)

A-end different from Z-end.

LambdaRouter
(point of
flexibility)

LambdaRouter (point of
flexibility)

A-end different from Z-end

At least 2 DWDM network elements between
A-end and Z-end.
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Table 5-14 Fixed connections per network element (continued)

LambdaRouter
(point of
flexibility)

DWDM network element At least 1 DWDM network element between
A-end and Z-end

No LambdaRouter between A-end and Z-end

LambdaRouter
(point of
flexibility)

SONET network
element/black box

At least two DWDM network elements between
A-end and Z-end.

No LambdaRouter between A-end and Z-end.

Optical link layer
provisioning

The following section describes the provisioning of optical links
between SONET network element or Black Box and DWDM network
elements or between two DWDM network elements.

End nodes for optical link provisioning : a user can provision an
optical link between:

• a SONET network element and a DWDM network element

• two LambdaRouters

• a black box and a DWDM network element

• two DWDM network elements (back to back OLS or between
ORS and an external DWDM network element)

• a SONET network element and a LambdaRouter

• a black box and a LambdaRouter

• a LambdaRouter and a DWDM network element

The Navis™ Optical PM - NP checks the model of the nodes that
terminate the optical link. If the models are not correct, the
provisioning request shall be rejected. The cut-through to the selected
EMS graphical user interface for port selection and automatic
population shall be provided.

Automatic creation of internal optical link in OLS 1.6T through
discovery: When an association exists between the output port of an
optical ring switch (ORS) in a OLS 1.6T that association is reported
to Navis™ Optical PM - NP as a link. Navis™ Optical PM - NP creates
an optical link for this discovered link with a system generated
ckt/trail ID and order number.

Behavior of Navis™ Optical PM - NP when an internal optical link
is removed: if, after an internal optical link is created in Navis™

Optical PM - NP with a ckt/trail ID and order number after a database
synchronization, the optical link is detected to be absent from a
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subsequent dbsync procedure, Navis™ Optical PM - NP does the
following:

• If there is no OCh trail provisioned on the internal optical link,
the optical link shall be deleted fromNavis™ Optical PM - NP
and all the associated records (alarm, PM, if any) are removed
per the existing system behavior. In addition, if optical fixed
connections are discovered with the internal optical link, the
fixed connections are either removed or reconciled by Navis™

Optical PM - NP.

• If an OCh trail is already provisioned on the internal optical link,
this should be treated as an improper disconnect and reported to
the user. The improper disconnect notification shall be on the
internal optical link.

Client service type in the Optical Link provisioning screen: when
provisioning an optical link, depending of the end-node types, a user
will have to populate a ‘client service type’ field in the provisioning
screen. The ‘client service type’ will have to be populated only in the
following cases:

• one end-node of the optical link is a black box and the other
end-node is a LambdaRouter

• one end-node of the optical link is a black box and the other
end-node is a DWDM network element without OTU

• one end-node of the optical link is a LambdaRouter and the other
end-node is a DWDM network element without OTU

Validation of client service type for optical link provisioning:
When provisioning an optical link, the Navis™ Optical Network
Management System performs the following validations:

• If the optical link is provisioned between one SONET network
element and one DWDM network element with OTU, the port
address rate in the SONET network element is the same than
client service type (OTU type) in the DWDM network element.

• If the optical link is provisioned between two DWDM network
elements with OTU (dual-facing Metropolis EON or dual-facing
WaveStar OLS 1.6T), the OTU type in the two DWDM network
elements are the same (same client service type).

Rearrange for Optical Links : the user is not allowed to a rearrange
optical links that are already ‘in-effect’ or ‘pending’ (in IMP step).
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However, the user can modify an optical link in “pending” (in LAY
step).

Optical channel
connection (trail)

provisioning for clients
and servers

This section covers the handling and provisioning of OCh connections
with Navis™ Optical PM - NP for both clients and servers.

Navis™ Optical PM - NP supports the following features for optical
channel connection provisioning:

• protected OCH connection (using ORS in WaveStar OLS 1.6T)
and protection switching.

• OCH over OCH (using 10G mux in WaveStar OLS 1.6T).

• OCH provisioning using fixed connections.

• Routing in Auto mode (including exclude node and exclude link).

• re-arrange for OCH.

• Y-protected OCH connection is supported.

• SNCP on the LambdaRouter is not supported (as it is not
supported by the network element).

Provisioning optical channel connections: The user may have to
provide the following information to provision a new OCH
connection:

• whether it is an OCH server or a regular OCH (client).

• Two end ports.

• the client service type: this is the type of client connection that
will ride on this OCH connection.

• protection type: path protected or not.

• routing mode: manual or auto.

• in manual mode: selection of OCH channels and fixed
connections from the network map as for other connection type.

• in auto mode: selection of a list of node and link to be excluded
(optional).
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OCh protection scenarios for the LambdaRouter 256 and 128
Release 2.0: the following figure provides a sample OCh protection
scenarios for the LambdaRouter 256 and 128.

OCH connection type: The connection type for OCH connections is
“OCH” for a regular OCH and “OCH-S” for an OCH server. This is
also the value in the “type” field of a Circuit ID in the M.1400 circuit
ID format. The “channel type” is “OCH” both connection type.

Figure 5-6 OCh protection scenarios for the LambdaRouter
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Supported operations: Navis™ Optical PM - NP supports the
following operations for the OCH connection type: Add; Disconnect
(include both regular and paper disconnect); Modify (re-arrange).

Map filtering: When an OCH-S is being provisioned, the map should
be filtered to represent OL and OMS. When an OCH is being
provisioned, the map shall be filtered to represent OL, OMS, and
OCH-S.

Mandatory fields: Navis™ Optical PM - NP does not allow the user
to validate the order (“Apply”) unless the following parameters are
filled: connection ID (A and Z location and port ID).

Optional parameters: The following optional parameters exist for
optical channel connection provisioning:

• client service type: mandatory if auto-routing is selected.

• selection of channels: greyed out for auto-routing mode, optional
for manual mode.

• exclude node and links: greyed out for manual mode, optional for
auto-routing mode.

When the ports of an OCH server are selected using the Navis™

Optical PM - NP port table, those ports shall be filtered to display
only the 10G muxed ports.

Protection types: The protection type for OCH provisioning shall be
1+1. By default, the connection shall be left unprotected.

For an OCH server connection, the client service type shall be greyed
out, and the protection type is set to unprotected and greyed out.

OCh trail provisioning involving OLS 1.6T wavelength add/drop
terminals: Navis™ Optical PM - NP allows users to provision an OCh
trail between two WaveStar OLS 1.6T Add/Drop terminals or between
an WaveStar OLS 1.6T Add/Drop terminal and a WaveStar OLS 1.6T
end terminal. In the case of through connections in the wavelength
add/drop terminal or WaveStar OLS 1.6T, the OCh trail will terminate
only at the two end terminals.

The following configurations are possible for OCh trail passing
through or terminating on the WaveStar OLS 1.6T. In the case of an
OCh trail passing through the WaveStar OLS 1.6T WAD terminal, the
through association between the two line ports of the WAD terminal
will be represented as a cross-connect in Navis™ Optical PM - NP and
verified by Navis™ Optical EMS. There is no validation in Navis™
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Optical PM - NP as to which frequencies are added/dropped and
which are pass-through. It is expected that such validations will be
done by Navis™ Optical EMS.

OCh trail provisioning involving WaveStar OLS 1.6T 2 fiber Full
Add/Drop (Ring) Terminals Navis™ Optical PM - NP allows users to
provision an OCh trail through a WaveStar OLS 1.6T 2 Fiber
Add/Drop (Ring) Terminal. In the case of Full Add/Drop terminal, an
OCh trail can either terminate on the drop side OTU port or can pass
through from one line port to the other line port. The following
figures show different configurations of OCh trail that either pass
through the WaveStar OLS 1.6T 2 fiber Full Add/Drop (Ring)
terminal or terminate on the drop side OTU.

In the case of pass through from one line to the other, the
cross-connect from one OMU/ODU pair to the other OMU/ODU pair
is reported to Navis™ Optical PM - NP as a through cross-connect.
The presence of one “through OTU” or two “through OTUs” is
transparent toNavis™ Optical PM - NP. It is also assumed that there is
no frequency interchange in the “through OTUs”. Though the Full
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Add/Drop Terminals are shown in a ring configuration, there is no
protection provided for the OCh trails.

Figure 5-7 OCh trail terminating on the full add/drop (ring)
terminal
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OCh trail provisioning in manual mode: When the user provisions
an OCh trail in the Manual mode, any time the user selects one of the
links corresponding to either Optical Links or OMS, the related Fixed
connections shall be available for selection. Alternately, if the user
selects an Optical Link that is part of a discovered Fixed Connection,
the other links such as OMS channel and the other Optical Link that
are part of the same Fixed Connection shall be automatically chosen
in the Network Map during provisioning (i.e. shown with dashed
lines). The Facility Channel List screen where the link IDs of the
selected link are shown shall also indicate the presence of Fixed
Connections with the A end and Z end and their Client Service Type.

Selection of three ports ended fixed connections: When the user
selects a channel from an OL or an OMS, that is common of two
fixed connections, Navis™ Optical PM - NP displays two fixed
connections to choose from. When the user selects a channel from an
OL or an OMS that is part of only one fixed connection, Navis™

Optical PM - NP will only display that fixed connection for selection.
Alternately, if the user selects a channel that is part of a Fixed
Connection, the other links such as OMS channel and the other
Optical Link that are part of the same Fixed Connection shall be
automatically chosen in the Network Map during provisioning (i.e.
shown with dashed lines).

Figure 5-8 OCh trail passing the intermediate full add/drop (ring)
terminal
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Display the list of selected channels: When a channel that is part of
a fixed connection is selected, then all the channels of this fixed
connections shall be displayed in the link list of the connection. When
a channel that is part of a fixed connection is removed from the link
list of the connection profile form, then all the channels of the fixed
connection shall be removed as well.

OCH channels for an OCH connections: When the OCH connection
is assignable, Navis™ Optical PM - NP will create channels depending
on the OCH type and the client service type:

• for an OCH-S, Navis™ Optical PM - NP will create four OCH
channels should be created. Each channel shall be marked with a
OC-48 client service type.

• In the other cases, Navis™ Optical PM - NP will create one
channel. The client service type of the connection should be used
to mark the OCH channel.

Rearrange an OCH with fixed connections: Navis™ Optical PM -
NP supports rearrange for IE OCH connections. The workflow for
OCH rearrange shall be the same as for other connection types. The
only difference is the channel selection for the new route shall be as
for OCH provisioning, i.e. selection of fixed connection instead of
individual channels. Navis™ Optical PM - NP prevents changing the A
or Z port of the connection. For a route only formed with fixed
connection before and after the re-arrange, Navis™ Optical PM - NP
determines the lists of LambdaRouters where the cross connect has to
be created, deleted, updated or left unchanged. Navis™ Optical PM -
NP creates and deletes the cross connect as determined. For network
elements where the cross connect has to be updated, Navis™ Optical
PM - NP will delete the current cross connect and create a new one
(no bridge and roll). In case of re-arrange of an OCH connection that
is not entirely formed by fixed connection, the re-arrange shall not
attempt to compute the difference between the two routes. All the
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cross connects of the old route shall be deleted and all the cross
connects of the new route shall be created.

Delete an OCH trail: When the user requests to delete an OCH
connection, Navis™ Optical PM - NP will follow the following steps
in the given order. If any step fails, an error will occur and the order
status of this connection shall be updated consequently.

• Check there is no connection client of this OCH.

• Delete the cross connect on each LambdaRouter

• Mark the OCH order as history

Client layer support Provisioning of OC-n digital links if connectivity through the
optical layer is found: when provisioning OC-n (n=3, 12, 48, 192)
digital links, if the selected port on A and/or Z end terminates an OCh
trail, Navis™ Optical PM - NP will verify if there is an end-to-end
connectivity between the A and Z ports of the digital links through the
optical layer. If there is, the layout generation of the OC-n digital link
shall automatically include the optical channel trails. The OCh trail for
the service and protection of 1+1 APS digital link will be included. If
there is no end-to-end connectivity through the optical layer, the
digital link provisioning shall continue without the optical layer.

In the case of provisioning 1+1 APS digital links that span through
optical layer(s), it is possible that the service link and the protection
link can take diverse paths through the optical layer(s). In such cases,

Figure 5-9 Example of an OCH re-arrange
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the layout of the 1+1 APS digital link shall include the layouts of both
service link and the protection link. It is also possible that only
service link or protection link can go through optical layer.

Capability to insert an optical layer into a digital link: in certain
customer applications, an optical layer might be already exist in a
OC-n digital link with complete connectivities but not inventoried in
Navis™ Optical PM - NP. In such cases, the user can provision
“In-Effect” optical links, optical channel trails and OMS sections in
the optical layer. After all the optical layer components are
provisioned in Navis™ Optical PM - NP, a new option in the
Graphical Layout for digital links is provided so as to insert the
optical layer to the digital link.

The “Insert Optical Layer” option is available from the “Action”
menu of the Graphical Layout screen. To insert the optical layer, the
following steps are performed:

1. Navis™ Optical PM - NP will check if the digital link has any
SONET regenerators. If there are, an error message will appear.
If there are no SONET regenerators in the digital link layout,
proceed to step 2.

2. Navis™ Optical PM - NP will then find the connectivity between
the two SONET network elements through the OCh trail. If it
fails to find the connectivity, an error message will appear. If the
connectivity through the optical layer is found, proceed to step 3.

3. If the connectivity through optical layer is found, Navis™ Optical
PM - NP will modify the layout of the digital link inserting the
optical layer and notify the user stating that “the insertion of the
optical layer is successfully completed.”
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4. A pop-up message will appear asking if the user wants to see the
modified Graphical Layout of the digital link after the insertion
of the optical layer.

• If the user chooses “Yes,” the graphical layout of the digital
link showing the optical layer all appear.

• If the user chooses “No,” no action is required and the
pop-up window will close.

• If there is an existing display of the digital link, the “Query
Again” operation after the optical layer is successfully
inserted will display the graphical layout of the digital link
with the optical layer.

5. The Network Map shall be dynamically updated with the
successful completion of the optical layer. The digital link
connectivity shall be appropriately displayed.

In the case of MSP protected digital link, it is not necessary to have
optical layer both in service link and protection link. One of the links
need not go through the optical layer.

No provisioning commands shall be generated during “Insert Optical
Layer” operation. It is the user’s responsibility to set the “Expected
Trace Identifiers” at the appropriate DWDMs from the EMS screens.

Provisioning HSBB and LSBB circuits: Navis™ Optical PM - NP
supports the provisioning of unprotected HSBB and LSBB circuits (no
1+1 or Ring protection). Provisioning is only allowed in “Manual”
mode. Both LSBB and HSBB circuits are allowed to be created only
when both the A and Z ends are black boxes and an OCh trail
terminates on the A and Z end ports. If the connectivity check through
the OCh trail fails, the provisioning of LSBB or HSBB circuit shall
fail with an appropriate error message. No transmission parameters are
required for LSBB or HSBB circuits. However, the order parameters,
such as customer name, priority, Quality of Service will be applicable
to both LSBB and HSBB circuits. Merging of two or more LSBB or
HSBB circuits is not supported.

Section IV: Optical Layers
Provisioning optical layers

Provisioning Concepts

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 5 - 5 7



Optical ring switch
support

An optical ring switch (ORS) circuit pack supports optical channel
protection. An ORS can be added to any WaveStar OLS 1.6T DWDM
network element as an add-on including the existing configuration and
includes a splitter in the transmit direction to bridge the incoming
signal to two output ports and a selector in the receive direction that
selects the better of the two incoming signals from the other direction
from the ODU.
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ONN support
....................................................................................................................................................................................................................................

Overview This section describes the Navis™ Optical PM - NP’s support of the
Optical Network Navigator (ONN).

Definition The ONN is the software and hardware present in the LambdaRouter
network element that performs management functions, such as
configuration management and fault management, on optical
connections across a network of LambdaRouters.

An ONN system consists of a number of ONN modules, each on a
different LambdaRouter.

Terminology The following ONN-related terms appear within this section.

Connection: in the context of the ONN, a signal carried between two
edge ports. Depending on the type of connection (unprotected, 1+1),
the two edgeports may be connected by different ONN paths during
the connection’s lifetime.

1+1 ONN connection: a connection routed by the ONN which has
two paths through the network. If the first path fails, the second path
automatically takes over.

Client service type (CST): the input provided by Navis™ Optical PM
- NP to indicate the bandwidth when provisioning optical links.

Discover route: the process undertaken in configuration management
to determine the route of ONN-created connections in the network
from the cross connections present in the LambdaRouter.

Fixed connection span (FCS): denotes a fixed connection span
established internally by Navis™ Optical PM - NP traversing DWDM’s
with fixed cross connects.

Auto reroute ONN connection: a connection routed by an ONN. If a
failure occurs, along the length of the ONN managed part, the
connection will automatically be rerouted on to another path. This
new path will be computed at the time the failure occurs.

ONN domain: The area of the network that is under the control of the
ONN. Specifically, an ONN domain is a collection of LambdaRouters
and ONNs that are capable of signalling amongst themselves and
maintain neighbor topology data to provide routing and restoration
within that domain. This is helpful for customer wishing to partition
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the ONN network. In this release, only a single ONN domain is
supported by Navis™ Optical PM - NP. Therefore, the system will not
provide a mechanism for the user to specify the ONN domain.
Instead, Navis™ Optical PM - NP prepopulates the ONN domain name
either based on the user’s input during installation or predefines the
ONN domain name as “ONN_DOMAIN.”

Network to network interface (NNI): a network signalling interface
value set against the networkInterfacetype ONN parameter. This port
is available for signaling within the service provider’s transport
network.

Permanent connection (PC): a connection which is routed entirely
over a traditional network.In this mode, the request for service
provisioning is received by the management system which handles
each network element individually.

Soft permanent connection (SPC): an OCH connection that is
partially routed over an ONN network. In this mode, the request for
service provisioning is received by the management system and then
transferred to the signaling control plane to route and establish the
end-to-end service within the domain.

User network interface (UNI): the client signalling interface value set
against the networkInterfacetype ONN parameter. This port is then
able to receive requests for connection creation.

Unprotected ONN connection: a connection routed by an ONN
which has only a single path through the LambdaRouter and will not
automatically reroute after a failure.

Icon for ONN Navis™ Optical PM - NP uses a unique icon to identify that a
LambdaRouter has been associated to an ONN signalling element.
Navis™ Optical PM - NP depicts the ONN on the Network Map as a
square-shaped icon and specifies whether the ONN is active or
inactive. When the ONN icon contains a green square, the ONN is
active. When the icon contains an L-shaped pink shape, the ONN is
inactive.

Navis™ Optical PM - NP enables users to view the icons representing
LambdaRouters associated with the ONN from the legend menu
accessible through the Network Map.

The following table presents the icon for the ONN as it appears on
the Navis™ Optical PM - NP Network Map.
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Table 5-15 Icon for the ONN

The ONN in active (Up) and inactive (Down) mode. “LR” denotes the
LambdaRouter.

Feature description LambdaRouters managed by the Navis™ Optical EMS possess a
signalling element that facilitates automatic routing between similarly
equipped LambdaRouters. The auto-routing between the routers with a
signalling element is managed by the ONN. Navis™ Optical PM - NP
has to interface with the ONN for connection (routing and
implementation) between LambdaRouters and will interface with the
routers through the Navis™ Optical EMS for data synchronization,
alarms and notifications of port parameters, and cross-connects.

Navis™ Optical PM - NP has a direct LAN (TCP/IP) interface to the
ONN located within the network element. Navis™ Optical PM - NP
provides a mechanism to set up this communication via the Network
Map.

Not all LambdaRouters in the network are equipped with the
signalling element. This forces Navis™ Optical PM - NP to manage a
mixture of LambdaRouters with ONN and some without it. The
routing between LambdaRouters is made feasible because of the
capability of LambdaRouters to identify its neighbor by signaling.
Once a LambdaRouter is set up with the signaling capability, the ports
are identified to the ONN that are within its control. The ports have to
be set with network interface type as NNI for network signaling and
UNI to accept connection requests. Navis™ Optical PM - NP has to
inventory these navigable ports based on the allocation from the user.
If user requests a connection involving a LambdaRouter with
navigable port, the source (ingress LambdaRouter) and the sink
(egress LambdaRouter) has to be determined by Navis™ Optical PM -
NP and a connection request has to be made to the ONN. If a
connection request from the user does not involve a LambdaRouter
with navigable ports, the implementation is the same as what exists
currently.

The connections passing through ONN domains are called soft
permanent connections (SPC). The route through the LambdaRouters
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associated with the ONN are determined by the ONN. Navis™ Optical
PM - NP needs to request connections from the ONN or EMS
depending on the category (S/PC) of connection. In addition, Navis™

Optical PM - NP must also maintain the states of the routes of these
SPCs and provide the same to the user accordingly.

Establishing an ONN
communication connection

Navis™ Optical PM - NP interfaces directly with the ONN through
TCP/IP. Navis™ Optical PM - NP will establish a corresponding
number of TCP/IP connections with the corresponding ONN. During a
network element synchronization with the EMS, Navis™ Optical PM -
NP automatically uploads all LambdaRouters. At this time, Navis™

Optical PM - NP is unaware whether the LambdaRouter has a
signalling element (ONN) associated with it. As a result, the
association between Navis™ Optical PM - NP and the ONN is not
done automatically. Instead, the user has to manually add this
association using the ONN configuration management features
available through the Navis™ Optical PM - NP Network Map. Navis™

Optical PM - NP will use the specified session parameters to establish
communication with the ONN. Once communication is established,
the LambdaRouters associated with the ONN are represented on the
Network Map with a icon different from the LambdaRouters with no
ONN association. Refer to the “Icon for ONN” section located at the
beginning of this section for more information.

In addition to the communication IP address, the ONN uses a
signalling IP address as an identifier to establishing connections
during routing. As a result, the session parameters includes a
“Signalling IP Address” parameter that is provided by the user during
ONN session setup. ONN session parameters can be modified from
the Network Map when the session between Navis™ Optical PM - NP
and the ONN is down. The ONN session parameters, along with the
time when the last synchronization was performed, the time when
communication between Navis™ Optical PM - NP and the ONN was
lost, and the time when communication between Navis™ Optical PM -
NP and the ONN was reestablished will be displayed via the ONN
Session Parameters form.

Users can start or stop communication with the ONN by right-clicking
on an ONN icon and selecting “ Start/Stop ONN communication.”
The ONN icon will reflect the color associated with the session status
of “Up” or “Down.” Refer to the “Icon for ONN” section for more
information about the ONN icon.
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Starting an ONN session When the user selects Configuration > ONN Network Elements >
Add from the Navis™ Optical PM - NP Network Map, the ONN
Session Setup form appears. This form enables the user to start a
session with the ONN. After the user provides the session parameters
and clicks OK, Navis™ Optical PM - NP applies the provided session
parameters when establishing a session with the ONN.

Navis™ Optical PM - NP allows the following attributes for ONN
session parameters:

• IP address: how Navis™ Optical PM - NP communicates with
the ONN. Navis™ Optical PM - NP allows for the standard IP
address specifications (nnn.nnn.nnn.nnn n).

• Login: used to establish communication from Navis™ Optical PM
- NP to the ONN. Navis™ Optical PM - NP allows for an
alphanumeric string of up to eight characters.

• Passwd: the password for ONN login. Navis™ Optical PM - NP
allows for an alphanumeric string of up to eight characters.

• Signalling IP address: used by Navis™ Optical PM - NP in all
connection requests to the ONN. Navis™ Optical PM - NP allows
for the standard IP address specifications (nnn.nnn.nnn.nnn n).

Database synchronization ONN port parameters are the port parameters set on the
LambdaRouter ports and utilized by the ONN during the ONN
connection requests from Navis™ Optical PM - NP. Navis™ Optical
PM - NP has to synchronize all ONN port parameters and the route
states of all the ONN SPC connections.

The ONN port parameters are synchronized through a port
synchronization between Navis™ Optical PM - NP and the EMS via
the TMF interface. The only synchronization between Navis™ Optical
PM - NP and the ONN associated with the LambdaRouter is the route
states and the new connections created or deleted from the ONN.

If communication between Navis™ Optical PM - NP and the ONN is
down , and in that time if the ONN has rerouted the traffic on mesh
protected paths or if failures has occurred causing change in route
states, these need to be synchronized with the states of the
connections in the system. Incremental synchronizations to retrieve
only the changes during the loss of communication is not available.

Navis™ Optical PM - NP provides the user the mechanism to
manually trigger synchronizations with the ONN at which time
Navis™ Optical PM - NP will send a request to the ONN to obtain
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route states. In addition, Navis™ Optical PM - NP will sift through the
data retrieved to identify the changes and reflect them in its system.

Modify session
parameters

When a user selects Configuration > ONN Network Element >
Display/Modify from the Network Map, the ONN Session Parameters
form is displayed. This form allows users to modify the ONN session
parameters.

The ONN Session Parameters form contains the following fields for
filtering

• Node name: the name of the ONN network element.

• ONN domain name: the ONN domain the ONN network
element belongs to. This field is prepopulated for this release as
only one ONN domain is supported.

• IP address: how Navis™ Optical PM - NP communicates with
the ONN. Navis™ Optical PM - NP allows for the standard IP
address specifications (nnn.nnn.nnn.nnn n).

• Signalling IP address: used by Navis™ Optical PM - NP in all
connection requests to the ONN. Navis™ Optical PM - NP allows
for the standard IP address specifications (nnn.nnn.nnn.nnn n).

• Session status: indicates whether the session between Navis™

Optical PM - NP and the ONN is “Up” or “Down.”

• Login: used to establish communication from Navis™ Optical PM
- NP to the ONN. Navis™ Optical PM - NP allows for an
alphanumeric string of up to eight characters.

• Passwd: the password for ONN login. Navis™ Optical PM - NP
allows for an alphanumeric string of up to eight characters.

• Sync time: a time stamp indicating the last time when user
successfully completed an ONN Connection sync.

• Outage time: a time stamp indicating when the communication
between Navis™ Optical PM - NP and the ONN was last lost.

• Session start time: indicates when communication between
Navis™ Optical PM - NP and the ONN was last established.
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Route discovery and
management

Route management for OCH-SPC connections is shared between
Navis™ Optical PM - NP and the ONN associated with the ingress
ONN in the path. Navis™ Optical PM - NP identifies only the routes
outside of the ONN domain and the ingress/egress to the ONN
domain. During execution, Navis™ Optical PM - NP sends connection
requests to the ONN associated with the ingress ONN. The ONN
associated with the ingress ONN determines the route within the ONN
domain based on the protection type and constraint criteria specified
by the user and executes the cross connects for the LambdaRouters in
the path.

Automatic re-routing

The ONN has the capability of auto re-routing the ONN managed
section of an OCH-SPC connection depending on the protection type.

• If the protection type is set to “revertive auto re-route,” the ONN
re-routes the path in case of fault and would re-route back to the
original path once the fault has been cleared.

• If the protection type is set to “non-revertive,” the ONN re-routes
the path in case of faults to a different route and the original path
details are deleted.

• If the protection type is set to pre-emptible, the connection has
the lowest priority in the ONN. If a higher priority connection,
such as revertive or non-revertive auto reroute paths, could not
find available resources, a lower priority path can be pre-empted.

Route discovery

Users can build end-to-end routes for OCH-SPC connections through
the Graphical Layout screen: Action > Discover ONN Route. This
selection is disabled for Disconnect Orders.

When user selects Discover ONN Route, Navis™ Optical PM - NP
builds an end-end path using the cross connects received for the
LambdaRouters in the path together with the trails terminating on
those cross connects. The entire route of the OCH-SPC Connection,
with the details of the associated ONN domain, is displayed to the
user.
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Route states

Navis™ Optical PM - NP supports the following route states for
OCH-SPC connections:

• Initial: the route state for an OCH-SPC connection when the
details within the ONN domain are not discovered.

• Actual: the route state for OCH-SPC connection when Navis™

Optical PM - NP successfully builds the end-to-end route.

• Notfound: the route state for OCH-SPC connection when Navis™

Optical PM - NP is unable to build the end-to-end path.

• Stale: the route state applicable for a revertive/nonrevertive
auto-rerouted OCH-SPC connection when the ONN successfully
restores/reroutes the connection.

• ReRouteFailed: the route state applicable for a
revertive/nonrevertive auto-rerouted OCH-SPC connection when
the ONN fails to re-route the connection.

• Preempted: the route state applicable for a pre-emptible
OCH-SPC connection when auto re-routing in the ONN
pre-empts a low priority connection.

Network map views This section discusses network map views for ONN support.

ONN layer view

When the user selects the View > Link View > Optical Layer > ONN
Switch Connection Spans menu item, Navis™ Optical PM - NP
displays on the Network Map all the fixed Connection spans and optic
links based on whether they are:

• allocated and unallocated to the ONN

• terminating on a LambdaRouter or any SONET network element

• not terminating on DWDMs.

Span information

A fixed connection span is an entity created in Navis™ Optical PM -
NP to represent fixed cross connects and does not contain data such as
channels or circuit trail lists. When a link icon is selected and the
right mouse is clicked, a link menu appears and the user can select
View > Optic Layer > Switch Spans NE ID--NE ID _ Span
Information Form to view the Span Information form. Through this
form, Navis™ Optical PM - NP displays the allocation data for all the
optical links and fixed connections spans represented by that link.
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When the user selects the Allocation Information form, from the link
menu of the Switch Span view, Navis™ Optical PM - NP will bring up
the Span Information Form, which contains the following fields:

• A-Port: network level port address for A End

• Z-Port: network level port address for Z End

• ONN Allocated (Y/N): indicates whether the underlying FCS/OL
has been allocated for an ONN

• Spare (Y/N): indicates whether the FCS/OL is available or has
service.

Behavior when a
LambdaRouter is out of

service

When a LambdaRouter associated with an ONN is put in an out of
service state, Navis™ Optical PM - NP sets the session state between
Navis™ Optical PM - NP and the ONN. The color of the ONN icon
on the Network Map reflects the session state. Refer to the “Icon for
ONN” section located at the beginning of this section for more
information.

Behavior when a
LambdaRouter is deleted

When a LambdaRouter associated with an ONN is deleted, Navis™

Optical PM - NP also deletes all associations and data shared between
Navis™ Optical PM - NP and the ONN associated with the
LambdaRouter.

Section V: Optical Network Navigator
ONN support

Provisioning Concepts

....................................................................................................................................................................................................................................

5 - 6 8 Lucent Technologies 365-314-106R1.1
Issue 1, July 2002



Bandwidth allocation feature
....................................................................................................................................................................................................................................

Overview This section describes the provisioning concepts associated with the
bandwidth allocation feature supported by Navis™ Optical PM - NP.

Definition The mechanism involving the creation of ONN parameters that
effectively allocates ports for the ONN from Navis™ Optical PM - NP
is termed bandwidth allocation.

Provisioning connections from Navis™ Optical PM - NP involving the
LambdaRouter can be done via the ONN for SPC connections and via
an EMS otherwise. The provisioning of ONN-SPC connections
through the ONN is only possible with ports under ONN control. The
control of ports in the LambdaRouter must be shared between the
EMS and ONN and the ports must be assigned to belong to the EMS
or ONN. By default, the ports in the LambdaRouter are under the
control of the EMS. A port can be assigned to the ONN by setting the
NetworkInterfaceType ONN port parameter on the LambdaRouter or
ONN. Client service type refers to the type of client rate that can be
carried on the ONN port.

Shared risk group A shared risk group indicates the risk for existing traffic and is
created from Navis™ Optical PM - NP using a mechanism independent
from the allocation process. During the ONN port parameter setup,
Navis™ Optical PM - NP assigns the ONN port to a shared risk group
from the existing shared risk group list.

Setting parameters Navis™ Optical PM - NP currently sets the LambdaRouter’s port
parameters only during provisioning through connection requests to
the EMS. In order to provision ONN (SPC) connections, the ONN
parameter NetworkInterfaceType must have been set prior to
provisioning. Navis™ Optical PM - NP provides a mechanism
independent of provisioning that allows the user to allocate ports for
ONN control from the Network Map during which Navis™ Optical
PM - NP sends TP set up request to LambdaRouter via the EMS for
setting the ONN port parameters. Navis™ Optical PM - NP uses the
same mechanism to enable the user to set the other optional ONN
parameters, namely the client service type and shared risk group.
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Operational methods From Navis™ Optical PM - NP, users can allocate bandwidth for the
ONN using the following two operational methods:

1. Users can allocate ONN client ports. Using this mechanism, the
ONN parameters network interface port type (UNI) and client
service type can be allocated for these ports. Ports that meet the
following criteria are eligible to be allocated using this method:

• Ports in a LambdaRouter/ONN that are completely free with
no associated connections.

• Optical link ports on a LambdaRouter/ONN that are not a
termination port for any fixed connection span between two
LambdaRouters/ONNs.

• Optical link ports on a LambdaRouter/ONN that are a
termination point of optic link between either a
LambdaRouter/ONN and a SONET network element or
between a LambdaRouter/ONN and a black box.

2. Users can allocate ports on the network side. These ports can
only be assigned for the NNI network interface port type. Users
can also assign the shared risk group and client service type
ONN port parameters. Based on the allocation from the user,
Navis™ Optical PM - NP will send port set up requests
(setTPData) to Navis™ Optical EMS for ports at either ends (A
and Z) of the connection. The connections, fixed connection span
and optical link, terminating on ports assigned to the ONN are
reserved for OCH-SPC connections through the ONN domain
and will not be available for other regular connections. Ports
meeting the following criteria come under this method of
allocation:

• Optical link ports on the LambdaRouter/ONN that are
termination ports for any unprotected fixed connection span
between two LambdaRouters or ONNs.

• Optical link ports on the LambdaRouter/ONN that are
termination points of an optical link between two
LambdaRouters or ONNs.

Note: The ports on a LambdaRouter or ONN that are a termination
point of fixed connection spanning between a LambdaRouter/ONN
and a network element are not eligible to be allocated for ONN as
they cannot be utilized for SPC connections.
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Allocating bandwidth by
trails

Whenever a user selects Configuration > ONN Bandwidth Allocation
from the Network Map, Navis™ Optical PM - NP provides a query
box that has two options for allocating bandwidth to the ONN, Ports
and Trails. The Trails option presents all the fixed connection spans
using OMS trails as a carrier terminating on the ONN and optical
links between the ONN from which (de)allocation can be made.

The following options become available if Trails is selected:

• ONN Domain Name: prepopulated with the ONN domain name.

• Trail type: allows the user to select a trail type. Selections
include: OL, OMS, and All (default).

- OL: when the user selects OL trail type and then clicks on a
CircuitId field name, Navis™ Optical PM - NP will provide
a list of the OLs in the system associated between two
LR/ONN.

- OMS: when the user selects OMS trail type and then clicks
on a CircuitId field name, Navis™ Optical PM - NP will
present a selection box with the circuit IDs of all the OMS
trails in Navis™ Optical PM - NP that are a carrier for a
fixed connection span terminating at both ends on LR’s
associated with ONN.

- All: Navis™ Optical PM - NP provides a list of OMS and
OL trails satisfying the criterias mentioned above. Selection
of a CircuitID in the selection box shall automatically
populate the CircuitID field value in the query box.

Allocating bandwidth by
ports

Whenever a user selects Configuration > ONN Bandwidth Allocation
from the Network Map, Navis™ Optical PM - NP provides a query
box that has two options for allocating bandwidth to the ONN: Ports
and Trails. The Ports option presents a list of all allocated ports as
well as unallocated ports eligible for ONN allocation from which
(de)allocation can be made.

When the user clicks on Node in the Ports tab, Navis™ Optical PM -
NP presents a selection box containing names of all LambdaRouters
currently in the system. When a user selects a network element and
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clicks OK, the Bandwidth Allocation form appears, listing the
following types of ONN allocated and unallocated ports:

• Optical link ports within the specified ONN that are completely
free with no associated connections.

• Optical link ports between the ONN that are not termination
ports for any fixed connection span between two ONNs.

• Optical link ports on the ONN that are termination points of an
optic link between an ONN and a network element between an
ONN and black box.

Setting bandwidth for
client ports

From the Bandwidth Allocation form, accessible through the Network
Map, users can view and update previously set ONN paramters for
bandwidth allocation.

The bandwidth allocation form possesses the following fields:

• Network:ClientServiceType: indicates the actual bandwidth
(payload) for the port in the network.

• Network:NetworkInterfaceType: indicates the client/network
interface attribute of the port in the network.

• Allocation Status: specifies the status of the allocation requests
made for the associated ports by the user.

• Manager:ClientServiceType: corresponds the bandwidth set
from the network manager.

• Manager:NetworkInterfaceType: represents the client/network
interface for the port on the network manager.

• Error Description: indicates the cause of failure.
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Provisioning support
....................................................................................................................................................................................................................................

Overview This section discusses the provisioning support provided by the ONN.

Connection types Navis™ Optical PM - NP supports three connection types:
Unprotected, OnePlusOne protection, and Ring protection. These three
protection types are supported in three provisioning modes: Auto,
Manual, and Partial. The user specifies the category of the required
connection, whether the category is a Permanent Connection (PC),
which is not across the NN domain, or a Soft PC (SPC), which
traverses through the NN domain.

Important! These SPC network connections can be made only
after successful completion of direct communication to the ONN
from Navis™ Optical PM - NP and bandwidth allocation of ports
to the ONN. If the user requests a SPC connection, and if Navis™

Optical PM - NP is unable to identify the ingress/egress
LambdaRouters due to the absence of navigable ports,
provisioning will fail. Navis™ Optical PM - NP will not attempt a
SPC connection using available unallocated ports.

Permanent connections

If the category of connection is permanent (PC), the provisioning flow
is same as what exists currently. Manual, Auto and Partial modes will
be supported with ring, OnePlusOne and unprotected connection
types. The bandwidth in LambdaRouters allocated for navigation will
neither be eligible for manual provisioning nor for automatic route
selections by Navis™ Optical PM - NP.

Soft permanent connections

If user specifies a SPC, automatic provisioning with the following
protection types will be available:

• None: unprotected connection where a simple unprotected
network connection is made

• 1+1: where the network connection is protected by dedicated path
capable of switching in case of failure

• Reroute: auto rerouted connections where the ONN
autonomously restores the path on best-effort basis;

Unprotected connections

Unprotected connections can be set to pre-emptible or
non-pre-emptible from Navis™ Optical PM - NP. A unprotected
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pre-emptible path can be pre-empted during revertive/non revertive
auto rerouting when resources are not available.

Auto rerouted protection connections

If the user specifies an auto rerouted protection connection, it can be
further classified based on reroute types as:

• Revertive: where a auto rerouted path can be re instated to the
original path

• Nonrevertive: where a auto rerouted path cannot be re-instated to
its original path

Provisioning an ONN
connection

This section discusses the provisioning of an ONN connection.

Preconditions

The following pre-conditions apply to provisioning an ONN
connection:

• Prior to the ONN connection set up, the user must have
provisioned LambdaRouters associated with the ONN.

• Bandwidth Allocation involving the networkInterfaceType port
parameter must have been completed.

• The session between Navis™ Optical PM - NP and the ONN and
Navis™ Optical PM - NP and Navis™ Optical EMS must be UP.
Server trails OL, OMS, FCS conforming with Navis™ Optical
PM - NP guidelines must have been provisioned.

Provisioning input

When the user selects Configuration > ONN Connections > Add >
OCH from the Network Map, the Circuit Profile Form will appear.
This form allows users to specify input for OCH connection request
through the NN domain.

The following ONN-specific options appear with the Circuit Profile
form:

• Connection Category: preset to SPC (Soft Permanent
Connection). For all other provisioning through Navis™ Optical
PM - NP, this option is set to PC (Permanent Connection).

• Provisioning mode: only auto mode is available.

• Protection types: default is unprotected (None); 1+1 Protection;
Auto Reroute Protection. For 1+1 protection type, the user is not
be prompted for a_protect_location and z_protect_location.
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• Preemptible: if unprotected is selected, the user is provided with
an option to select whether the connection is preemptible. The
allowed values are Y/N. The default value for preemptible is
“N.”

• Reroute type: when an auto reroute protection connection is
selected by the user, the “Reroute Type” option will become
active. This option allows the user to indicate whether the
re-routed connection is revertive or non-revertive. This selection
is available for auto re routed protection type OCH-SPC
connections only.

• Priority: valid values ranges from 0 to 5.

• Routing tab: Navis™ Optical PM - NP provides users a
mechanism to specify one of the following routing constraints :
Explicit Node List: A specific list of all intermediate nodes
(LR/ONN) in the path ordered from source to destination
Exclude Node List: A list of nodes (LR/ONN) that shall be
excluded from the path created.
For a 1+1 OCH SPC connection, Navis™ Optical PM - NP
provides users a mechanism to specify routing constraints:

- Explicit Node List (Service): A specific list of all
intermediate network elements in the service path specified
in order from source to destination.

- Explicit Node List (Protection): A specific list of all
intermediate network elements in the protection path
specified in order from source to destination.

- Exclude Node List: A list of network elements that must be
excluded from the path created. This applies for both service
and protection paths.

Constrained routing

When the user selects Explicit or Exclude Node List constraint for
OCH SPC connection, Navis™ Optical PM - NP provides only the
LambdaRouters associated with the ONN in the included or excluded
list selection box.

For unprotected and auto-rerouted paths, Navis™ Optical PM - NP
supports a maximum of five intermediate network elements in the
explicit node list and a maximum of 15 intermediate network elements
in the exclusive node list.
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For 1+1 connections, Navis™ Optical PM - NP supports a maximum
of five intermediate network elements in the service explicit node list,
a maximum of five intermediate network elements in the protection
explicit node list, and a maximum of 15 intermediate network
elements in the exclusive node list.

Cancel an ONN connection

Navis™ Optical PM - NP allows users to cancel an ONN connections
at LAY, IMP, TST and COI steps. A message indicating the success or
failure status is provided to the user.

Disconnect an ONN connection

Navis™ Optical PM - NP allows the disconnection of InEffect ONN
connections from the Navis™ Optical PM - NP database. A message
indicating the success or failure is provided to the user.
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Network discrepancy
....................................................................................................................................................................................................................................

Overview This section describes the provisioning concepts associated with the
network discrepancy feature supported by the ONN.

Definition Network discrepancy occurs when the network is changed externally
to Navis™ Optical PM - NP.

The route involving ONN connections is shared between Navis™

Optical PM - NP and the ONN. When the ONN-owned section of a
connection is modified or deleted, this results in discrepancies
between Navis™ Optical PM - NP and the ONN.

Causes The following scenarios will cause discrepancies in Navis™ Optical
PM - NP:

• When Navis™ Optical PM - NP establishes SPC paths, by
sending connection requests to the ONN, a route is determined
and cross connects are made on a LambdaRouter by the ONN.
Navis™ Optical PM - NP receives the completion response from
the ONN. Cross connect events on the LambdaRouter are sent by
Navis™ Optical EMS. . These discrepancies gets cleared when
user triggers route discovery for the OCH-SPC connection and
system builds it using these un-correlated cross connects.

• In the case of an auto reroute SPC connection, any failures in the
path manged by an ONN domain triggers a automatic rerouting
in the ONN. Navis™ Optical PM - NP receives cross connects
events from Navis™ Optical EMS, which indicate the disconnects
inventoried as improper disconnects. According to Navis™

Optical PM - NP, they belong to the SPC connection.

• Communication between Navis™ Optical PM - NP and the ONN
is down and when link comes up, the user performs an ONN
Connection synchronization to synchronize all connections
between Navis™ Optical PM - NP and the ONN. Any new
connections created by the ONN during this time will have no
SPC connection request associated with it in Navis™ Optical PM
- NP.

• From Navis™ Optical PM - NP, OCH-SPC connections can be
pre-emptible. This allows the auto rerouted connections to steal
the resources of pre-emptible connections.
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Access When a user selects Configuration > Network Discrepancy > ONN
Connections from the Network Map, the ONN Discrepancy form,
consisting of discrepancies relating to ONN connections, is displayed.

Process When ONN connections are created or disconnected external to
Navis™ Optical PM - NP, ONN connection discrepancies are reported
to the user. This discrepancy is identified in Navis™ Optical PM - NP
either via notifications from the ONN or during an ONN connection
synchronization from Navis™ Optical PM - NP. These are
connections/paths in ONN consisting of cross connects on multiple
LambdaRouters and is different from the existing discrepancies. These
are reported as a independent ONN discrepancy reports to the user.
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Subnet support
....................................................................................................................................................................................................................................

Overview This section presents an overview of Navis™ Optical PM - NP’s
support for subnets (rings).

Definition A ring is a collection of network elements that form a closed loop
where each network element is connected to the adjacent network
element. Supported bidirectional line switched rings (BLSR) and
unidirectional path switched rings (UPSR) provide redundant
bandwidth or equipment to ensure system integrity in the event of any
transmission failure, such as a fiber cut or network element failure.

Support Navis™ Optical PM - NP supports two broad categories of rings:

• bidirectional line switched rings (BLSR).

• unidirectional path switched rings (UPSR).

In addition to the BLSR and UPSR ring types, Navis™ Optical PM -
NP also provides support for virtual rings and subtending rings.

Ring examples The following are examples of ways in which users can create rings.

Two rings sharing all nodes

The below figure illustrates two rings sharing all nodes.

A Z

D

B C

E

Ring One

Ring Two
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Four rings formed by four nodes

The below figure shows four rings formed using the same four
network elements.

Ring names Users can display the names of all link IDs that belong to a specified
ring name through the Network Map.

If a ring is deleted, Navis™ Optical PM - NP will remove the ring
name from the list of ring names. This applies to all ring types.

Protection protocol Navis™ Optical PM - NP will display the ring protection protocol as
reported to it by the EMS.

Timeslots and channels Within each ring, the same timeslot/channel must be used. The same
timeslot/channel rule is applicable to all rings.

Effect of a digital link
disconnection

If the user disconnects a digital link that is part of a ring forming
loop, Navis™ Optical PM - NP will delete the ring and remove the
ring name from the list of ring names. This applies to all ring types.

Deletion criteria Navis™ Optical PM - NP allows for the disconnection of a digital link
even if the digital link is part of a ring loop as long as the ring is not
providing any protection.

A ZB D

C

E

Ring Three

Ring Four

Ring One

Ring Two
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Bidirectional line switched rings
....................................................................................................................................................................................................................................

Overview This section dicusses Navis™ Optical PM - NP’s support for
bidirectional line switched rings (BLSR).

Size limits Navis™ Optical PM - NP supports up to 16 network elements
(including black boxes) to partake in a BLSR.

Note: For Navis™ Optical PM - NP, all the network elements in the
ring will use the same channel/timeslot. This applies to both manual
and automatic path provisioning.

Automatic formation
criteria

Navis™ Optical PM - NP uses the following criteria to automatically
form a BLSR:

• The loop forming OC-N digital links (N = 48, 192) are identical.

• The OC-N loop is closed.

• The loop closing OC-N’s have identical (2-fiber or 4-fiber)
protection group.

• No black boxes are included.

• The connected network elements have BLSR capability at the
OC-N level closing the loop (already enforced by Navis™ Optical
EMS in order to provide the protection group).

• All the network elements in the loop can interwork in a BLSR
forming capacity (already enforced by the Navis™ Optical EMS
in order to provide the protection group). That is, a BLSR can be
automatically formed even if the network elements in the loop
are not homogenous (a mix of network elements are permitted).

Two-fiber rings When OC-N (N = 48 or 192) connectivity is established between two
or more network elements, the protection group of the OC-N’s is
2-fiber, and automatic ring forming pre-requisites are met, Navis™

Optical PM - NP will form a two-fiber BLSR.

With a two-fiber BLSR, one fiber transmits and the other receives.
Both transmission directions of the bidirectional connection travel
through the ring in opposite directions. If the working transmit path at
a given network element is clockwise, then the working receive path
is counterclockwise and vice versa.

For protection against faults, each fiber’s channels are split. The first,
or top half, fibers are assigned as service paths while the second, or
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lower half, fibers are assigned as protection paths. The protection
channels and service channels are not on the same fiber.

Traffic Flow

The following figure shows the traffic flow on a two-fiber ring. With
this figure, note that the path of working traffic transmitting from
Node A to Node D traverses both fibers on the service path, and the
path of protection traffic transmitting from Node D to Node A
traverses both fibers on the protection path.

Example of a fault

The following figure shows that a fault has occurred in the paths from
Node B to Node C. Note how the traffic is re-routed to bypass the

Figure 5-10 Two-Fiber BLSR
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fault so that the traffic still emerges from the destination node from
the expected port.

Four-fiber rings When OC-N (N=48 or 192) connectivity is established between two
or more network elements, the protection group of the OC-N’s is
4-fiber, and automatic ring pre-requisites are met, Navis™ Optical PM
- NP will create a 4-fiber BLSR.

Four-fiber rings are similar to two-fiber rings in function in that they
possess transmit and receive lines. With a four-fiber ring, however,
there are two pairs of transmit and receive lines on each node rather
than a single pair.

Also, the creation of a four-fiber ring is slightly different from that of
a two-fiber ring in that the protection for the digital links have to be
individually provisioned. It is required that the protection digital links
be provisioned between the BandWidth Manager prior to the
provisioning of the working (protected) digital links in creating a
four-fiber ring.

Figure 5-11 Two-Fiber BLSR with Fault
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Protection on a four-fiber rings consists of dedicated fibers for
protection and service so that two fibers are dedicated for service and
two digital links are dedicated for protection.

Traffic Flow

The following figure shows the traffic flow on a four-fiber ring.

Automatic BLSR-forming
network elements

Navis™ Optical PM - NP will automatically form a BLSR using the
following SONET network elements at the OC-N level specified when
the BLSR prerequisites are met.

Table 5-16 Automatic BLSR-forming network elements

Network element Rate BLSR Type

DMX Release 2.0 and 2.1 OC-48/OC-192 Not supported.

DMXpress Release 1.0 OC-48

LambdaUnite MSS OC-48 2 Fiber

OC-192 2 Fiber

Figure 5-12 Four-Fiber BLSR
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Table 5-16 Automatic BLSR-forming network elements (continued)

WaveStar BandWidth Manager OC-48 2 Fiber and 4 Fiber

OC-192 2 Fiber and 4 Fiber

WaveStar TDM 2.5/10G OC-48 2 Fiber

OC-192 2 Fiber

Manual formation criteria The following conditions must be met in order to manually form a
BLSR with Navis™ Optical PM - NP:

• All network elements selected to participate in the 2- or 4-fiber
BLSR must have 2- or 4-fiber BLSR forming capability
respectively.

• At least two network elements have been identified/selected for
creating the ring.

• The digital links connecting the participating network elements
form a closed loop.

• The protection group (if applicable) must be identical on all
network elements.

• The digital links forming the closed loop are of the same level
(they are either all OC-3, OC-12, OC-48 or OC-192).

• The ring to be created does not already exist.

• The network elements selected to participate in the desired ring
are not all black boxes.

Timeslot and channel use In the case of provisioning ring protected paths going through BLSRs:

• Auto path selection: Navis™ Optical PM - NP will automatically
pick the same timeslot/channel of all the service link segments in
the BLSR.

• Manual path selection : once a user selects the timeslot/channel
of the first service link segment in the BLSR, Navis™ Optical
PM - NP will reserve/mark the same timeslot/channel for the rest
service link segments. Navis™ Optical PM - NP will discard any
protection link segment selected by the user.
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Unidirectional line switched rings
....................................................................................................................................................................................................................................

Overview This section dicusses Navis™ Optical PM - NP’s support for
unidirectional line switched rings (UPSR).

Definition A UPSR provides path-level protection for VT1.5 (DMX and
DMXpress) circuits within a physical ring network. The ring is
usually comprised of unprotected lines at the same OC-N rate.

Size limits Navis™ Optical PM - NP supports up to 65 network elements to
participate in a UPSR.

Note: All network elements in the ring use the same channel and
timeslot. This applies to both manual and automatic path provisioning.

Automatic formation
criteria

Navis™ Optical PM - NP uses the following criteria to automatically
form a UPSR:

• An OC-N (N = 3, 12, 48, 192) loop is closed.

• The loop forming digital links are identical in value.

• None of the end loop forming OC-N digital links are in a 1+1
APS, 2-Fiber, or 4-Fiber protection group.

• No black boxes are included.

• The connected network elements have UPSR capability using the
loop closing OC-N links.

• All the network elements in the loop can interwork in a UPSR
capacity within the context of Navis™ Optical PM - NP.

• Only homogenous network elements are allowed in the
automatically forming of an UPSR. Note that Metropolis DMX
and Metropolis DMXpress network elements are considered as
the same network element type when forming a UPSR.

Automatic UPSR-forming
network elements

Navis™ Optical PM - NP can automatically form a UPSR using the
following SONET network elements at the OC-N level specified when
the UPSR prerequisites are met.

Table 5-17 Automatic UPSR-forming network elements

Network element Rate

Metropolis DMX OC-3, OC-12, OC-48, OC-192
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Table 5-17 Automatic UPSR-forming network elements (continued)

Metropolis DMXpress OC-48

Manual UPSR-forming
network elements

Navis™ Optical PM - NP supports the forming of a UPSR for the
following SONET network element at the specified OC-N rate when
the manual ring forming criteria are met.

Table 5-18 Automatic UPSR-forming network elements

Network element Rate

Metropolis DMX OC-3, OC-12, OC-48, OC-192

Metropolis DMXpress OC-48

LambdaUnite MSS OC-12, OC-48

WaveStar BandWidth Manager OC-12, OC-48

WaveStar TDM 2.5G/10G OC-12, OC-48, OC-192

Manual formation criteria The following conditions must be met in order to manually form a
UPSR with Navis™ Optical PM - NP:

• All network elements selected to participate in a UPSR have
UPSR forming capabilities respectively.

• A minimum of two network elements have been selected for
creating the ring.

• The digital links connecting the participating network elements
form a closed loop.

• The digital links forming the closed loop are all of the same level
(all OC-3, OC-12, OC-48, or OC-192).

• The digital links forming the loop are not be members of a 1+1
linear APS, 2-fiber or 4-fiber group.

• The ring to be created does not already exist.

• The network elements selected to participate in the desired ring
are not all black boxes.
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Timeslot and channel use When provisioning a 1+1 protected path that goes through a UPSR,
the following items apply:

• Auto path selection: Navis™ Optical PM - NP will automatically
pick the same timeslot/channel of all the link segments in the
UPSR.

• Manual path selection: the user needs to specify each link
segment in the UPSR as either service or protection. Once the
user selects the timeslot/channel of the first link segment in the
UPSR, Navis™ Optical PM - NP will reserve/mark the same
timeslot/channel for the rest service/protection link segments.
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Subtending rings
....................................................................................................................................................................................................................................

Overview This section describes Navis™ Optical PM - NP’s support for
subtending rings.

Definition A subtending ring is assumed to be associated with a UPSR. In the
following figure, both the single homed subtending ring (R2) and dual
homed subtending ring (R3) is associated with the main UPSR (R1).

Figure 5-13 A typical Metropolis DMX and Metropolis DMXpress
ring topology
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Single homed rings A single homed subtending ring (R2) consisting of Nodes G and A
forms a ‘closed’ loop with the two digital links terminating at Node
A’s function unit with or without the consideration of the main UPSR
(R1). The single homed subtending ring can be formed with the
existing manual (physical) ring forming.

Dual homed rings A dual homed subtending ring is an open ring which allows only a
pair of adjacent nodes in a ring that do not have a link connected. The
two end nodes of a dual homed subtending ring do have a link or
links connected between them. However, any links are assigned to a
main UPSR. There can be additional node(s) in the main UPSR
between the two end nodes of the dual homed subtending ring.

Figure 5-14 Single homed subtending ring example
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In the figure below, the dual homed subtending ring (R3) consisting of
Nodes H, B, and C forms a closed loop only with the consideration of
the main UPSR (R1).

Size limits Navis™ Optical PM - NP supports up to 65 network elements to
participate in a subtending ring.

Note: For Navis™ Optical PM - NP, all the network elements in the
ring will use the same channel/timeslot. This functions is applied to
both manual and automatic path provisioning.

Automatic formation
criteria

Navis™ Optical PM - NP does not support the automatic formation of
subtending rings.

Manual creation Navis™ Optical PM - NP supports manual subtending ring formation
when each network elements is a Metropolis DMX or Metropolis
DMXpress. With the exception of the host network elements, the loop
forming OC-n digital links in each of the Metropolis DMXs or
Metropolis DMXpresses can terminate at the two main slots with the
same level of OC-3/OC-12/OC-48 optical interfaces. In addition, each
port in these slots must configure in the “UPSR port
ProtectionAssociation”.

Figure 5-15 Dual homed subtending ring example
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For the host nodes, the one (the single homed subtending ring) or two
(the dual-homed subtending ring) host nodes must use the function
unit slots with the same OC-n rate and the port in these slots must
configure in the “0x1 port ProtectionAssociation”.

Manual formation criteria The following conditions must be met in order to manually form a
ring with Navis™ Optical PM - NP:

• A minimum of two network elements have been selected for
creating the ring.

• The digital links connecting the participating network elements
form a closed loop.

• The digital links forming the closed loop are all of the same level
(all OC-3, OC-12, OC-48, or OC-192).

• The digital links forming the loop are not be members of a 1+1
linear APS, 2-Fiber or 4-Fiber group.

• The ring to be created does not already exist.

• The network elements selected to participate in the desired ring
are not all black boxes.
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Virtual rings
....................................................................................................................................................................................................................................

Overview This section describes Navis™ Optical PM - NP’s support for virtual
rings.

Definition A virtual ring is usually a main UPSR ring plus at least one adjacent
subtending ring. A network element can belong to more than one
virtual ring. When multiple rings are required to form a virtual ring,
the adjacent rings must share at least one common network element.

Size limits Navis™ Optical PM - NP supports a virtual ring consisting of one
UPSR and up to 15 subtending rings.

Creation criteria The following criteria applies to creating virtual rings:

• Must be manually created.

• For use with UPSR and subtending rings only.

• Within each ring, the same timeslot/channel must be used. The
same timeslot/channel rule is applicable to all rings.

• VT1.5 can ride on STS-1 paths or OC-N (N = 3, 12, 48, 192)
links.

Workflow This section describes a sample workflow of a virtual ring. This
virtual ring is assumed to transverse only rings (R1) and (R2).

Figure 5-16 Sample virtual ring workflow
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1. The user provisions OC-N links and forms a ring. In the figure,
links (a) and (b) with nodes (A) and (B) form ring (R1).

2. Links (c), (d), (e), (f), (g), (h), and (i) with nodes (B), (C), (D),
(E), (F), (G), and (H) form ring (R2) and links (j) and (k) with
network elements (E), (F), and (J) to form ring (R3). It is
assumed that the virtual ring only transverses (R1) and (R2).

3. The user provisions a pair of STS-1s to traverse the main ring
(R2) and at least one subtending ring (s1 from Node A to D) and
(s2 from node A to H). The two STS-1 paths should be
provisioned in opposite directions of the ring (i.e. clockwise and
counter-clockwise) and cannot have any overlapping segments or
links. It is the user’s responsibility to make sure each STS-1 path
of the pair has the same timeslot within the same ring. For
example, if timeslot/channel ″005″ is picked for link (c) and (d)
of (s1) then the user should also pick ″005″ for link (i) of (s2). In
(R1), if timeslot/channel ″003″ is picked for link (a) of (s1) then
the user should also pick ″003″ for link (b) of (s2). Different
rings can have different timeslot/channels.

4. The user forms virtual rings for the STS-1 timeslots only. Navis™

Optical PM - NP will provide a means for allowing the user to
form a virtual ring and select the supported circuit/path rate for
the virtual ring. In the current release, only the STS-1 is
supported. Also,Navis™ Optical PM - NP provide the
available/unmarked timeslots/channels of the specified
circuit/path rate (only STS-1 for the current release) for all links
within each ring. For each ring, the user needs to select one from
the available/unmarked timeslots to be used to carry the STS-1
path in the ring. For example, the virtual ring (VR1) can consist
of nodes (A), (D), (E), (F), (G), and (H) with timeslot 003 in
(R1) and 005 in (R2) respectively. Note that network elements
(B) and (C) are not part of the virtual ring due to the fact that the
STS-1 timeslot is riding on the STS-1 infrastructure paths.

5. For the remaining links in the ring that do not have the STS-1
paths on the selected timeslot, Navis™ Optical PM - NP will
reserve the same timeslot/channel (as user specified) for those
segments of each ring (as user entered) respectively.

Virtual ring creation
examples

This section illustrates the creation of a virtual rings by only one
STS-1 pair and possibly with one additional “express” STS-1 path.
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With the network configuration as shown in the following figure, it is
assumed that Node C is a LambdaUnite, Node D is a WaveStar
BandWidth Manager, and all of the remaining nodes are Metropolis
DMXs. There are three rings in this figure:

• R1: an OC-192 Main UPSR formed by the nine nodes, A through
I.

• R2: an OC-48 “single homed” subtending ring formed by the
four nodes, J, K, L, and host node A.

• R3: an OC-48 “dual homed” subtending ring formed by the three
nodes, M and two host nodes F and G.

The following table summarizes the STS-1 paths (and their associated
time slots) that may have been provisioned for Figure 5-15. These
paths are intended for virtual ring creation and carrying T1/T3 traffic.

Table 5-19 Example STS-1 paths provisioned for the creation of virtual rings

STS-1
Scenario

1st STS-1 (Rings
transversed

2nd STS-1 (Rings
transversed

STS-1 Time Slot in:

Ring 1
(R1)

Ring 2
(R2)

Ring 3
(R3)

VR1 K-J-A-B-C-D-E (R2,
R1)

K-L-A-I (R2, R1) 1 1 -

VR2 K-J-A-B (R2, R1) K-L-A-I (R2, R1) 2 2 -

Figure 5-17 Metropolis DMX configuration with a mixed main
UPSR
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Table 5-19 Example STS-1 paths provisioned for the creation of virtual rings (continued)

VR3 K-J-A-B (R2, R1) K-L-A-I (R2, R1) 3 3 -

VR4 (express) B-C-D-E (R1) None 3 - -

VR5 M-G-H (R3, R1) M-F-E-D-C-B (R3, R1) 192 - 1

VR6 M-G-H (R3, R1) M-F-E (R3, R1) 191 - 2

VR7 K-J-A-B-C-D-E-F-M
(R2, R1, R3)

K-L-A-I-H-G-M (R2, R1,
R3)

4 4 4

VR8 K-J-A-B-C-D-E (R2,
R1)

K-L-A-I-H-G-M-F-E
(R2, R1, R3)

5 5 5

In the following table, which supplements Table 5-19 and Figure 5-15,
columns two to four show the user selection of rings and their STS-1
time slots for virtual ring creation. Column six shows the nodes that
belonged to the successfully created virtual ring. The nodes in column
six enclosed in parenthesis are bypassed by STS-1 paths in the created
virtual ring.

Table 5-20 Example of virtual ring creation

STS-1
Scenario

STS-1 Time Slot Picked Virtual Ring Creation

R1 R2 R3 Y/N Virtual Ring Nodes

VR1 1 1 - Y K-(J-A-B-C-D)-E-F-G-H-I-(A-L)-K

VR2 2 2 - Y K-(J-A)-B-C-D-E-F-G-H-I-(A-L)-K

VR3 and VR4 3 3 - Y K-(J-A)-B-(C-D)-E-F-G-H-I-(A-L)-K

VR5 192 - 1 Y M-(G)-H-I-A-B-(C-D-E-F)-M

VR6 191 - 2 Y M-(G)-H-I-A-B-C-D-E-(F)-M

VR7 4 4 4 Y K-(J-A-B-C-D-E-F)-(M-G-H-I-A-L)-K

VR8 5 5 5 Y K-(J-A-B-C-D)-E-(F-M-G-H-I-A-L)-K

Selecting ring IDs To form a virtual ring, Navis™ Optical PM - NP allows users to select
rings from a list of ring IDs (PSR and subtending rings that already
exist) to form a virtual ring. Each virtual ring consists of at least two
rings which consists of one main UPSR and one or more subtending
rings. Multiple selections of all the required ring IDs for creating a
virtual ring are provided. For virtual ring creation, every listed ring ID
can be selected only once (if selected). In other words, multiple
selections of the same ring ID for the same virtual ring creation is
denied.
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Time slot and channel use Once the virtual ring is created, Navis™ Optical PM - NP reserves the
same timeslot and channel, as the two STS-1 infrastructure paths used,
of the rest of the link segments around the ring (for main and
subtending rings). In other words, Navis™ Optical PM - NP will
enforce the use of the same timeslot/channel in each rings forming the
virtual ring, and the user can not manually select different
timeslots/channel for the paths. Upon a successful creation of a virtual
ring, Navis™ Optical PM - NP will generate a unique name/ID for the
virtual ring.

Deleting a virtual ring Navis™ Optical PM - NP allows users to delete a virtual ring without
deleting the STS-1 paths as long as there are no VT1.5 circuits riding
on the virtual ring. If any of the STS-1 paths that are part of a virtual
ring are deleted, the virtual ring shall be automatically deleted. If any
of the rings forming the virtual ring are deleted, the virtual ring shall
be deleted.

Navis™ Optical PM - NP allows for the disconnection of a STS-1 path
that was used in forming a virtual ring as long as the ring is not
providing any protection to an in-effect or pending path/trail.
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Hairpinning
....................................................................................................................................................................................................................................

Overview In a “hairpinning” topology, low-speed tributary traffic is routed into
Navis™ Optical PM - NP and back out of the system without ever
being placed on the high-speed (OC48 or OC-192) UPSR interfaces.
Hairpinning can be either inter-function group or intra-function group
hairpinning cross-connections.
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Hairpinning connections Important! Hairpinning is only applicable with Metropolis®
DMX network elements.

The following figure illustrates hairpinning connections.

Figure 5-18 Hairpin connections
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Inter-function group
hairpin

Navis™ Optical PM - NP supports two way “inter-function group
hairpin” cross connections between channels on two different ring
interfaces on different function units. In following Figure, for
example, traffic from OC-3 UPSR ring coming into function unit A is
hairpinned to OC-12 UPSR ring in function unit B.

Intra-function group
hairpins

Navis™ Optical PM - NP supports two way “intra-function group
hairpin” cross connection between channels on two different ring
interfaces on the same function unit.

Protection association in
inter/intra function group

hairpins

In Navis™ Optical PM - NP, for inter/intra function group hairpin
crossconects between two different ring interfaces, both pair of ports
at either end must have either ‘0x1’ Protection association or ‘UPSR’
Protection Association (i.e ‘UPSR’ to ‘0x1’ is currently not supported).

Figure 5-19 Inter-function group hairpin
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Pass-through hairpin cross
connect

Navis™ Optical PM - NP supports two way intra-function group
“pass-through hairpin” cross connections between a receive port and a
transmit port on a ring interface channels on same or different ring
interfaces, on the same function unit.

Figure 5-20 Pass-through hairpin
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Section VII: Virtual Concatenation Groups

Overview
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Purpose This section provides conceptual information for virtual concatenation
groups (VCG) as supported by Navis™ Optical PM - NP.
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Virtual concatenation support
....................................................................................................................................................................................................................................

Definition Virtual concatenation is a standards compliant mechanism for
efficiently transporting payloads which do not neatly fit into a
standard SONET-sized container across a SONET network. It works
by distributing the payload across a number of standard SONET
containers, transporting the containers independently across the
network and then reassembling the payload a the other side.

In the network model, virtual concatenation is supported by allowing
a virtually concatenated link connection to be derived from multiple
STS-N connections. Additionally, a new attribute is added to the link
connection to represent the transport mechanism for that link
connection over the server(s) which carry it. This can take the values
of:

• DirectClient: the link connection is carried over a single
connection (all previous link connections have this value).

• InverseMuxScalable: the link connection is carried by an inverse
multiplexing scheme which allows dynamic scaling as the server
connections fail (e.g. virtual concatenation with LCAS).

• InverseMuxFixed: the link connection is carried by an inverse
multiplexing scheme which does not allow dynamic scaling as
the server connections fail (e.g. virtual concatenation without
LCAS).

Feature support The following items apply to virtual concatenation groups as they
relate to Navis™ Optical PM - NP:

• Application of virtual concatenation groups is for Ethernet
transport only.

• An Ethernet card can interwork with another Ethernet card of a
different network element type (example Metropolis DMX and
Metropolis DMXpress).

• Gigabit Ethernet (1GbE) and Fast Ethernet cards are supported.

• Neither a LAN nor WAN port enabling/disabling is performed at
Navis™ Optical PM - NP-level.

• No Ethernet parameter setting for a LAN or WAN port is
performed from the Navis™ Optical PM - NP-level.
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• LAN to WAN associations are unknown and not accounted by
Navis™ Optical PM - NP.

• Navis™ Optical PM - NP does not support the merging of STS-1
circuit/path if any one of the circuits/path to be merged
terminates on a port derived from a VCG port.

• The identification of the link capacity adjustment system (LCAS)
to Navis™ Optical PM - NP is the user’s responsibility.

• Enabling/disabling LCAS across the Navis™ Optical EMS
interface is not supported.

• Its the user’s responsibility to enter the correct required capacity.

• Only two-way STS-1’s can be members of a VCG.

• Any rearrange that results in a change of a VCG end port(s) or a
VCG member’s (STS-1) port contained by a VCG port is not
supported.

• The VCG has to be provisioned before the individual STS
member trails can be provisioned. The variable rate is changed
via the capacity parameter and subsequent adding/removing STS
trail(s).

• Support for single ended VCGs (a VCG in which only one end,
either the “A” or “Z” end, is provided) and dual ended VCGs (a
VCG in which both ends, the “A” and “Z” ends, are specified).

• Ethernet support for LambdaUnite MSS R2.1 (no support for
release 2.0)

• Enabling or disabling LCAS across the southbound interface is
not supported.

Naming conventions Navis™ Optical PM - NP allows up to 83 alphanumeric characters for
a VCG name. The valid characters are alphanumeric characters (A-Z,
a-z and 0-9) plus “/”, “.”, “_”, “-”, and ″ ″ (forward slash, period,
underscore, dash and blank) and is case sensitive. Navis™ Optical PM
- NP will remove all leading and trailing blanks.

Navis™ Optical PM - NP will ensure that the user specified VCG
name is unique within Navis™ Optical PM - NP.
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Adding a VCG The provisioning of a VCG is slightly different from the provision of
other circuits/paths in Navis™ Optical PM - NP in that the
specification of the two end network elements or ports are not always
necessary. That is, a VCG can be provisioned using a single network
element and port since no explicit and direct physical connection is
implied by a VCG. The port(s) specified during VCG provisioning are
WAN ports and have a one-to-one correspondence to a VCG port.

Users must specify the VCG name, capacity, required capacity, and
whether LCAS is applicable. Enabling or disabling can be performed
at either the EMS or network element level since LCAS information
is not currently passed across the Navis™ Optical EMS interface.

Once a VCG has been provisioned and given a VCG name, STS trails
can be provisioned as members of the VCG. During STS trail
provisioning, Navis™ Optical PM - NP is expected to provide the user
with an option to identify the VCG that the STS trail will belong to.
Navis™ Optical PM - NP allows only STS-1 trails to belong to a VCG

Modify a VCG Users can display and modify a VCG from the list of VCGs existing
in Navis™ Optical PM - NP through the Network Map (Configuration
> Virtual Concatenation Group > Display/Modify). Navis™ Optical
PM - NP will present a VCG Query Box which allows filtering of the
list of VCGs based on either the VCG Name, Order Status
with/without Order Action, or A and/or Z Location.

Provisioning with one end
port

Navis™ Optical PM - NP supports the provisioning of a STS trail in
which one or both ends terminate at a VCG capable card. In case of a
single-ended VCG, the other end of the STS trail (not the end that is
derived from the VCG port) should have a STS-1 cross-connect and
should not terminate on a non-SONET (asynchronous) port (e.g. DS3).

VCG selection During STS trail provisioning, once user has selected A and/or Z
node, Navis™ Optical PM - NP will present the user with a list of
VCG names and capacity, associated with the nodes. The VCG field
on the STS trail provisioning screen is only available for the STS-1
rate. The user is able to select only one of the VCGs from the list.

A STS trail in a VCG can have one or both ends terminated on a
VCG capable card. Allowing one end of the STS trail to terminate on
a “plain” SONET port is required to cover the case of an VCG in
which both ends may not be within Navis™ Optical PM - NP domain.
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The following figure shows a single-ended VCG. The second figure
shows the VCG having three STS trail members.

Figure 5-21 A single-ended VCG

Figure 5-22 Members of a single-ended VCG

Figure 5-23 A dual-ended VCG
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STS port constraints Navis™ Optical PM - NP does not allow the provisioning of a STS
trail with one end terminating on an SONET port if the STS trail is to
belong to a dual-ended VCG. In other words, both ends of the STS
trail have to terminate on a VCG port for the STS trail to belong to a
dual-ended VCG. Navis™ Optical PM - NP does not allow the
provisioning of a STS trail with either end terminating on a VCG
port, if the VCG name was not specified.

Deleting a VCG Navis™ Optical PM - NP will deny the deletion of a VCG if the VCG
has member STS trails, be it in-effect or pending. Upon successful
deletion of a VCG, Navis™ Optical PM - NP will remove the VCG
name (no history maintenance is required for a VCG name; the VCG
name can be reused immediately after deletion).

Figure 5-24 Members of a dual-ended VCG
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Virtual concatenation with link capacity adjustment scheme
....................................................................................................................................................................................................................................

Overview This section describes Navis™ Optical PM - NP’s support for virtual
concatenation with a link capacity adjustment scheme (LCAS).

Background LCAS provides a control mechanism to increase or decrease the
capacity of a virtually concatenated link to meet the bandwidth needs
of the application. It also provides a means of removing member links
that have experienced failure.

Bandwidth adjustment Once provisioned, bandwidth adjustment is hitless.

• Bandwidth can be modified under management control while
keeping the virtually concatenated path in service. This will not
be service affecting, and can done by:

- Provisioning additional STS-Ns to be part of the virtually
concatenated path.

- Reducing the number of STS-Ns that are part of the
virtually concatenated path.

• Bandwidth can be modified automatically due to failure of the
STS-Ns whilst keeping the virtually concatenated path in service.

- On failure, the affected STS is disabled until the path has
been restored, at which point it will be re-incorporated into
the STS-N.

- If failure of all but one of the STS paths, the STS path will
be degraded and will be operating at a reduced bandwidth.
If the final STS-N fails then the STS also fails.

• Bandwidth can be protected whilst keeping the virtually
concatenated path in service by provisioning the capacity STS-N
to be greater than the intended maximum capacity needed by the
client service.

- On failure of one or more of the STS-Ns in the VCG,
reducing the capacity of the VCG down to the intended
maximum capacity needed by the client service, the VCG
itself is degraded, however the service itself is still working.

- On failure of one or more STS-Ns in the VCG, reducing the
capacity of the VCG to below that required for the intended
maximum capacity needed by the client service, both the
VCG is degraded and the service itself is degraded.
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Ordinal symmetry For the STS-1-Xv path to operate successfully, the STS-n TTPs over
which it is transmitted must have the same ordinal symmetry at both
ends of the connection.

All STS trails belonging to a VCG have to maintain ordinal symmetry
when both ends of the trail terminate on VCG capable cards. Ordinal
symmetry should not be confused with time slot. Herein, by ordinal
symmetry it is meant the rank order (that is first, second, third, etc.)
of the STS at the VCG port. For example, a user wants to provision
up to 150Mb/s capacity between network element “A” and “Z”. To
achieve the 150Mb/s capacity, three STS-1s have to be provisioned
between “A” and “Z”. Consider the first, second and third STS-1
terminate on “A” at ports “1”, “2” and “3” respectively. To maintain
ordinal symmetry the second STS-1 can only terminates at “Z” on
ports that have higher sequential order than the ″Z″ termination port
for first STS-1. Similarly, the third STS-1 can only terminates at “Z”
on ports that have higher sequential order than the ″Z″ termination
ports for first and second STS-1. On the other hand, if only 50Mb/s
capacity is provisioned from “A” to “Z” any combination is
acceptable since only one STS-1 is provisioned.

The LCAS has the ability to reconstitute the STS-1-Xv based on the
sequence number of each of the STS-Ns, ensuring that the payload of
STS-1-Xv is reconstituted in the right order.

Section VII: Virtual Concatenation Groups
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Virtual concatenation without link capacity adjustment scheme
....................................................................................................................................................................................................................................

Overview This section describes Navis™ Optical PM - NP’s support for virtual
concatenation without a link capacity adjustment scheme (LCAS).

Background Basic virtual concatenation without LCAS enables pipes to be created
in granularities outside of that for standard SONET so as to increase
flexibility in the use of the available bandwidth in the network. The
availability of the pipes is based on the connections that support it.
Any adjustments in size made to the pipes, either automatically due to
failures or manually due to provisioned changes are service affecting.

Bandwidth adjustment Once provisioned, bandwidth adjustment is not hitless.

• To increase the bandwidth, additional STS-Ns can be added,
however, this will be service affecting.

• If a failure of one on the STS-Ns that makes up the STS-1-Xv
occurs, then the STS-1-Xv Path itself fails. This will also be
service affecting.

Ordinal symmetry For the STS-1-Xv path to operate successfully, the STS-n TTP’s over
which it is transmitted must have the same ordinal symmetry at both
ends of the connection.

All STS trails belonging to a VCG have to maintain ordinal symmetry
when both ends of the trail terminate on VCG capable cards. Ordinal
symmetry should not be confused with time slot. Herein, by ordinal
symmetry it is meant the rank order (that is first, second, third, etc.)
of the STS at the VCG port. For example, the user wants to provision
up to 150Mb/s capacity between network element “A” and “Z”. To
achieve the 150Mb/s capacity, three STS-1s have to be provisioned
between “A” and “Z”. Consider the first, second and third STS-1
terminate on “A” at ports “1”, “2” and “3” respectively. To maintain
ordinal symmetry the second STS-1 can only terminates at “Z” on
ports that have higher sequential order than the ″Z″ termination port
for first STS-1. Similarly, the third STS-1 can only terminates at “Z”
on ports that have higher sequential order than the ″Z″ termination
ports for first and second STS-1. On the other hand, if only 50Mb/s
capacity is provisioned from “A” to “Z” any combination is
acceptable since only one STS-1 is provisioned.
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A sequence number is added to the overhead of each of the STS-Ns to
ensure that the payload of the STS-1-Xv is reconstituted in the right
order. If the order of the STS-Ns paths that support the STS-1-Xv
path is not maintained, then the STS-1-Xv path will fail. If a STS-N
has a sequence number that is completely out of the scope of the
STS-1-Xv will be treated the same as if the order has been mixed up
and the STS-1-Xv will fail.
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Section VIII: Shared Risk Groups

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information pertaining to shared risk
groups as supported by Navis™ Optical PM - NP.

Contents
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Shared risk group support
....................................................................................................................................................................................................................................

Definition A shared risk group is an identifier used to indicate risk among fibers
that use the same conduit. All entities that share the same risk can be
grouped into a risk group.

Functionality A shared risk group possesses the following functionality:

• Can be associated with digital links, optical multiplex sections,
and optical links.

• Users are not allowed to modify or delete a shared risk group
identification when it is associated with a digital link, optical
multiplex section, or optical link.

• Cable and conduits are not supported.

• Able to be associated to digital links with IE status.

• Maximum of five shared risk groups can be associated with each
digital link.

Creating shared risk
groups

Navis™ Optical PM - NP allows users to create shared risk groups
through the Network Map (Configuration > Shared Risk Group >
Add). If duplicate risk groups are created, Navis™ Optical PM - NP
rejects the duplication. The Risk Group Add form contains the
following fields:

• Shared Risk Group Name: this alphanumeric string specifies the
shared risk group’s name. A maximum of 83 characters is
allowed.

• Shared Risk Group Id: the number associated with the shared
risk group. Each shared risk group ID contains a two-byte
(unassigned) value = [1...65535].

• Description: used to add comments. The description format is
limited to 32 characters.

Display or modify shared
risk groups

Users can display and modify shared risk groups from the Network
Map (Configuration > Shared Risk Group > Display/Modify). Users
can modify a shared risk group name by simply overwriting it.
However, modifying a shared risk group identification is not allowed
if the shared risk group is already allocated to a digital link or optical
link connection.
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Update shared risk groups Users can update shared risk group IDs by overwriting them and can
also add or modify any comments from the shared risk group list
form. After modifying the IDs, the user can update them through
Action > Update. Updating is not allowed if the shared risk group is
already allocated to a digital link, ONN ports of a FCS, or to an
optical link connection.

Display associated links Users can display the digital links associated with a shared risk group
through the Network Map (from the Shared Risk Group List form,
select Actions > Shared Risk Group > Links Association list).

Deleting shared risk
groups

Users can select a row in the Shared Group List form and then delete
the selected group through the Action > Delete menu item. Users can
not delete a shared risk group if it is already associated with any
digital or optical links.
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6 Network Element Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This chapter presents the port addresses for the network elements
supported by Navis™ Optical PM - NP.

Contents
Section I: Introduction 6-3

Terminology 6-4

Port address structure and components 6-6

Section II: LambdaRouter Port Addresses 6-7

Port identifiers 6-8

Section III: LambdaUnite Port Addresses 6-9

Port identifiers 6-10

Section IV: Metropolis DMX Port Addresses 6-12

Port identifiers 6-13

Section V: Metropolis DMXpress Port Addresses 6-16

Port identifiers 6-17

Section VI: Metropolis EON Port Addresses 6-18

Port identifiers 6-19

Section VII: WaveStar BandWidth Manager Port
Addresses

6-21

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 6 - 1



Port identifiers 6-22
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Section I: Introduction

Overview
....................................................................................................................................................................................................................................

Purpose This section presents an overview of the chapter including a definition
of terms used throughout the chapter and also a description of port
address structure.

Contents
Terminology 6-4

Port address structure and components 6-6

Network Element Port Addresses

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 6 - 3



Terminology
....................................................................................................................................................................................................................................

Overview Generic port addressing allows for a single address structure across all
network elements. This applies to Lucent network elements and other
vendor equipment. With Navis™ Optical PM - NP, the generic port
address is commonly referred to as the external address or network
level address.

Terminology The following terminology applies to the material discussed within
this chapter:

• Entity identifier (EID): the name of a logical or physical port or
a non-port resource in a network element. The EID is the primary
means by which resources within the network elements are
identified in the host-to-host interactions between the network
management system and the element management system. The
EID is often referred to as the internal address.

• External address: the network level address used in Navis™

Optical PM - NP. The external address is sometimes referred to
as the network level address.

• Internal Address: the element level address, which is generally
the ’native’ port address used in the EMS. The internal address is
sometimes referred to as the entity identifier.

• Logical port address: address of a logical channel riding on a
higher-order system; the higher-order system is terminated on a
physical port. A logical port address can also be a lower- order
logical channel, riding on a higher-order logical channel, riding
on a facility that terminates on a physical port.

• Network level address: this format is used for port identification
at the Navis™ Optical PM - NP GUI and also on the Port
Selection screens. The Network Level Address selected by the
user from the Port Selection screen is passed to the NMS-level
via the F-Interface. NLAs also appear in some of the host-to-host
interface messages. The network level address is sometimes
referred to as the external address.

• Physical port address: address of the port that physically
terminates a facility.
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• Protection Group: not visible in Navis™ Optical PM - NP.

• Tributary port: generally refers to the add/drop side of a network
element.
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Port address structure and components
....................................................................................................................................................................................................................................

Overview This section describes the components of a port address.

Generic structure The generic structure of a port address is as follows:

Physical Port Type / Physical Port Location / Logical Address(es)

For a lower-order logical channel riding on a higher-order logical
channel, the generic port address structure is as follows:

Physical Port Type / Physical Port Location / Higher Order Logical
Address - Lower Order Logical Address

Note that [] (brackets) indicates that the selection is contained within
brackets. , (comma) denotes ’or.’ - (hyphen) signifies a range of
numbers. Users may select only one number in the range.

Physical port types The physical port types associated with the generic port addresses are
as follows:

• STS-x = OCx. For example, STS-48c is OC48.

Physical port location The physical port location consists of: Shelf / Slot / Port

If Slot contains only one port, the number one is entered for the port
number.

Logical port location The logical port location consists of:

• Shelf / Slot / Port /higher logical port - lower logical port

• Shelf / Slot / Port /single logical port.

External addresses The external addresses associated with generic port addressing may be
represented through the following form: OCx/m/n/p/h - 1

• x can equal 3, 12, 48, or 192.

• m= mm: physical shelf number

• n=nn: physical slot number

• p: physical port number

• h: high order logical port number

• l: lower order logical port number
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Section II: LambdaRouter Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides conceptual information regarding the external
and internal port addresses for both the physical and logical ports of
the LambdaRouter 256 (2.0) and 128 (2.0). It also discusses the
correlation between the external and internal port addresses.
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section provides the port identifiers for the LambdaRouter 256
(2.0) and 128 (2.0).

Table The following port identifiers are applicable to the LambdaRouter 256
(2.0) and 128 (2.0). Entries enclosed in { } are variables. Fields
enclosed in [] are optional fields.

Table 6-1 Port identifiers for the LambdaRouter 256 (2.0) and 128 (2.0)

Description Entity Identifier Network Level Address

Optical Channel Port
(Transparent Ports)

och-[1-32]-[1-32]-[1-4] OT/och-[1-32]-[1-32]-[1-4]

Optical Link Logical Port
(Transparent Ports)

och-[1-32]-[1-32]-[1-4] OT/och-[1-32]-[1-32]-[1-4]

10G Optical Channel Port
(Opaque Ports)

och-[1-32]-[1-32]-1 OT/och-[1-32]-[1-32]-1

10G Optical Link Logical Port
(Opaque Ports)

och-[1-32]-[1-32]-1 OT/och-[1-32]-[1-32]-1

2.5G Optical Channel Port
(Opaque Ports)

och-[1-32]-[1-32]-[1-2] OT/och-[1-32]-[1-32]-[1-2]

2.5G Optical Link Logical Port
(Opaque Ports)

och-[1-32]-[1-32]-[1-2] OT/och-[1-32]-[1-32]-[1-2]

Note: “Opaque Ports” refer to the case where the LambdaRouter is
used in conjunction with the “OEO 10G/2.5G Optical Interface CP
(OXI10GC or OX12.5GC).
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Section III: LambdaUnite Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section provides the port identifiers for LambdaUnite releases 2.0
and 1.0.
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section presents the port identifiers for LambdaUnite releases 2.0
and 1.0.

Table The following table displays the port addresses for LambdaUnite
releases 2.0 and 1.0.

Table 6-2 Port identifiers for LambdaUnite Release 2.0 and 1.0

Description Entity Identifier Network Level Address

OC-192 Physical Port 1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1

OC192/1-1-#-#-[1-8, 12-19, 21-28, 32-39]-1

STS-192c logical port
on OC-192 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1-1

OC192/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1/192c.1

STS-48c logical port
on OC-192 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1-[1, 49, 97, 145]

OC192/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1/48c.[1-4]

STS-12c logical port
on OC-192 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1-[12n+1 where n=0 to
15]

OC192/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1/12c.[1-16]

STS-3c logical port
on OC-192 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1-[3n+1 where n=0 to
63]

OC192/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1/3c.[1-64]

STS-1 logical port on
OC-192 physical port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1-[1-192]

OC192/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-1/STS1.[1-192]

OC-48 Physical Port 1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]

OC48/1-1-#-#-[1-8, 12-19, 21-28, 32-39]-[1-4]

STS-48c logical port
on OC-48 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]-[1]

OC48/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]/48c.1

STS-12c logical port
on OC-48 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]-[1, 13, 25, 37]

OC48/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]/12c.[1-4]

STS-3c logical port
on OC-48 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]-[3n+1 where n=0
to 15]

OC48/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]/3c.[1-16]
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Table 6-2 Port identifiers for LambdaUnite Release 2.0 and 1.0 (continued)

STS-1 logical port on
OC-48 physical port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]-[1-48]

OC48/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]/STS1.[1-48]

OC-12 Physical Port 1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]

OC12/1-1-#-#-[1-8, 12-19, 21-28, 32-39]-[1-16]

STS-12c logical port
on OC-12 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]-1

OC12/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]/12c.1

STS-3c logical port
on OC-12 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]-[1, 4, 7, 10]

OC12/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]/3c.[1-4]

STS-1 logical port on
OC-12 physical port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]-[1-12]

OC12/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]/STS1.[1-12]

OC-3 Physical Port 1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]

OC3/1-1-#-#-[1-8, 12-19, 21-28, 32-39]-[1-16]

STS-3c logical port
on OC-3 physical
port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]-1

OC3/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]/3c.1

STS-1 logical port on
OC-3 physical port

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]-[1-3]

OC3/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-16]/STS1.[1-3]

GbE Physical Port
(LAN) - ptp

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-[1-4]

LAN/1-1-#-#-[1-8, 12-19, 21-28, 32-39]-[1-4]

GbE Physical Port
(WAN) - ptp

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-v[1-4]

WAN/1-1-#-#-[1-8, 12-19, 21-28, 32-39]-v[1-4]

STS-1 logical port on
GbE Physical Port -
ctp

1-1-#-#-[1-8, 12-19, 21-28,
32-39]-v[1-4] - [1-21]

WAN/1-1-#-#-[1-8, 12-19, 21-28,
32-39]-v[1-4]-[1-21]
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Section IV: Metropolis DMX Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section contains port addresses specific to the Metropolis DMX
network elements.
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section presents the port identifiers for the Metropolis DMX
(2.0/2.1) network elements.

Table This table contains the port addresses for the Metropolis DMX
(2.0/2.1) network elements.

Table 6-3 Port identifiers for Metropolis DMX (2.0/2.1)

Description Entity Identifier Network Level Address

OC-192 (Main) physical
port

main-[1, 2]-1 OC192/m-[1, 2]-1

STS-48c logical port on
OC-192 physical port

m[1, 2]-1-[1, 49, 97, 145] OC192/m-[1, 2]-1/48c.[1-4]

STS-12c logical port on
OC-192 physical port

m[1, 2]-1-[12n+1 for n=0 to
15]

OC192/m-[1, 2]-1/12c.[1-16]

STS-3c logical port on
OC-192 physical port

m[1, 2]-1-[3n+1 for n=0 to 63] OC192/m-[1, 2]-1/3c.[1-64]

STS-1 logical port on
OC-192 physical port

m[1, 2]-1-[1-192] OC192/m-[1, 2]-1/STS1.[1-192]

VT1.5 logical port on
OC-192 physical port

m[1, 2]-1-[1-192]-[1-7]-[1-4] OC192/m-[1, 2]-1/STS1.[1-192]/VT.[1-
7].[1-4]

OC-48 (Main) physical
port

main-[1, 2]-1 OC48/m-[1, 2]-1

STS-48c logical port on
OC-48 physical port

m[1, 2]-1-1 OC48/m-[1, 2]-1/48c.1

STS-12c logical port on
OC-48 physical port

m[1, 2]-1-[1, 13, 25, 37] OC48/m-[1, 2]-1/12c.[1-4]

STS-3c logical port on
OC-48 physical port

m[1, 2]-1-[3n+1 for n=0 to 15] OC48/m-[1, 2]-1/3c.[1-16]

STS-1 logical port on
OC-48 physical port

m[1, 2]-1-[1-48] OC48/m-[1, 2]-1/STS1.[1-48]

VT1.5 logical port on
OC-48 physical port

m[1, 2]-1-[1-48]-[1-7]-[1-4] OC48/m-[1, 2]-1/STS1.[1-48]/VT.[1-
7].[1-4]

OC-48 physical port
(function unit)

fn-[a, b, c, d]-[1, 2]-1 growth-[1,
2]-1

OC48/[a, b, c, d]-[1, 2] -1OC48/g-[1, 2]-1

Section IV: Metropolis DMX Port Addresses Network Element Port Addresses

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 6 - 1 3



Table 6-3 Port identifiers for Metropolis DMX (2.0/2.1) (continued)

STS-48c logical port on
OC-48 physical port

[a, b, c, d, g][1, 2]-1-1 OC48/[a, b, c, d, g]-[1, 2]-1/48c.1

STS-12c logical port on
OC-48 physical port

[a, b, c, d, g][1, 2]-1-[1, 13,
25, 37]

OC48/[a, b, c, d, g]-[1, 2]-1/12c.[1-4]

STS-3c logical port on
OC-48 physical port

[a, b, c, d, g][1, 2]-1-[3n+1 for
n=0 to 15]

OC48/[a, b, c, d, g]-[1, 2]-1/3c.[1-16]

STS-1 logical port on
OC-48 physical port

[a, b, c, d, g][1, 2]-1-[1-48] OC48/[a, b, c, d, g]-[1, 2]-1/STS1.[1-48]

VT1.5 logical port on
OC-48 physical port

group-port-STS1-VTG-VT1.5
[a, b, c, d, g][1,
2]-1-[1-48]-[1-7]-[1-4]

OC48/m-[a, b, c, d, g]-[1,
2]-1/AU.[1-16].[1-3]/TU.[1-7].[1-4]

OC-12 Physical Port
(Function Unit)

fn-[a, b, c, d]-[1, 2]-[1, 2]
growth-[1, 2]-[1, 2]

OC12/[a, b, c, d]-[1, 2] -[1, 2]OC12/g-[1,
2]-[1, 2]

STS-12c logical port on
OC-12 physical port

[a, b, c, d, g][1, 2]-[1, 2]-1 OC12/[a, b, c, d, g]-[1, 2]-[1, 2]1/12c.1

STS-3c logical port on
OC-12 physical port

[a, b, c, d, g][1, 2]-[1, 2]-[1, 4,
7, 10]

OC12/[a, b, c, d, g]-[1, 2]-[1, 2]/3c.[1-4]

STS-1 logical port on
OC-12 physical port

[a, b, c, d, g][1, 2]-[1,
2]-[1-12]

OC12/[a, b, c, d, g]-[1, 2]-[1,
2]/STS1.[1-12]

VT1.5 logical port on
OC-12 physical port

[a, b, c, d, g][1, 2]-[1,
2]-[1-12]-[1-7]-[1-4]

OC12/m-[a, b, c, d, g]-[1, 2]-[1,
2]/STS1.[1-12]/VT.[1-7].[1-4]

OC-3 Physical Port
(Function Unit)

fn-[a, b, c, d]-[1, 2]-[1-4]
growth-[1, 2]-[1-4]

OC3/[a, b, c, d]-[1, 2] -[1-4]OC3/g-[1,
2]-[1-4]

STS-3c logical port on
OC-3 physical port

[a, b, c, d, g][1, 2]-[1-4]-1 OC3/[a, b, c, d, g]-[1, 2]-[1-4]/3c.1

STS-1 logical port on
OC-3 physical port

[a, b, c, d, g][1, 2]-[1-4]-[1-3] OC3/[a, b, c, d, g]-[1, 2]-[1-4]/STS1.[1-
3]

VT1.5 logical port on
OC-3 physical port

[a, b, c, d, g][1,
2]-[1-4]-[1-3]-[1-7]-[1-4]

OC3/[a, b, c, d, g]-[1, 2]-[1-
4]/STS1.[1-3]/VT.[1-7].[1-4]

EC1 (or STS1E) Physical
Port (Function Unit)

[a, b, c, d, g]-[1-12] EC1/[a, b, c, d, g]-[1-12]

STS-1 logical port on
EC1 physical port

[a, b, c, d, g]-[1-12]-1 EC1/[a, b, c, d, g]-[1-12]/STS1.1

VT1.5 logical port on
EC1 physical port

[a, b, c, d, g]-[1-12]-1-[1-7]-[1-
4]

EC1/[a, b, c, d, g]-[1-12]/STS1.1/VT.[1-
7].[1-4]
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Table 6-3 Port identifiers for Metropolis DMX (2.0/2.1) (continued)

DS3 Physical Port
(Function Unit)

[a, b, c, d]-[1-12] D3/[a, b, c, d]-[1-12]

T3 logical port on DS3
physical port

[a, b, c, d, g]-[1-12] D3/[a, b, c, d, g]-[1-12]

DS1 Physical Port
(Function Unit)

[a, b, c, d, g]-[1-7]-[1-4] D1/[a, b, c, d, g]-1/[1-7].[1-4]

T1 logical port on DS1
physical port

[a, b, c, d, g]-1-[1-7]-[1-4] D1/[a, b, c, d, g]-1/[1-7].[1-4]

GbE Physical Port (LAN)
- ptp

[a, b, c, d, g]-[1-2] LAN/[a, b, c, d, g]-[1-2]

GbE Physical Port (WAN)
- ptp

[a, b, c, d, g]-v[1-4] WAN/[a, b, c, d, g]-v[1-4]

STS-1 logical port on
GbE Physical Port
(WAN) - ctp

[a, b, c, d, g]-v[1-4]-[1-21] WAN/[a, b, c, d, g]-v[1-4]-[1-21]
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Section V: Metropolis DMXpress Port Addresses
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section presents the port identifiers for the Metropolis DMXpress
(1.0) network elements.

Table This table contains the port addresses for the Metropolis DMXpress
(1.0) network elements.

Table 6-4 Port identifiers for Metropolis DMXpress (1.0)

Description Entity Identifier Network Level Address

OC-48 (Main) physical
port

main-[1, 2]-1 OC48/m-[1, 2]-1

STS-12c logical port on
OC-48 physical port

m[1, 2]-1-[1, 13, 25, 37] OC48/m-[1, 2]-1/12c.[1-4]

STS-3c logical port on
OC-48 physical port

m[1, 2]-1-[3n+1 for n=0 to 15] OC48/m-[1, 2]-1/3c.[1-16]

STS-1 logical port on
OC-48 physical port

m[1, 2]-1-[1-48] OC48/m-[1, 2]-1/STS1.[1-48]

VT1.5 logical port on
OC-48 (Main) physical
port

m[1, 2]-1-[1-48]-[1-7]-[1-4] OC48/m-[1, 2]-1/STS1.[1-48]/VT.[1-
7].[1-4]

DS3 Physical Port
(Function Unit)

b-1 or g-[1-12] D3b-1 or D3/g-[1-12]

T3 logical port on DS3
physical port

b-1 or g-[1-12] D3b-1 or D3/g-[1-12]

DS1 Physical Port
(Function Unit)

a-[1-4]-[1-4] D1/a-1/[1-4].[1-4]

T1 logical port on DS1
physical port

a-1-[1-4]-[1-4] D1/a-1/[1-4].[1-4]

GbE Physical Port (LAN)
- ptp

d-[1-2] LAN/d-[1-2]

GbE Physical Port (WAN)
- ptp

SlotType-Group-Port d-v[1-4] WAN/d-v[1-4]

STS-1 logical port on
GbE physical port
(WAN) - ctp

group-port-trib (odd port
addresses odd and even port
pair) d-v[1-4]-[1-21]

WAN/d-v[1-4]-[1-21]
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Section VI: Metropolis EON Port Addresses

Overview
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section presents the port identifiers for the Metropolis EON
Release 8.1 network elements.

Note: Optical links terminate at ptp and OCH trails terminate at ctp.

Table The following table displays the port identifiers for the Metropolis
EON Release 8.1 network elements.

Description Port Type Entity Identifier Network Level Address

OMS Line Port
(ptp)

OA (20A, 10A,
0OA)

oline-[1a, 1b, 2a, 2b]/oline-[1a,
1b, 2a, 2b]

OL16c/oline-[1a, 1b, 2a,
2b]/oline-[1a, 1b, 2a, 2b]

Repeater Port
(ptp)

OA oline-[1a, 1b, 2a, 2b]/oline-[1a,
1b, 2a, 2b]

OL16c/oline-[1a, 1b, 2a,
2b]/oline-[1a, 1b, 2a, 2b]

OCH Trail
Logical Port on
OMS Line (ctp)

OA oline-[1a, 1b, 2a, 2b]/oline-[1a,
1b, 2a, 2b]-zzzz

OL16c/[1a, 1b, 2a,
2b]/oline-[1a, 1b, 2a, 2b]-zzzz

OTPM (Quad
OTUs)

OTPM (ptp) otpm-[1, 2]-[1, 3, 5, 7, 9, 11,
13, 15, 17, 19, 21, 23, 25, 27,
29, 31]-[1-4]-1

OT/otpm-[1, 2]-[1, 3, 5, 7, 9,
11, 13, 15, 17, 19, 21, 23, 25,
27, 29, 31]-[1-4]-1

OTPM (ctp) optm-[1, 2]-[1, 3, 5, 7, 9, 11,
13, 15, 17, 19, 21, 23, 25, 27,
29, 31]-[1-4]-1-zzzz

OT/otpm-[1, 2]-[1, 3, 5, 7, 9,
11, 13, 15, 17, 19, 21, 23, 25,
27, 29, 31]-[1-4]-1-zzzz

OTU OTU (ptp) otu-[1, 2]-[1-32]-1 OT/otu-[1, 2]-[1-32]-1

OTU (ctp) otu-[1, 2]-[1-32]-1-zzzz OT/otu-[1, 2]-[1-32]-1-zzzz
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OUPSR (Ring
and End
Terminal)

OUPSR (ptp) oupsr-[shelf]-[slot]-[port]

oupsr-[1,2]-[1-32]

Note 1: The three bidirectional
ports of the OUPSR may be
interpreted as: C is the
’reliable’ port and A/B are the
’working’ and ’protecting’
ports.

Note 2: CIN represents
bidirectional port CIN/COUT.
Similarly, AIN and BIN are
bidirectional ports.

OT/oupsr-[shelf]-[slot]-[port]

OT/oupsr-[1,2]-[1-32]

OUPSR (ctp) oupsr-[shelf]-[slot]-[port]-1

oupsr-[1,2]-[1-32]-1

OT/oupsr-[shelf]-[slot]-[port]-1

OT/oupsr-[1,2]-[1-32]-1
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Section VII: WaveStar BandWidth Manager Port Addresses
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section presents the port identifiers for the WaveStar BandWidth
Manager (BWM).

Address format The format for the WaveStar BandWidth Manager addresses are as
follows:

<bay>-<Shelf>-<Protection group#>-<w/p>-<slot>-<port>

Important! The Protection group# and the w/p are not used.
Enter the # character for both of these.

Table This table contains the port addresses for the WaveStar BandWidth
Manager.

Table 6-5 Port identifiers for the WaveStar BandWidth Manager

Description Entity Identifier Network Level Address

OC-192 physical port [1-99]-[1-2]-#-#-tr[1-4]-1 OC192/[1-99]-[1-2]-#-#-tr[1-4]-1

STS-48c logical port on
OC-192 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1, 49, 97,
145]

OC192/[1-99]-[1-2]-#-#-tr[1-4]-
1/48c.[1-4]

STS-12c logical port on
OC-192 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[12n+1
where n=0 to 15]

OC192/[1-99]-[1-2]-#-#-tr[1-4]-
1/12c.[1-16]

STS-3c logical port on
OC-192 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[3n+1 where
n=0 to 63]

OC192/[1-99]-[1-2]-#-#-tr[1-4]-
1/3c.[1-64]

STS-1 logical port on
OC-192 physical port

[1-99]-[1-2]-#-#-tr[1-4]-1-[1-192] OC192/[1-99]-[1-2]-#-#-tr[1-4]-
1/STS1.[1-192]

OC-48 physical port [1-99]-[1-2]-#-#-[02, 04, 06.....16]-1 OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1

STS-48c logical port on
OC-48 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1]

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/48c.1

STS-12c logical port on
OC-48 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1, 13, 25, 37]

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/12c.[1-4]

STS-3c logical port on
OC-48 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[3n+1 where n=0 to 15]

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/3c.[1-16]

STS-1 logical port on
OC-48 physical port

[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1-[1-48]

OC48/[1-99]-[1-2]-#-#-[02, 04,
06.....16]-1/STS1.[1-48]

OC-12 Physical Port [1-99]-[1-2]-#-#-[01-16]-[1-2] OC12/[1-99]-[1-2]-#-#-[01-16]-[1-2]
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Table 6-5 Port identifiers for the WaveStar BandWidth Manager (continued)

STS-12c logical port on
OC-12 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-[1] OC12/[1-99]-[1-2]-#-#-[01-16]-
[1-2]/12c.[1]

STS-3c logical port on
OC-12 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-[1, 4, 7,
10]

OC12/[1-99]-[1-2]-#-#-[01-16]-
[1-2]/3c.[1-4]

STS-1 logical port on
OC-12 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-2]-[1-12] OC12/[1-99]-[1-2]-#-#-[01-16]-
[1-2]/STS1.[1-12]

OC-3 Physical Port (for
SONET Gateway)

[1-99]-[1-2]-#-#-[01-16]-[1-4] OC3/[1-99]-[1-2]-#-#-[01-16]-[1-4]

STS-3c logical port on
OC-3 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-4]-[1] OC3/[1-99]-[1-2]-#-#-[01-16]-[1-
4]/3c.1

STS-1 logical port on
OC-3 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-4]-[1-3] OC3/[1-99]-[1-2]-#-#-[01-16]-[1-
4]/STS1.[1-3]

EC1 and STS1E Physical
Port

[1-99]-[1-2]-#-#-[01-16]-[1-8] EC1/[1-99]-[1-2]-#-#-[01-16]-[1-8]

STS-1 logical port on
EC1 physical port

[1-99]-[1-2]-#-#-[01-16]-[1-8]-1 EC1/[1-99]-[1-2]-#-#-[01-16]-[1-
8]/STS1.1

DS3 Physical Port [1-99]-[1-2]-#-#-[01-16]-[1-8] D3/[1-99]-[1-2]-#-#-[01-16]-[1-8]

T3 logical port on DS3
physical port

[1-99]-[1-2]-#-#-[01-16]-[1-8] D3/[1-99]-[1-2]-#-#-[01-16]-[1-8]
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Port identifiers
....................................................................................................................................................................................................................................

Overview This section presents the port identifiers for the WaveStar TDM
2.5G/10G (6.0) network elements.

Table The following table displays the port addresses for the WaveStar TDM
2.5G/10G (6.0) network elements.

Table 6-6 Port identifiers for WaveStar TDM 2.5G/10G (6.0)

Description Entity Identifier Network Level Address

OC-192 Physical Port 1-2-#-#-[tre, trw]-1 OC192/1-2-#-#-[tre, trw]-1

STS-48c logical port
on OC-192 physical
port

1-2-#-#-[tre, trw]-1-[1, 49, 97,
145]

OC192/1-2-#-#-[tre, trw]-1/48c.[1-4]

STS-12c logical port
on OC-192 physical
port

1-2-#-#-[tre, trw]-1-[12n+1
where n=0 to 15]

OC192/1-2-#-#-[tre, trw]-1/12c.[1-16]

STS-3c logical port
on OC-192 physical
port

1-2-#-#-[tre, trw]-1-[3n+1
where n=0 to 63]

OC192/1-2-#-#-[tre, trw]-1/3c.[1-64]

STS-1 logical port on
OC-192 physical port

1-2-#-#-[tre, trw]-1-[1-192] OC192/1-2-#-#-[tre, trw]-1/STS1.[1-192]

OC-48 Physical Port [1-4]-[1-3]-#-#-[02, 04,
06....16]-1

OC48/[1-4]-[1-3]-#-#-[02, 04, 06....16]-1

STS-48c logical port
on OC-48 physical
port

[1-4]-[1-3]-#-#-[02, 04,
06....16]-1-1

OC48/[1-4]-[1-3]-#-#-[02, 04,
06....16]-1/48c.1

STS-12c logical port
on OC-48 physical
port

[1-4]-[1-3]-#-#-[02, 04,
06....16]-1-[1, 13, 25, 37]

OC48/[1-4]-[1-3]-#-#-[02, 04,
06....16]-1/12c.[1-4]

STS-3c logical port
on OC-48 physical
port

[1-4]-[1-3]-#-#-[02, 04,
06....16]-1-[3n+1 where n=0
to 15]

OC48/[1-4]-[1-3]-#-#-[02, 04,
06....16]-1/3c.[1-16]

STS-1 logical port on
OC-48 physical port

[1-4]-[1-3]-#-#-[02, 04,
06....16]-1-[1-48]

OC48/[1-4]-[1-3]-#-#-[02, 04,
06....16]-1/STS1.[1-48]

OC-12 Physical Port [1-4]-[1-3]-#-#-[01-16]-[1-2] OC-12/[1-4]-[1-3]-#-#-[01-16]-[1-2]
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Table 6-6 Port identifiers for WaveStar TDM 2.5G/10G (6.0) (continued)

STS-12c logical port
on OC-12 physical
port

[1-4]-[1-3]-#-#-[01-16]-[1-2]-1 OC12/[1-4]-[1-3]-#-#-[01-16]-[1-2]/12c.1

STS-3c logical port
on OC-12 physical
port

[1-4]-[1-3]-#-#-[01-16]-[1-2]-[1,
4, 7, 10]

OC12/[1-4]-[1-3]-#-#-[01-16]-[1-2]/3c.[1-4]

STS-1 logical port on
OC-12 physical port

[1-4]-[1-3]-#-#-[01-16]-[1-2]-
[1-12]

OC12/[1-4]-[1-3]-#-#-[01-16]-[1-2]/STS1.[1-
12]

OC-3 Physical Port [1-4]-[1-3]-#-#-[01-16]-[1-4] OC3/[1-4]-[1-3]-#-#-[01-16]-[1-4]

STS-3c logical port
on OC-3 physical
port

[1-4]-[1-3]-#-#-[01-16]-[1-4]-1 OC3/[1-4]-[1-3]-#-#-[01-16]-[1-4]/3c.1

STS-1 logical port on
OC-3 physical port

[1-4]-[1-3]-#-#-[01-16]-[1-4]-
[1-3]

OC3/[1-4]-[1-3]-#-#-[01-16]-[1-4]/STS1.[1-3]

EC1 Physical Port [1-5]-[1-3]-#-#-[01-16]-[1-8] EC1/[1-5]-[1-3]-#-#-[01-16]-[1-8]

STS-1 logical port on
EC1 physical port

[1-5]-[1-3]-#-#-[01-16]-[1-8]-1 EC1/[1-5]-[1-3]-#-#-[01-16]-[1-8]/STS1.1

DS3 Physical Port [1-5]-[1-3]-#-#-[01-16]-[1-8] D3/[1-5]-[1-3]-#-#-[01-16]-[1-8]

T3 Logical Port on
DS3 Physical Port

[1-5]-[1-3]-#-#-[01-16]-[1-8] D3/[1-5]-[1-3]-#-#-[01-16]-[1-8]

GbE Physical Port
(LAN) - ptp

[1-4]-[1-3]-#-#-[02, 04, 06, 08,
10, 12, 14, 16]-[1-2]

LAN/[1-4]-[1-3]-#-#-[02, 04, 06, 08, 10, 12, 14,
16]-[1-2]

GbE Physical Port
(WAN) - ptp

[1-4]-[1-3]-#-#-[02, 04, 06, 08,
10, 12, 14, 16]-v[1-2]

WAN/[1-4]-[1-3]-#-#-[02, 04, 06, 08, 10, 12, 14,
16]-v[1-2]

STS-1 logical port on
GbE Physical Port
(WAN) - ctp

[1-4]-[1-3]-#-#-[02, 04, 06,
08, 10, 12, 14,
16]-v[1-2]-[1-24]

WAN/[1-4]-[1-3]-#-#-[02, 04, 06, 08, 10, 12,
14, 16]-v[1-2]-[1-24]

Section VIII: WaveStar TDM 2.5G/10G Port
Addresses
Port identifiers

Network Element Port Addresses

....................................................................................................................................................................................................................................

6 - 2 6 Lucent Technologies 365-314-106R1.1
Issue 1, July 2002



Section IX: WaveStar OLS 1.6T Port Addresses

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the external port addresses for the WaveStar
OLS 1.6T network elements.

Contents
Port identifiers 6-28

Network Element Port Addresses

....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies 6 - 2 7



Port identifiers
....................................................................................................................................................................................................................................

Overview This section provides the port identifiers for the WaveStar OLS 1.6T
network elements.

Port identifiers for
WaveStar OLS 1.6T (6.1)

The following table provides the port identifiers for the WaveStar
OLS 1.6T network elements.

Table 6-7 Port address table for WaveStar OLS 1.6T (6.1)

OMS Line Port (WaveStar OLS 1.6T R6.1 all node-types)

Description Port Type Entity Identifier Network Level Address

(All OLS
1.6T models
including
WADs)

OA PORT-[BAY]-[SHELF]-
[OAaddSLOT]-OUT/

PORT-[BAY]-[SHELF]-
[OAdropSLOT]-OUT

OL [80,16]c/PORT-[BAY]-
[SHELF]-[OAaddSLOT]-
OUT/[PORT]-[BAY]-
[SHELF]-[OAdropSLOT]-
OUT

PORT-[1-2]-[1-3]-[1-12]-OUT/PORT-
[1-2]-[1-3]-[1-12]-OUT

OL [80,16]c/PORT-[1-2]-[1-3]-
[1-12]-OUT/PORT-[1-2]-[1-3]-
[1-12]-OUT

OTS
Repeater Port
(PTP)

OA PORT-[BAY]-[SHELF]-
[OAaddSLOT]-OUT/
PORT-[BAY]-[SHELF]-
[OAdropSLOT]-OUT

OL [80,16]c/PORT-[BAY]-
[SHELF]-[OAaddSLOT]-
OUT/[PORT]-[BAY]-
[SHELF]-[OAdropSLOT]-
OUT

PORT-[1]-[1]-[1,4]-OUT/PORT-[1]-[1]-[1,
4]-OUT

OL [80,16]c/PORT-[1]-[1]-[1,
4]-OUT/PORT-[1]-[1]-[1,4]-
OUT

OCH Trail Logical Port on OMS Line (WaveStar OLS 1.6T R6.1 all node types)

(All OLS
1.6T models
including
WADs)

OA (CTP) PORT-[BAY]-[SHELF]-
[OAaddSLOT]-OUT/

PORT-[BAY]-[SHELF]-
[OAdropSLOT]-OUT-zzzz

OL [80,16]c/PORT-[BAY]-
[SHELF]-[OAaddSLOT]-
OUT/PORT-[BAY]-[SHELF]-
[OAdropSLOT]-OUT-zzzz

PORT-[1-2]-[1-3]-[1-12]-OUT/PORT-
[1-2]-[1-3]-[1-12]-OUT-zzzz

OL [80,16]c/PORT-[1-2]-[1-3]-
[1-12]-OUT/ PORT-[1-2]-[1-
3]-[1-12]-OUT-zzzz

Optical Link and OCH Trail (WaveStar OLS 1.6T R6.1 all node types)

Section IX: WaveStar OLS 1.6T Port
Addresses

Network Element Port Addresses

....................................................................................................................................................................................................................................
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Table 6-7 Port address table for WaveStar OLS 1.6T (6.1) (continued)

No
compatible
optics (i.e.,
OTU)
required

OTU (PTP) [PORT]-[BAY]-[SHELF]-[SLOT]-
[PORT]

[PORT]-[1-12]-[1-3]-[1-12]-[IN1, IN2]

OT/PORT-[BAY]-[SHELF]-
[SLOT]-[PORT]

OT/PORT-[1-12]-[1-3]-[1-12]-
[IN1, IN2]

OTU (CTP) PORT-[1-12]-[1-3]-[1-12]-[IN1,
IN2]-zzzz

PORT-[1-12]-[1-3]-[1-12]-[IN1,
IN2]-zzzz

OT/PORT-[1-12]-[1-3]-[1-12]-
[IN1, IN2]-zzzz

OT/PORT-[1-12]-[1-3]-[1-12]-
[IN1, IN2]-zzzz

10G
MUX-OTU
2.5G (PTP)

[PORT]-[BAY]-[SHELF]-[SLOT]-
[PORT]

[PORT]-[1-12]-[1-3]-[1-12]-[IN1, IN2,
IN3, IN4]

OT/PORT-[BAY]-[SHELF]-
[SLOT]-[PORT]

OT/PORT-[1-12]-[1-3]-[1-12]-
[IN1, IN2, IN3, IN4]

10G
MUX-OTU
2.5G (CTP)

[PORT]-[BAY]-[SHELF]-[SLOT]-
[PORT]-1

[PORT]-[1-12]-[1-3]-[1-12]-[IN1, IN2,
IN3, IN4]-1

OT/PORT-[BAY]-[SHELF]-
[SLOT]-[PORT]-1

OT/PORT-[1-12]-[1-3]-[1-12]-
[IN1, IN2, IN3, IN4]-1

10G MUX
OTU (GTP)

[PORT]-[BAY]-[SHELF]-[SLOT]-
[PORT]-zzzz

[PORT]-[1-12]-[1-3]-[1-12]-IN-zzzz

OT/PORT-[BAY]-[SHELF]-
[SLOT]-[PORT]-zzzz

OT/PORT-[1-12]-[1-3]-[1-12]-
[IN]-zzzz

ORS
End/Ring
Terminal
(PTP)

PORT-[BAY]-[SHELF]-[SLOT]-
[PORT]

PORT-[1-12]-[1-3]-[1-12]-[C1IN,
C2IN, 1AIN, 2AIN, 1BIN, 2BIN]

OT/PORT-[BAY]-[SHELF]-
[SLOT]-[PORT]

OT/PORT-[1-12]-[1-3]-[1-12]-
[C1IN, C2IN, 1AIN, 2AIN,
1BIN, 2BIN]

ORS
End/Ring
Terminal
(CTP)

PORT-[BAY]-[SHELF]-[SLOT]-
[PORT]-1

PORT-[1-12]-[1-3]-[1-12]-[C1IN,
C2IN, 1AIN, 2AIN, 1BIN, 2BIN]-1

OT/PORT-[BAY]-[SHELF]-
[SLOT]-[PORT]-1

OT/PORT-[1-12]-[1-3]-[1-12]-
[C1IN, C2IN, 1AIN, 2AIN,
1BIN, 2BIN]-1

Compatible
optics (i.e.,
virtual OTU)

OMU
(PTP/CTP)

EXT_PORT-[BAY]-[SHELF]-
[omuSLOT]-zzzz

EXT_PORT-[1-12]-[1-3]-[1-12]-zzzz

OT/EXT_PORT-[BAY]-
[SHELF]-[omuSLOT]-zzzz

OT/EXT_PORT-[1-12]-[1-3]-
[1-12]-zzzz

Section IX: WaveStar OLS 1.6T Port
Addresses
Port identifiers

Network Element Port Addresses
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Index

A Add

a 1+1 APS digital link,
4-8

a regenerator to a
digital link, 4-13

black box, 3-13

circuit between
controlled network
element and
noncontrolled network
element, 4-25

circuit between
controlled network
elements, 4-21

circuit between
noncontrolled network
elements, 4-23

controlled network
element, 3-6

digital link between two
network elements, 4-5

equipment, 3-17

optical amplifier to an
OMS, 4-46

subnet, 4-76, 4-79, 4-84

UPSR, 4-81

virtual concatenation
group, 4-91

Adding

virtual concatenation
group, 5-106

Administration Guide, 2-3

Aggregate

definition, 2-3

Alarms, 1-17

log, 1-20

repeat alarms, 1-19

Applications, 1-29

large application, 1-29

medium application,
1-29

small application, 1-29

APS digital links, 4-8

Area

definition, 2-3

ASCII northbound alarm
interface, 1-4, 1-24

Associate

shared risk group with a
digital link, 4-102

audience

intended, xvii

........................................................

B Bandwidth

edit allocation of, 4-69,
4-71

Bandwidth allocation

by ports, 5-71

by trails, 5-71

definition, 5-69

operational methods,
5-70

provisioning concepts,
5-69

setting for client ports,
5-72

Bidirectional ring

automatic formation,
5-82

automatic ring forming
network elements, 5-85

four-fiber ring, 5-84

two-fiber ring, 5-82

Black box

adding, 3-13

definition, 2-3

delete, 3-16

display list of, 3-14
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search for a specific,
3-15

........................................................

C Channel

definition, 2-3

Channels

creation of type, 5-14

definition, 5-14

support, 5-14

supported types network
element, 5-14

termination records,
5-14

Circuit

co-existence support,
5-31

definition, 2-4, 5-21

delete history, 5-34

Gigabit Ethernet
support, 5-23

M.1400-specification
format, 5-32

merging, 5-33

path trace identifiers
and mismatch
detection mode, 5-27

provisioning concepts,
5-30

provisioning controls,
5-25, 5-26

provisioning modes,
5-25

rearrange, 5-33

relationship to trails and
digital links, 2-4

scheduling provisioning,
5-28

STS-1, 5-30

STS-12c, 5-30

STS-192c, 5-30

STS-3c, 5-30

STS-48c, 5-30

supported cross-connect
types and rates, 5-22

supported ID formats,
5-31

supported UPSR
protection, 5-22

T1, 5-31

T3, 5-31

time slot assignment,
5-34

user-defined
free-format, 5-32

VT1.5, 5-30

Y-protected paths, 5-28

Circuit order transmission
parameters

modifying, 4-31

Circuits

adding between
controlled network
element and
noncontrolled network
element, 4-25

adding between
controlled network
elements, 4-21

adding between
noncontrolled network
elements, 4-23

disconnecting, 4-33

display list of, 4-27

list of by type, 4-28

provisioning, 1-14

virtual disconnect, 4-35

Clone feature, 4-30

Comcodes, 1-32

Concept information, 2-1

Configuration management,
1-14

Connection

definition, 5-21

Gigabit Ethernet
support, 5-23

provisioning concepts,
5-20

provisioning controls,
5-25, 5-26

provisioning modes,
5-25

support, 5-21

supported cross-connect
types and rates, 5-22

supported UPSR
protection, 5-22

Connections

copy using the Clone
feature, 4-30

definition, 4-19

provisioning, 4-19

Controlled network element
icons, 3-5

Controlled network
elements, 3-4, 3-5, 5-4

controlled network
elements

adding, 3-6

Controlled network
elements

adding, 5-7

.....................................................................................................................................................................................................................................

I N D E X
I N - 2

Lucent Technologies 365-314-106R1.1
Issue 1, July 2002



characteristics, 5-4

control techniques, 5-4

icons, 5-7

LambdaUNITE MSS
support, 5-7

list of supported, 5-4

Metropolis EON
support, 5-8

Conventions

naming, xix

typographical, xix

Create

connection with Lucent
Optical Network
Navigation System,
4-60

digital link through an
optical channel trail,
4-52

optical channel trail,
4-43

optical link, 4-41

optical multiplex
section, 4-39

shared risk group ID,
4-97

Creating

rings, 4-74

subnets, 4-74

Cut-throughs to EMSs, 1-6
........................................................

D Database synchronization,
3-1

Delete

black box, 3-16

controlled network
element, 3-10

equipment, 3-19

optical amplifier from
an OMS, 4-48

regenerator from a
digital link, 4-15

rings, 4-88

shared risk group ID,
4-107

subnet, 4-88

virtual concatenation
group, 4-94

Deleting

virtual concatenation
group, 5-108

Digital link

1+1 protected, 5-12

add, 5-17

add a regenerator to,
4-13

add between network
elements, 4-5

creation of channel
types, 5-14

definition, 2-4, 4-4,
5-12

deleting regenerators
from, 4-15

disconnect, 4-17, 5-17

display protection group
names, 4-11

display specifications,
4-12

external circuit types,
5-13

E_Link provisioning,
5-17

in-effect, 5-17

Insert an optical layer
into, 4-50

protection types, 5-12

provision a 1+1 APS
digital link, 4-8

provisioning, 4-4

provisioning concepts,
5-16

provisioning order
action, 5-17

relationship to trails and
circuits, 2-4

support, 5-12

support transmission
rates, 5-13

supported, 4-4

Digital links

APS protection
concepts, 5-18

Conceptual information,
5-11

creating through an
optical channel trail,
4-52

protection concepts,
5-18

protection, bi, 5-18

protection, uni, 5-18

provisioning, 1-14

supported protection
types, 5-18

supported, list of, 1-8

Disassociate

shared risk groups with
a digital link, 4-104

Disconnect

circuit, 4-33

.....................................................................................................................................................................................................................................
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digital link, 4-17

optical channel trail,
4-54

optical link, 4-56

optical multiplex
section, 4-57

virtually disconnect a
circuit, 4-35

Disk mirroring, 1-27

Display

digital link associated
with a shared risk
group, 4-101

digital link protection
group names, 4-11

digital link
specifications, 4-12

shared risk groups
associated with a
digital link, 4-99

Documentation

Administration Guide,
xix, xix

comcodes, 1-33

font usage, xix

how to order, 1-38

list of, 1-37

list of; Information
products, xix

Maintenance Guide, xix

on CD-ROM, xx, 1-37

on-line in Navis™

Optical PM - NP
software, 1-37

on-line version, xx, 1-11

Provisioning Guide, xix

........................................................

E Edit

bandwidth allocation,
4-69, 4-71

Element management
systems (EMSs)

cut-throughs, 1-6

Navis Optical EMS, 1-6

supported, list of, 1-6

WaveStar SNMS, 1-6

Equipment

adding, 3-17

definition, 2-5

deleting, 3-19

list of, 3-18

Events, 1-17

monitored events, 1-21

External interfaces, 1-4
........................................................

F Fault management, 1-17

Fault state values, 1-18

Features, 1-10
........................................................

G G7 2.0 CORBA interface

southbound to Navis
Optical EMS, 1-5

Global TSS Contact Center,
1-36

Glossary, xix
........................................................

H Help, 1-36

screen help, xx, 1-11,
1-37

High-availability strategies,
1-25

Hotline, 1-36

How to order, xx
........................................................

I

information product

how to use, xviii

Information products

comcodes, 1-33

how to order, 1-38

how to
order;Documentation,
xx

list of, 1-37

on CD-ROM, xx

on-line version, xx, 1-11

Insert

optical layer into digital
link, 4-50

Interfaces

external, 1-4

northbound, 1-4

Performance Monitoring
(PM) Export, 1-5

southbound, 1-4

to other systems, 1-5
........................................................

L Lambda Unite

port identifiers, 6-10

LambdaRouter, 3-6, 4-58

port addresses, 6-7

port identifiers, 6-8

.....................................................................................................................................................................................................................................
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LambdaUnite

port addresses, 6-9

LambdaUNITE MSS, 5-7

Lists

black boxes, 3-14

circuits, 4-27

circuits by type, 4-28

equipment, 3-18

Shared risk group, 4-98

Logins

number allowed, 1-11

Logs

alarm log, 1-20

user logs, 1-11

Lucent Optical Network
Navigation System

creating a connection
with, 4-60

modify session
parameters, 4-64

provisioning, 4-58

start communication
with, 4-62

Stop, 4-63

view network elements,
4-66

view switch connection
spans, 4-67

........................................................

M Maintenance

comcodes, 1-34

MetroEON network
elements

port identifiers, 6-19

Metropolis DMX

port addresses, 6-12

port identifiers, 6-13

Metropolis DMXpress

port addresses, 6-16

port identifiers, 6-17

Metropolis EON, 5-8

port addresses, 6-18

Mirrored disks, 1-27

Mismatch detection mode

for circuits, 5-27

Modify

circuit order
transmission
parameters, 4-31

Lucent Optical Network
Navigation System
session parameters,
4-64

rings, 4-87

shared risk group ID,
4-106

subnet, 4-87

virtual concatenation
group, 4-93

Modifying

virtual concatenation
group, 5-106

........................................................

N Name

subnet, 4-86

Navis Optical Element
Management System
(EMS), 1-6

Navis Optical EMS
See: Navis Optical

Element Management
System (EMS)

Network

definition, 2-5

Network discrepancy

access, 5-78

causes, 5-77

definition, 5-77

provisioning concepts,
5-77

Network element

adding controlled, 5-7

adding noncontrolled,
5-9

characteristics, 5-4

conceptual information,
5-3

control techniques, 5-4

controlled, 5-4

definition, 2-5

deleting controlled
network elements, 3-10

DWDM, 4-39

icons, 3-12

icons for controlled, 5-7

icons for noncontrolled,
5-9

LambdaRouter, 4-58

LambdaUnite MSS
support, 5-7

list of supported
controlled, 5-4

Metropolis EON
support, 5-8

.....................................................................................................................................................................................................................................
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noncontrolled, 3-11, 5-9

noncontrolled
characteristics, 5-9

noncontrolled support,
3-12

supported channel types,
5-14

supported noncontrolled,
5-9

synchronize, 3-7

update location, 3-9

WaveStar OLS 1.6T,
4-45

Network element control,
1-16

Network elements

adding controlled
network elements, 3-6

Before you begin task
information, 3-1

controlled, 3-1, 3-4, 3-5

icons, 3-1, 3-5

identification number
format, 3-1

supported, list of, 1-7

Network Map, 1-11

Noncontrolled network
element icons, 3-12

Noncontrolled network
element support, 3-12

Noncontrolled network
elements, 5-9

adding, 5-9

characteristics, 5-9

icons, 5-9

support, 5-9

Nonontrolled network
elements, 3-11

Northbound interfaces, 1-4

ASCII northbound
alarm interface, 1-4,
1-24

TIM interface, 1-4, 1-24
........................................................

O OCh
See: Optical channel trail

OL
See: Optical link

OMS
See: Optical multiplex

section

adding optical
amplifiers to, 4-46

deleting optical
amplifiers from, 4-48

OMS layer

C+L band, 5-43

deleting an OMS, 5-44

DWDM listing for, 5-42

optical amplifiers, 5-42

provisioning concepts,
5-42

On-line documentation, xx,
1-11, 1-23, 1-37

CD-ROM version, 1-37

On-line help
See: Screen help

Optical amplifiers

adding to an OMS, 4-46

deleting from an OMS,
4-48

Optical channel

discovery of fixed
connections, 5-44

fixed connections, 5-45

Optical channel
connections

add/drop terminals,
5-50, 5-51

mandatory fields, 5-50

map filtering, 5-50

OCH connection type,
5-49

optional parameters,
5-50

protection types, 5-50

supported operations,
5-50

Optical channel trail

creating, 4-43

creating a digital link
through, 4-52

disconnect, 4-54

Optical layer

inserting into digital
link, 4-50

Optical Layers

definition, 4-37

Optical layers

fixed connection, 5-40

fixed connections, 5-45

hierarchy, 5-39

OCH assignable port,
5-40

OCH connection, 5-40

OCH nonassignable
port, 5-40

.....................................................................................................................................................................................................................................
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OCH server, 5-40

OMS layer
provisioning, 5-42

optical channel
connection for clients
and servers, 5-48

optical channel
provisioning, 5-44

Optical channel trail,
5-40

optical link
provisioning, 5-46

paired fixed connection,
5-40

point of flexibility, 5-40

provisioning, 4-37

Provisioning concepts,
5-38

provisioning concepts,
5-41

provisioning optical
channel connections,
5-48

provisioning order, 5-41

terminology, 5-39

topological link, 5-40

Optical link

automatic creation of
internal link in OLS
1.6T, 5-46

behavior of NMS when
removed, 5-46

client service type in
provisioning screen,
5-47

creating, 4-41

disconnect, 4-56

end nodes for
provisioning, 5-46

validation of client
service type, 5-47

Optical multiplex section

creating, 4-39

disconnect, 4-57

Optical network navigator

1+1 connection, 5-60

auto reroute ONN
connection, 5-60

bandwidth allocation
feature, 5-69

behavior with
LambdaRouter, 5-68,
5-68

client service type, 5-60

connection, 5-60

database
synchronization, 5-64

definition, 2-5, 5-60

discover route, 5-60

establishing an ONN
connection, 5-63

features description,
5-62

fixed connection span,
5-60

icon, 5-61

modify session
parameters, 5-65

network to network
interface, 5-61

ONN domain, 5-60

permanent connection,
5-61

provisioning concepts,
5-59

related terminology,
5-60

soft permanent
connection, 5-61

starting a session, 5-64

support, 5-60

unprotected ONN
connection, 5-61

user network interface,
5-61

Optical Network Navigator
(ONN), 1-24

Optical switch ring

support, 5-58

Optional features

ASCII northbound
alarm interface, 1-24

Optical Network
Navigator (ONN), 1-24

Performance Monitoring
(PM) Data Export,
1-24

Ordering, 1-32

Navis™ Optical PM -
NP, 1-31

orderable items, 1-32
........................................................

P Path

definition, 2-4, 5-21

Path trace identifiers

for circuits, 5-27

Paths

provisioning, 1-14

.....................................................................................................................................................................................................................................
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Performance monitoring,
1-21

monitored events, 1-21

Performance Monitoring
(PM) Data Export, 1-24

Performance Monitoring
(PM) Export, 1-5

Performing monitoring,
1-21

PM Export
See: See Performance

Monitoring (PM) Export

Port addresses

LambdaRouter, 6-7

LambdaUnite, 6-9

Metropolis DMX, 6-12

Metropolis DMXpress,
6-16

Metropolis EON, 6-18

WaveStar Bandwidth
Manager, 6-21

WaveStar OLS400G,
6-27

WaveStar TDM
2.5G/10G, 6-24

Port identifiers

Lambda Unite, 6-10

LambdaRouter, 6-8

MetroEON network
elements, 6-19

Metropolis DMX, 6-13

Metropolis DMXpress,
6-17

WaveStar Bandwidth
Manager, 6-22

WaveStar TDM
2.5G/10G, 6-25

Port indentifiers

WaveStar OLS 1.6T,
6-28

Ports

address structure, 6-6

address terminology, 6-4

components, 6-6

entity identifier, 6-4

external address, 6-4

external addresses, 6-6

generic structure, 6-6

internal address, 6-4

logical address, 6-4

logical location, 6-6

network level address,
6-4

physical address, 6-4

physical location, 6-6

physical types, 6-6

protection groups, 6-5

tributary, 6-5

Protection

Y-protected paths, 5-28

Protection group names,
4-11

Provision

Lucent ONNS
connection, 4-73

Provisioning

circuits, 5-30

conceptual information,
2-9

connections, 4-19

definition, 2-2

digital circuits, 1-14

digital links, 4-4

Lucent Optical Network
Navigation System,
4-58

network discrepancy,
5-77

optical layers, 4-37,
5-38, 5-41

optical network
navigator, 5-59

paths and circuits, 1-14

rings, 4-74

shared risk groups, 4-95

subnets, 4-74

supported actions, 2-2

task information, 2-8

using the Clone feature,
4-30

virtual concatenation
groups, 4-90

Provisioning concepts

shared risk groups,
5-113

........................................................

R Regenerator

deleting from a digital
link, 4-15

Regenerators

add, 4-13

Reports, 1-16

Resource management,
1-16

Ring

definition, 2-5, 5-80

.....................................................................................................................................................................................................................................
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Rings
See: Subnets
See: Subnets
See: Subnets
See: Subnets

bidirectional, 5-82

creating, 4-74

definition, 4-74

deleting, 4-88

deletion criterion, 5-81

effect of digital link
disconnect, 5-81

examples, 5-80

modifying, 4-87

names, 5-81

naming, 4-86

protection protocol,
5-81

provisioning, 4-74

size limits, 5-82, 5-87,
5-92, 5-94

subtending, 5-90

support, 5-80

unidirectional line
switched, 5-87

virtual, 5-94
........................................................

S Scheduled provisioning,
1-15

Screen help, xx, 1-11, 1-37

Security, 1-12

Service impact values, 1-19

Shared risk group

associate with a digital
link, 4-102

create an ID, 4-97

definition, 2-6, 4-95

deleting IDs, 4-107

disassociate with a
digital link, 4-104

display associations
with a digital link,
4-99, 4-101

display list of, 4-98

modifying an ID, 4-106

Shared risk groups, 1-24

creating, 5-114

definition, 5-114

deleting, 5-115

display associated links,
5-115

displaying, 5-114

functionality, 5-114

modifying, 5-114

provisioning, 4-95

provisioning concepts,
5-113

support, 5-114

Southbound interfaces, 1-4

G7 2.0 CORBA to
Navis Optical EMS,
1-5

Start

communication with
Lucent Optical
Network Navigation
System, 4-62

Stop

communication with
Lucent Optical
Network Navigation
System, 4-63

Subnet

bidirectional rings, 5-82

definition, 5-80

deletion criterion, 5-81

effect of digital link
disconnect, 5-81

examples, 5-80

names, 5-81

protection protocol,
5-81

Provisioning concepts,
5-79

size limits, 5-82, 5-87,
5-92, 5-94

subtending rings, 5-90

support, 5-80, 5-80

unidirectional line
switched rings, 5-87

virtual rings, 5-94

Subnets

adding, 4-76, 4-79,
4-81, 4-84

creating, 4-74

definition, 4-74

deleting, 4-88

modifying, 4-87

naming, 4-86

provisioning, 4-74

Subtending rings

automatic formation,
5-92

Supported applications

list of, 1-29

Supported digital links, 1-8

.....................................................................................................................................................................................................................................
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Supported element
management systems
(EMSs), 1-6

Supported network
elements, 1-7
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modify, 5-106

naming conventions,
5-105

port constraints, 5-108

provisioning, 4-90

provisioning concepts,
5-103, 5-104

provisioning with one
end port, 5-106

selection, 5-106

with link capacity
adjustment scheme,
5-109

Virtual concatentation
groups

bandwidth adjustment,
5-111

ordinal symmetry,
5-110, 5-111

without link capacity
adjustment scheme,
5-111

Virtual disconnect, 4-35

Virtual rings

definition, 5-94
........................................................

W WaveStar BandWidth
Manager, 3-6

.....................................................................................................................................................................................................................................

I N D E X
I N - 1 0

Lucent Technologies 365-314-106R1.1
Issue 1, July 2002



WaveStar Bandwidth
Manager

port addresses, 6-21

port identifiers, 6-22

WaveStar OLS 1.6T

port identifiers, 6-28

WaveStar OLS400G

port addresses, 6-27

WaveStar SNMS
See: WaveStar

Subnetwork Management
System (SNMS)

WaveStar Subnetwork
Management System
(SNMS), 1-6

WaveStar TDM 2.5G/10G

port addresses, 6-24

port identifiers, 6-25
........................................................

Y Y-protected paths, 5-28

.....................................................................................................................................................................................................................................

365-314-106R1.1
Issue 1, July 2002

Lucent Technologies I N D E X
I N - 1 1




	Library
	Contents
	Figures
	Tables
	About this information product
	Purpose
	Reason for reissue
	Safety labels
	Intended audience
	How to use this information product
	Conventions used
	Related documentation
	How to comment
	How to order

	1. System Overview
	Overview
	Product Definition
	Overview
	External interfaces
	Supported element management systems (EMSs)
	Supported network elements
	Supported digital links
	Benefits

	Features per functional area
	Overview
	User support facilities
	Security issues
	Configuration management
	Network-level facilities
	Fault management
	Performance monitoring
	Other features
	Optional features

	Strategies for ensuring high-availability
	Overview
	Uninterruptible Power Supply (UPS)
	Mirrored disks

	Applications
	Overview
	Supported applications

	Ordering
	Overview
	How to order Navis ™ Optical PM - NP
	Orderable items

	Product support
	Overview
	Technical Assistance
	User documentation


	2. The Navis ™ Optical PM - NP Provisioning Process
	Overview
	What is provisioning?
	Terminology overview
	Task information
	Conceptual information

	3. Network Element Configuration Tasks
	Overview
	Section I: Controlled Network Elements
	Overview
	Controlled network element support
	Add a controlled network element
	Synchronize a network element
	Update a network element location
	Delete a controlled network element

	Section II: Noncontrolled Network Elements
	Overview
	Noncontrolled network element support
	Add a black box
	Display black box list
	Search for a specific black box
	Delete a black box
	Add equipment
	Display equipment list
	Delete equipment


	4. Provisioning Tasks
	Overview
	Section I: Digital Links
	Overview
	Add a digital link between two network elements
	Add a 1+1 APS protected digital link
	Display protection group names associated with digital links
	Display digital link specifications
	Add a regenerator to a digital link
	Delete a regenerator from a digital link
	Disconnect a digital link

	Section II: Connections
	Overview
	Add a circuit between two controlled network elements
	Add a circuit between two noncontrolled network elements
	Add a circuit between a controlled network element and a noncontrolled network element
	Display circuit list
	Display circuit list by type
	Copy a connection using the Clone feature
	Modify circuit order transmission parameters
	Disconnect a circuit
	Perform a virtual disconnect

	Section III: Optical Layers
	Overview
	Create an optical multiplex section
	Create an optical link
	Create an optical channel trail
	Add an optical amplifier to an optical multiplex section
	Delete an optical amplifier from an optical multiplex section
	Insert an optical layer into a digital link
	Create a digital link through an optical channel trail
	Disconnect an optical channel trail
	Disconnect an optical link
	Disconnect an optical multiplex section

	Section IV: Lucent Optical Network Navigation System
	Overview
	Establish a connection with the ONN
	Start communication with the ONN
	Stop communication with the ONN
	Modify Lucent ONNS session parameters
	View Lucent ONNS network elements
	View Lucent ONNS switch connection spans
	View and modify bandwidth allocation by trail
	View and modify bandwidth allocation by port
	Provision an Lucent ONNS connection

	Section V: Subnets
	Overview
	Add a BLSR (automatic)
	Add a BLSR (manual)
	Add a UPSR (automatic)
	Add a UPSR (manual)
	Modify a ring name
	Modify a ring
	Delete a ring

	Section VI: Virtual Concatenation Groups
	Overview
	Add a virtual concatenation group
	Modify a virtual concatenation group
	Delete a virtual concatenation group

	Section VII: Shared Risk Groups
	Overview
	Create a shared risk group ID
	Display a list of shared risk groups
	Display the shared risk groups associated with a digital link
	Display the digital links associated with a shared risk group
	Associate a shared risk group with a digital link
	Disassociate a shared risk group with a digital link
	Modify a shared risk group ID
	Delete a shared risk group ID


	5. Provisioning Concepts
	Overview
	Section I: Network Elements
	Overview
	Controlled network elements
	Noncontrolled network elements

	Section II: Digital Links
	Overview
	Digital link support
	Channel support
	Provisioning concepts
	Protection concepts

	Section III: Connections
	Overview
	Connection support
	Provisioning controls
	Provisioning circuits
	4-ended protection paths

	Section IV: Optical Layers
	Overview
	Optical layer support
	Provisioning optical layers

	Section V: Optical Network Navigator
	Overview
	ONN support
	Bandwidth allocation feature
	Provisioning support
	Network discrepancy

	Section VI: Subnets
	Overview
	Subnet support
	Bidirectional line switched rings
	Unidirectional line switched rings
	Subtending rings
	Virtual rings
	Hairpinning

	Section VII: Virtual Concatenation Groups
	Overview
	Virtual concatenation support
	Virtual concatenation with link capacity adjustment scheme

	Section VIII: Shared Risk Groups
	Overview
	Shared risk group support


	6. Network Element Port Addresses
	Overview
	Section I: Introduction
	Overview
	Terminology
	Port address structure and components

	Section II: LambdaRouter Port Addresses
	Overview
	Port identifiers

	Section III: LambdaUnite Port Addresses
	Overview
	Port identifiers

	Section IV: Metropolis DMX Port Addresses
	Overview
	Port identifiers

	Section V: Metropolis DMXpress Port Addresses
	Overview
	Port identifiers

	Section VI: Metropolis EON Port Addresses
	Overview
	Port identifiers

	Section VII: WaveStar BandWidth Manager Port Addresses
	Overview
	Port identifiers

	Section VIII: WaveStar TDM 2.5G/10G Port Addresses
	Overview
	Port identifiers

	Section IX: WaveStar OLS 1.6T Port Addresses
	Overview
	Port identifiers


	Index

